Installation Guide

- SAP NetWeaver Composition Environment 7.1 SP3 on Windows: Oracle

Productive Edition

Target Audience

- System Administrators
- Technical Consultants

Document version: 1.0 – 11/05/2007
Document History

⚠️ Caution
Before you start the implementation, make sure you have the latest version of this document. You can find the latest version at the following location: [http://www.sdn.sap.com] | SAP NetWeaver | Composition Environment.

The following table provides an overview of the most important document changes.

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>11/5/2007</td>
<td>Initial Version</td>
</tr>
</tbody>
</table>
# Table of Contents

| Chapter 1 | Introduction .................................................. | 7 |
| 1.1       | New Features .................................................. | 7 |
| 1.2       | SAP Notes for the Installation .............................. | 9 |
| 1.3       | Information Available on SAP Service Marketplace ....... | 10 |
| 1.4       | Naming Conventions ........................................... | 12 |

| Chapter 2 | Planning ...................................................... | 13 |
| 2.1       | Installation Options Covered by this Guide ............... | 13 |
| 2.1.1     | Standard System .............................................. | 14 |
| 2.1.2     | Distributed System ........................................... | 15 |
| 2.1.3     | High Availability System .................................... | 15 |
| 2.1.4     | Additional Application Server Instance ................... | 16 |
| 2.1.5     | Standalone Host Agent ....................................... | 17 |
| 2.2       | Distribution of SAP System Components to Disks .......... | 18 |
| 2.3       | SAP System Transport Host ................................... | 20 |
| 2.4       | Running Adobe Document Services on Non-Supported Platforms | 21 |
| 2.5       | Installation of Multiple Components in One Database .... | 21 |
| 2.6       | Multiple Oracle Homes ....................................... | 23 |

| Chapter 3 | Preparation .................................................. | 25 |
| 3.1       | Basic SAP System Parameters .................................. | 26 |
| 3.2       | Hardware and Software Requirements ....................... | 32 |
| 3.2.1     | Running the Prerequisite Checker in Standalone Mode (Optional) | 34 |
| 3.2.2     | Requirements for a Standard System ....................... | 35 |
| 3.2.3     | Requirements for a Distributed System .................... | 36 |
| 3.2.4     | Requirements for a High-Availability System .............. | 38 |
| 3.2.5     | Requirements for the Host Agent as a Separate Installation | 42 |
| 3.3       | Preparing User Management for an External ABAP System .... | 43 |
| 3.4       | Checking the Windows File System .......................... | 46 |
| 3.5       | Checking the Windows Domain Structure .................... | 46 |
| 3.6       | Reducing the Size of the File Cache ....................... | 47 |
| 3.7       | Required User Authorization for the Installation .......... | 47 |
| 3.8       | Performing a Domain Installation Without Being a Domain Administrator | 49 |
| 3.9       | Preparing the SAP System Transport Host .................. | 51 |
| 3.10      | Generating the SAP Solution Manager Key .................. | 53 |
3.11 Preparing the Installation DVDs ........................................ 54

Chapter 4  
4.1 Installing the Oracle Database Software .................................................. 57
4.2 Setting Up Multiple Homes (Optional) ..................................................... 59
4.3 Running SAPinst ................................................................. 61
4.4 SAPinst Installation Options ......................................................... 61
4.5 Installing Additional Components (Optional) ........................................... 65
4.6 Installing SAP Memory Analyzer (Optional) ............................................. 69

Chapter 5  
5.1 Logging On to the Application Server ..................................................... 73
5.2 Installing the SAP License .......................................................... 74
5.3 Configuring the Transport Management System .................................... 75
5.4 Configuring the Remote Connection to SAP Support ............................... 75
5.5 Applying the Latest Kernel and Support Packages .................................... 76
5.6 Ensuring User Security .................................................................. 77
5.7 Post-Installation Steps for the Host Agent ................................................ 78
5.8 Checking the SAP Java Documentation .................................................. 79
5.9 CE-Specific Post-Installation Activities .................................................. 79
5.10 Performing Oracle-Specific Post-Installation Steps ................................... 80
5.11 Performing a Full System Backup ......................................................... 81

Chapter 6  
6.1 Preparing the Installation DVD ......................................................... 83
6.2 Setting Up Multiple Homes (Optional) ..................................................... 84
6.3 Running SAPinst ................................................................. 86
6.4 SAPinst Installation Options ......................................................... 86
6.5 Installing Additional Components (Optional) ......................................... 87
6.6 Installing SAP Memory Analyzer (Optional) ......................................... 87

Chapter 7  
7.1 Transporting Self-Developed Software Component Archives (SCA) into the System .......................................................... 89
7.2 Troubleshooting – Repairing an Inconsistent MaxDB Installation .............. 89
7.3 Restarting the MaxDB Server Manually ............................................... 90
7.4 Restarting the MS SQL Server Manually .............................................. 91
7.5 Configuration Templates .................................................................. 92
7.6 SAP Directories ............................................................................. 92
7.7 Additional Information About SAPinst .................................................. 93
7.7.1 Interrupted Installation with SAPinst ............................................... 93
7.7.2 Performing a Remote Installation with SAPinst (Optional) ............... 94
7.7.3 Starting SAPinst GUI Separately (Optional) ..................................... 94
7.7.4 Entries in the Services File Created by SAPinst ............................... 95
7.7.5 How to Avoid Automatic Logoff by SAPinst .................................. 95
7.7.6 Troubleshooting with SAPinst ...................................................... 95
7.8 Starting and Stopping the SAP System .................................................... 96
7.9 SAP System Security on Windows ....................................................... 96

4/168  PUBLIC  11/05/2007
7.10 Automatic Creation of Accounts and Groups ........................................... 104
7.11 Uninstalling SAP NetWeaver Composition Environment ....................... 106
7.12 Deleting an SAP System .......................................................................... 107
7.13 Deleting the Oracle Database Software ................................................... 108

Chapter 8 High Availability with Microsoft Cluster Service ................................. 111
8.1 Planning .................................................................................................... 113
8.1.1 System Configuration in MSCS .............................................................. 113
8.1.1.1 SAP System Components in an MSCS Configuration ..................... 113
8.1.1.2 Multiple SAP Systems In One MSCS Cluster ................................. 116
8.1.1.3 Multiple SAP Systems In Multiple MSCS Clusters ......................... 119
8.1.1.4 Enqueue Replication Server in an MSCS Configuration .................. 120
8.1.2 Distribution of SAP System Components to Disks for MSCS .................. 121
8.1.3 Directories in an MSCS Configuration .................................................. 125
8.1.4 IP Addresses in an MSCS Configuration .............................................. 126
8.1.5 Obtaining IP Addresses for MSCS ...................................................... 130
8.2 Preparation ............................................................................................... 132
8.2.1 Assigning Drive Letters for MSCS ....................................................... 133
8.2.2 Mapping Host Names to IP Addresses for MSCS ................................. 133
8.2.3 Checking the Mapping of Host Names for MSCS ................................. 134
8.2.4 Preparing an Existing SAP System to Support Multiple Systems in one MS Cluster ........................................................................................................... 135
8.2.5 Preparing the Installation of Multiple SAP Systems in MSCS ................. 138
8.3 Installation ................................................................................................ 141
8.3.1 Moving MSCS Groups ......................................................................... 143
8.3.2 Rebooting During the Installation or Conversion for MSCS .................. 144
8.3.3 Installing the Oracle Fail Safe Software in a 64-Bit System .................... 144
8.3.4 Additional Steps for the Oracle Fail Safe Configuration ....................... 146
8.3.5 Installing the Central Services Instance (SCS) ..................................... 148
8.3.6 Configuring the First MSCS Node ......................................................... 149
8.3.7 Installing the Database Instance ......................................................... 150
8.3.8 Installing the Host Agent on the Additional MSCS Node ...................... 151
8.3.9 Configuring the Additional MSCS Node .............................................. 152
8.3.10 Installing an Enqueue Replication Server ......................................... 153
8.3.11 Installing the Primary Application Server Instance ............................ 154
8.3.12 Creating the Oracle Fail Safe Group ............................................... 155
8.3.13 Setting Up a Shared Database Directory in Oracle Home .................... 157
8.3.14 Adding the Oracle Database Resource to the Cluster Group ................. 158
8.3.15 Installing the Additional Application Server Instance ....................... 159
8.4 Post-Installation ....................................................................................... 160
8.4.1 Post-Installation Checks for Enqueue Replication Server ...................... 161
8.4.1.1 Checking the Status of the Enqueue Replication Server with ENSMON .. 161

11/05/2007 PUBLIC 5/168
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.4.1.2</td>
<td>Monitoring the Lock Table During Failover with ENQT</td>
<td>162</td>
</tr>
<tr>
<td>8.4.2</td>
<td>Starting and Stopping the SAP System in an MSCS Configuration</td>
<td>164</td>
</tr>
</tbody>
</table>
1 Introduction

This document explains how to install an SAP NetWeaver Composition Environment system as productive edition. For more information about SAP NetWeaver Composition Environment, see SAP Community Network at [http://sdn.sap.com › SAP NetWeaver › Composition Environment](http://sdn.sap.com › SAP NetWeaver › Composition Environment).

1.1 New Features

Here you can find the new features in this release.

⚠️ Caution
Make sure that you read the release notes for your SAP system. You can find these on SAP Service Marketplace at [http://service.sap.com/releasenotes](http://service.sap.com/releasenotes).

SAP System Installation

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
</table>
| SAPinst | SAPInst has the following new features:  
- The technical terms used for the instances of an SAP system have changed as follows:  
  - “Central instance” (CI) is now called “primary application server instance”.  
  - “Dialog instance” (DI) is now called “additional application server instance”.  

⚠️ Note  
The technical terms “Database instance”, “Java central services instance” (SCS), and “ABAP central services instance” (ASCS) remain unchanged.  
- “Central system” – meaning an SAP system running on one single host – is now called “standard system”.  
- You can now install the host agent separately with SAPInst. There is a new installation option Host Agent available under Software Life-Cycle Options Additional Preparations.

The host agent contains all of the required elements for centrally monitoring any host with the Alert Monitor or the SAP NetWeaver Administrator. It is automatically installed during the installation of all SAP NetWeaver components, except TREX.  
You only need to install the host agent separately in the following cases:  
- You want to centrally monitor a host that does not have an SAP component.  
- You want to perform an upgrade to SAP NetWeaver. |
### Area | Description
--- | ---
Software Deployment Manager (SDM) no longer available in the Application Server Java | The Software Deployment Manager (SDM) is no longer part of the primary application server instance of a Java-only system. Therefore, there is no longer any technical difference between the primary application server instance and the additional application server instance of a Java-only system. The SAP system directory of both instances is now called J<instance_number>. The SAP system directory of both instances is now called J<instance_number>. The SAP system directory of both instances is now called J<instance_number>.
Usage type EP Core (EPC) | The usage type Enterprise Portal (EP) is divided into the usage types EP Core (EPC) and Enterprise Portal (EP):
- **EP Core (EPC)**
  This usage type contains the core portal capabilities that were available in the former usage type EP. This new usage type provides more flexibility when implementing a portal where the full enterprise portal capabilities, such as knowledge management and collaboration, are not required. It contains the portal, GP, and UWL.
- **Enterprise Portal (EP)**
  This usage type includes Knowledge management, Collaboration, CAF-Core, Visual Composer, Web Dynpro extension, and .NET PDK.
  Usage type EPC is a prerequisite for usage type EP. If you want to obtain the full capabilities of the former usage type EP, you need both EP Core and EP.
  The configuration of EPC comprises only portal configuration steps.
  ![Note](image)
  The standalone implementation of the new usage type EPC without usage type EP is currently limited to certain ERP scenarios, as described in the mySAP ERP Master Guide.
Installation DVDs | You start the installation from the Installation Master DVD for your database.
SAP JVM | You no longer have to download and install a Java Development Kit (JDK) or Java Runtime Environment (JRE) from another software vendor. SAP delivers its own Java Virtual Machine (JVM) called SAP JVM. This virtual machine is certified and fully compliant with the J2SE 5.0 standard, offering a strong and reliable foundation for the whole SAP Java stack.
  - SAP JVM is available on the Installation Master DVD. SAPInst extracts and installs it automatically when you start the installation.
Visual Administrator tool integrated in SAP NetWeaver Administrator | SAP NetWeaver Administrator is a brand new solution for monitoring and administering Java systems and their applications. It is a web-based tool for administration, configuration, and monitoring.
  - The Visual Administrator tool is no longer available as a separate tool. It has been integrated in the SAP NetWeaver Administrator.
  - SAP NetWeaver Administrator offers you most of the functions previously available in Visual Administrator, but redesigned for the task-oriented approach of SAP NetWeaver Administrator.
  For more information about SAP NetWeaver Administrator, see the SAP NetWeaver Master Guide and SAP Service Marketplace at [http://service.sap.com/nwa](http://service.sap.com/nwa).
Oracle Database

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
</table>
| New features in Oracle 10g  | For the complete list of new features, see further documentation from Oracle, which you can find at:  
  www.oracle.com/technology/products/database/oracle10g  
  See also:  
  - www.oracle.com/technology/documentation/database10g.html  
  - The documentation provided by Oracle on the RDBMS DVD  
    under <DVD_Drive>:\NT\<platform>\database\doc\index.htm |

Operating Systems

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
</table>
| Support of Operating Systems | See the Product Availability Matrix (PAM) on SAP Service Marketplace at  
  http://service.sap.com/pam  |

Documentation

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Notes</td>
<td>You can now access SAP Notes directly in SAP Service Marketplace from your PDF. Place the cursor on the SAP Note &quot;&lt;number&gt;&quot; and double-click. A separate browser windows opens and the SAP Note is displayed.</td>
</tr>
</tbody>
</table>
| Links to the Internet       | You can use the new links in the PDF files of the guides as follows:  
  - Click on the section headings such as New Features to jump back to the table of contents at the beginning of the guide.  
  - Click on an internet link such as http://service.sap.com to jump to the corresponding internet page. |

1.2 SAP Notes for the Installation

You **must** read the following SAP Notes before you start the installation. These SAP Notes contain the most recent information on the installation, as well as corrections to the installation documentation. Make sure that you have the up-to-date version of each SAP Note which you can find in the SAP Service Marketplace at http://service.sap.com/notes.
1.3 Information Available on SAP Service Marketplace

More information is available as follows on SAP Service Marketplace.

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
<th>Title</th>
</tr>
</thead>
</table>
### 1.3 Information Available on SAP Service Marketplace

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
<th>Title</th>
</tr>
</thead>
</table>

All corrective software packages, including Support Packages (Stacks) for SAP NetWeaver 7.0 (2004s) and subsequent versions, as well as all applications which are based on this software (including SAP Business Suite 2005), released after **April 2, 2007**, will be available exclusively through the Maintenance Optimizer in SAP Solution Manager.

---

### General Quick Links

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Notes</td>
<td><a href="http://service.sap.com/notes">http://service.sap.com/notes</a></td>
</tr>
<tr>
<td>Released platforms and operating systems</td>
<td><a href="http://service.sap.com/platforms">http://service.sap.com/platforms</a></td>
</tr>
<tr>
<td>System sizing (Quick Sizer tool)</td>
<td><a href="http://service.sap.com/sizing">http://service.sap.com/sizing</a></td>
</tr>
<tr>
<td>High availability</td>
<td><a href="http://service.sap.com/ha">http://service.sap.com/ha</a></td>
</tr>
</tbody>
</table>

**Note**

For information on Windows operating system security, see: [http://www.microsoft.com/security](http://www.microsoft.com/security)

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Solution Manager</td>
<td><a href="http://service.sap.com/solutionmanager">http://service.sap.com/solutionmanager</a></td>
</tr>
</tbody>
</table>
1.4 Naming Conventions

In this documentation, the following naming conventions apply:

**Terminology**

- **SAP system** refers to *SAP NetWeaver CE 7.1*.

**Variables**

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;SAPSID&gt;</code></td>
<td>SAP system ID in uppercase letters</td>
</tr>
<tr>
<td><code>&lt;sapsid&gt;</code></td>
<td>SAP system ID in lowercase letters</td>
</tr>
<tr>
<td><code>&lt;sid&gt;</code> and <code>&lt;sapsid&gt;</code></td>
<td>SAP system ID in lowercase letters</td>
</tr>
<tr>
<td><code>&lt;DBSID&gt;</code></td>
<td>Database ID in uppercase letters</td>
</tr>
<tr>
<td><code>&lt;dbsid&gt;</code></td>
<td>Database ID in lowercase letters</td>
</tr>
<tr>
<td><code>&lt;host_name&gt;</code></td>
<td>Name of the corresponding host</td>
</tr>
<tr>
<td><code>&lt;INSTDIR&gt;</code></td>
<td>Installation directory for the SAP system</td>
</tr>
<tr>
<td><code>&lt;DVD_DIR&gt;</code></td>
<td>Directory on which a DVD is mounted</td>
</tr>
<tr>
<td><code>&lt;OS&gt;</code></td>
<td>Operating system name within a path</td>
</tr>
<tr>
<td><code>&lt;SCHEMAID&gt;</code></td>
<td>Database schema ID</td>
</tr>
</tbody>
</table>

The following example shows how the variables are used:

**Example**

Log on as user `<sapsid>adm` and change to the directory `\usr\sap\<SAPSID>`. If your SAP system ID is C11, log on as user `c11adm` and change to the directory `\usr\sap\C11`.
2 Planning

This section provides general planning information.

You must first:

1. Plan your SAP system landscape according to the Master Guide and the Technical Infrastructure Guide available for your product.
2. Decide on your installation option [page 13].

Now continue with the section for your chosen installation option below.

Standard, Distributed, or High-Availability System

1. For the database installation, you decide on how to distribute your database components to disk [page 18].
2. You decide on the transport host to use [page 20].
3. If you want to use Adobe Document Services (ADS), you check what you have to do in case your platform is not supported for ADS [page 21].
4. You decide whether you want to install multiple components in one database (MCOD) [page 21]
5. You decide if you want to use multiple Oracle homes [page 23].

[Only valid for: HA (MSCS)]
6. If you want to install a high-availability system with Microsoft Cluster Service (MSCS), see the MSCS-specific planning activities [page 113].

[End of: HA (MSCS)]

7. You can now continue with Preparation [page 25].

Additional Application Server Instance
You do not have to perform any planning steps.
You can immediately continue with Preparation [page 25]

Host Agent as a Separate Installation
You do not have to perform any planning steps.
You can immediately continue with Preparation [page 25]

2.1 Installation Options Covered by this Guide

This section shows the installation options covered by this installation guide. In the SAPinst tool, these comprises installation and software life-cycle options.
2 Planning
2.1 Installation Options Covered by this Guide

- **Standard system** [page 14] (formerly known as central system)
- **Distributed system** [page 15]
  - Only valid for: HA (MSCS)
- **High-availability system** [page 15]
  - End of: HA (MSCS)

- You can install one to <n> additional application server instance(s) [page 16] to an existing standard, distributed or high-availability system.
- You can install a *standalone host agent* [page 17].

### 2.1.1 Standard System

You can install a **standard** system on a **single** host. In a standard system, all main instances run on a single host:

- Central services instance (SCS)
- Database instance (DB)
- Primary application server instance

**Figure 1:** Standard System

![Diagram of Standard System](image)

SCS = Java central services instance  
PAS = Primary application server instance  
DB = Database instance

Optionally you can install one to <n> additional application server instances. For more information, see *Additional Application Server Instance* [page 16].
2.1.2 Distributed System

In a distributed system, every instance can run on a separate host:

- Central services instance (SCS)
- Database instance (DB)
- Primary application server instance

Optionally you can install one to \(<n>\) additional application server instances. For more information, see Installation of an Additional Application Server Instance [page 16].

Figure 2: Distributed System

```
SCS = Java central services instance
PAS = Primary application server instance
```

2.1.3 High Availability System

For more information on the system components you have to install and how to distribute them on the specific hosts, see System Configuration in MSCS [page 113].
2.1.4 Additional Application Server Instance

You can install one to \(<n>\) additional application server instance(s) for an existing SAP system. An additional application server instance can run on:

- The host of any instance of the existing SAP system
- On a dedicated host

**Note**

It is not recommended to install additional application server instance(s) on the SAP global host.

**Additional Application Server Instance for a Standard System**

The following figure shows additional application server instances that are running on dedicated hosts.

**Figure 3: Additional Application Server Instance for a Standard System**

For additional information, see *Standard System* [page 14].

**Additional Application Server Instance for a Distributed System**

The following figure shows additional application server instances that are running on dedicated hosts.
**Figure 4:** Additional Application Server Instance for a Distributed System

For additional information, see *Distributed System* [page 15].

**Additional Application Server Instance for a High-Availability System**

In a high-availability system, you require besides the primary application server instance, at least one additional application server instance. For more information about how to install and distribute the application servers in an MSCS configuration, see section *System Configuration in MSCS* [page 113].

**2.1.5 Standalone Host Agent**

Using the host agent you can centrally monitor any host with the Alert Monitor or the SAP NetWeaver Administrator. It is automatically installed during the installation of all SAP NetWeaver components.

You only need to install a **standalone** host agent in the following cases:

- You want to centrally monitor a host that does not have an SAP component.
- You want to perform an upgrade to SAP NetWeaver.
2 Planning
2.2 Distribution of SAP System Components to Disks

**Figure 5:** Host Agent

**SAP NetWeaver Management Agents on a Host**

The host agents contain the following elements:

- The control program `saphostexec`
- The SAP NetWeaver Management agent `SAPHostControl` (`sapstartsv` in host mode)
- The `sapacosprep` executable of the Adaptive Computing Infrastructure
- The operating system collector `saposcol`

**Note**

The installed programs are automatically started when the host is booted.

On Microsoft Windows hosts, the services `SAPHostControl` and `SAPHostExec` do this.

**More Information**

For more information about the host agent, see:

- [http://help.sap.com](http://help.sap.com) &gt; [your product] &gt; SAP NetWeaver Library &gt; Function-Oriented View &gt; Application Server ABAP &gt; Administration Tools for AS ABAP &gt; Monitoring in the CCMS &gt; Infrastructure of the NetWeaver Management Agents

---

**2.2 Distribution of SAP System Components to Disks**

When you install the SAP system, the main directories required for the system are automatically created. However, during the installation procedure, SAPinst prompts you to enter drive letters for the main components of the system. This gives you the opportunity to distribute components to
disks in the system as you wish. The way in which you do this significantly affects system throughput and data security, and must therefore be carefully planned. The best distribution depends on your specific environment and must take into consideration factors such as the size of the components involved, security requirements and the expected workload.

When you work out the assignment of components to disks, you first need to get an overview of the main components and their corresponding directories. Then, on the basis of sample configurations and the recommendations provided in this documentation, you can decide which assignment is best for your particular system.

SAP systems are normally installed on RAID arrays that ensure data redundancy. This documentation therefore focuses on RAID subsystems and drives.

**Minimal Configuration**

The following figure illustrates an example for a disk configuration for a small test or demo system. As security and performance play a less crucial role in this type of system, many different configurations are feasible.

⚠️ **Caution**

Use the illustrated configuration exclusively for test or demo systems. It is unsuitable for production systems because it only minimally satisfies security and performance requirements.

**Figure 6:**
### Distribution of Database Directories to Disks

<table>
<thead>
<tr>
<th>Disk</th>
<th>Directories</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk 1</td>
<td>\ORACLE&lt;DBSID&gt;\102</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\origlogA</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\origlogB</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\sapdata1</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\sapdata2</td>
</tr>
<tr>
<td>Disk 2</td>
<td>\ORACLE&lt;DBSID&gt;\mirrlogA</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\mirrlogB</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\sapreorg</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\saptrace</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\saparch</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\sapbackup</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\sapcheck</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\sapdata3</td>
</tr>
<tr>
<td></td>
<td>\ORACLE&lt;DBSID&gt;\sapdata4</td>
</tr>
<tr>
<td>Disk 3</td>
<td>\ORACLE&lt;DBSID&gt;\oraarch</td>
</tr>
</tbody>
</table>

### Comments
- The configuration ensures that no data can be lost, but the process for recovering a damaged database is complicated and time-consuming.
- The redo logs and database files are located on the same disks. This means that a single disk failure can result in the loss of both the redo logs and database data.
- The I/O-intensive redo logs are on the same disk volumes as the data files. This can impede performance.
- An equally good alternative would be to simply place all components on a single RAID 5 array.

### 2.3 SAP System Transport Host

The transport host contains the transport directory that is used by the SAP transport system to store transport data and change information of SAP systems, such as software programs, data dictionary data, or customization data. If you have several SAP systems they are usually organized in transport domains. In most cases, all SAP systems in a transport domain have a common transport directory.  
For more information, see:

When you install an SAP system, SAPinst by default creates the transport directory on the primary application server instance host in `\usr\sap\trans`.
2.4 Running Adobe Document Services on Non-Supported Platforms

Adobe document services (ADS) are currently not supported to run natively on all platforms supported by SAP systems based on SAP NetWeaver, in particular on 64-bit platforms.

**Procedure**
To use ADS in SAP landscapes on non-supported platforms, install an additional standalone AS Java on a platform supported by ADS.
For more information, see SAP Note 925741.

2.5 Installation of Multiple Components in One Database

You can install multiple SAP systems in a single database. This is called Multiple Components in One Database (MCOD).
MCOD is available with all SAP components. We are releasing this technology on all the major databases for the SAP system, in line with our commitment to deliver platform-independent solutions.
Using this technology is as easy as installing a separate component. No extra effort is required because the MCOD installation is fully integrated into the standard installation procedure. MCOD is not an additional installation option. Instead, it is an option of the database instance installation.
With MCOD we distinguish two scenarios:

- The installation of an SAP system in a new database
- The installation of an additional SAP system in an existing database
Prerequisites

- For more information on MCOD and its availability on different platforms, see the SAP Service Marketplace at http://service.sap.com/mcod.
- Since SAP does not support mixed solutions with MCOD, your SAP system must contain Unicode SAP instances only.
- Improved sizing required
  In general, you calculate the CPU usage for an MCOD database by adding up the CPU usage for each individual SAP system. The same applies to memory resources and disk space.
  You can size multiple components in one database by sizing each individual component using the SAP Quick Sizer and then adding the requirements together. For more information on the SAP Quick Sizer, see the SAP Service Marketplace at http://service.sap.com/sizing.

Features

- Reduced administration effort
- Consistent system landscape for backup, system copy, administration, and recovery
- Increased security and reduced database failure for multiple SAP systems due to monitoring and administration of only one database
- Independent upgrade
  In an MCOD landscape you can upgrade a single component independently from the other components running in the same database, assuming that the upgraded component runs on the same database version. However, if you need to restore a backup, be aware that all other components are also affected.

Note

Special MCOD considerations and differences from the standard procedure are listed where relevant in the installation documentation.

Constraints

- We strongly recommend that you test MCOD in a test or development system. We recommend that you run MCOD systems in the same context. We do not recommend that you mix test, development, and production systems in the same MCOD.
- In the event of database failure, all SAP systems running on the single database are affected.
- Automated support in an MCOD landscape for the following administrative tasks depends on your operating system and database:
  - Copying a single component from an MCOD landscape to another database at database level.
  - De-installing a single component from an MCOD landscape requires some additional steps.
    You can use a remote connection to SAP support to request help with these tasks. For more information see http://service.sap.com/remotefunction.
- You cannot install a Unicode SAP system with a non-Unicode SAP system in one database.
Multiple Oracle Homes

The Oracle database software is installed in a directory structure which is referenced as Oracle Home. If you install more than one database instance on the same host you have the following options:

- **You use Multiple Oracle Homes**
  Multiple Oracle Homes are necessary, if you need to install different Oracle versions on the same host. With multiple Oracle Homes, you can administer your databases independently. For example, if you want to install a patch set, you do not have to install them on all databases.

  **Note**
  If you use multiple Oracle Homes you must set up one Oracle Listener for each Oracle Home, and each listener must have a different TCP/IP port number.

- **You use a Single Oracle Home**
  You can use a single Oracle Home, if you use the same database version. The advantage is that you have to install the database software only once. However, with a single Oracle Home, you cannot administer your databases independently. For example, if you want to install a patch set, you have to stop all databases. When the installation is finished, you have to perform the post-installation tasks of the patch on all databases.

  **Note**
  In case you later want to use two multiple homes instead of one, you either have to perform a new database instance installation or upgrade your database.

Before you install your Oracle database software, you need to decide whether you want to set up multiple Oracle Homes as this influences the installation procedure.
More Information

Setting Up Multiple Oracle Homes [page 61]
3 Preparation

This section includes the preparation steps that you have to perform for the:

- Standard, distributed, or high-availability system
- Additional application server instance
- Host agent

**Standard, Distributed, or High-Availability System**

**Note**

In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.

1. You identify basic SAP system parameters [page 26].
2. You check the hardware and software requirements [page 32] on each host.
3. You check the Windows file system [page 46] on each host.
4. You check that all installation hosts belong to the correct Windows domain [page 46].
5. You reduce the size of the file cache [page 47] on each host.
6. You check that you have the required user authorization for the installation [page 47].
7. If required, you perform a domain installation without being a domain administrator [page 49].
8. If required, you prepare the SAP system transport host [page 51] for your SAP system.
9. You make sure that the required installation media [page 54] is available on each host.

10. For the installation of a high-availability system with Microsoft Cluster Service (MSCS), you also have to perform MSCS-specific preparation tasks [page 132].

11. You can now continue with Installation [page 57].

**Additional Application Server Instance**

You have to perform the following preparations on the host where you install the additional application server instance(s):

1. You check the hardware and software requirements [page 32].
2. You check the Windows file system [page 46].
3. You check that your host belongs to the correct Windows domain [page 46].
4. You reduce the size of the file cache [page 47].
5. You check that you have the required user authorization for the installation [page 47].
6. If required, you perform a domain installation without being a domain administrator [page 49].
7. You make sure that the required installation media [page 54] is available.
8. You can now continue with Installation [page 57].

**Standalone Host Agent**
You have to perform the following preparations on the host where you install the host agent separately:

1. You identify basic SAP system parameters [page 26].
2. You check the hardware and software requirements [page 32].
3. You check the Windows file system [page 46].
4. You reduce the size of the file cache [page 47].
5. You check that you have the required user authorization for the installation [page 47].
6. If required, you perform a domain installation without being a domain administrator [page 49].
7. You make sure that the required installation media [page 54] is available.
8. You can now continue with Installation [page 57].

### 3.1 Basic SAP System Parameters

SAPinst asks whether you want to run the installation in Typical or Custom mode.

If you choose Typical, SAPinst provides automatic default settings and you only have to respond to a minimum number of prompts. However, you can still change any of the default settings on the parameter summary screen.

The tables below list the basic system parameters that you always need to specify before installing your SAP system, both in typical and in custom mode.

For all other SAP system parameters, use the F1 help in the SAPinst dialogs.

#### SAP System ID and Database ID

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System ID &lt;SAPSID&gt;</td>
<td>The SAP system ID &lt;SAPSID&gt; identifies the entire SAP system. SAPinst prompts your for the &lt;SAPSID&gt; when you execute the first installation option to install a new SAP system. If there are further installation options to be executed, SAPinst prompts you for the profile directory. For more information, see the description of the parameter SAP System Profile Directory.</td>
</tr>
</tbody>
</table>

Example

This prompt appears when you install the central services instance, which is the
3.1 Basic SAP System Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>First instance to be installed in a distributed system.</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Caution**
Choose your SAP system ID carefully. Renaming is difficult and requires you to reinstall the SAP system.

Make sure that your SAP system ID:
- Is unique throughout your organization
- Consists of exactly three alphanumeric characters
- Contains only uppercase letters
- Has a letter for the first character
- Does not include any of the following, which are reserved IDs:
  - ADD
  - ALL
  - AND
  - ANY
  - ASC
  - COM
  - CON
  - DBA
  - END
  - EPS
  - FOR
  - GID
  - IBM
  - INT
  - KEY
  - LOG
  - MON
  - NIX
  - NOT
  - NUL
  - OFF
  - OMS
  - RAW
  - ROW
  - SAP
  - SET
  - SGA
  - SHG
  - SID
  - SQL
  - SYS
  - TMP
  - UID
  -USR
  - VAR

**Caution**
Choose your database ID carefully. Renaming is difficult and requires you to reinstall the SAP system.

- **If you want to install a new database:**
  Make sure that your database ID:
  - Is unique throughout your organization
  - Consists of exactly three alphanumeric characters
  - Contains only uppercase letters
  - Has a letter for the first character
  - Does not include any of the following, which are reserved IDs:
    - ADD
    - ALL
    - AND
    - ANY
    - ASC
    - COM
    - CON
    - DBA
    - END
    - EPS
    - FOR
    - GID
    - IBM
    - INT
    - KEY
    - LOG
    - MON
    - NIX
    - NOT
    - NUL
    - OFF
    - OMS
    - RAW
    - ROW
    - SAP
    - SET
    - SGA
    - SHG
    - SID
    - SQL
    - SYS
    - TMP
    - UID
    - USR
    - VAR

- **If you want to use an existing database:**
  Enter exactly the database ID of the existing database to which you want to add the system.
### SAP System Profile Directory

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(&lt;\text{SAPGLOBALHOST}&gt;/\text{sapmnt}/&lt;\text{SAPSID}&gt;/\text{SYS}/profile</td>
<td>The installation retrieves the parameters entered earlier from the SAP system profile directory. SAPinst prompts you to enter the location of the profile directory when the installation option that you execute is not the first one belonging to your SAP system installation. See also the description of the parameters SAP System ID and Database ID.</td>
</tr>
</tbody>
</table>

Note
If you install an additional application server instance to an existing SAP system, SAPinst also prompts you for the profile directory of the existing SAP system.

### SAP System Instances, Hosts, and Ports

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Instance Number:</strong></td>
<td>Technical identifier that is required for every instance of an SAP system, consisting of a two-digit number from 00 to 97. The instance number must be unique on a host. That is, if more than one SAP instance is running on the same host, these instances must be assigned different numbers. To find out this number, look in the SAP directory (&lt;\text{Drive}&gt;:\text{usr}\text{sap}/&lt;\text{SAPSID}&gt;/&lt;\text{nn}&gt; on the host of the primary application server instance. The value &lt;nn&gt; is the number assigned to the primary application server instance.</td>
</tr>
</tbody>
</table>

**Caution**
Do **not** use 43, 60, 89 for the instance number because:
- 43 is used by MSCS
- 60 is used by iSCSI
- 89 is used by Windows Terminal Server

| Virtual Host Name | For a high-availability (HA) system you need to specify the virtual host name, which is used by the (A)SCS instance. For more information about the use of virtual TCP/IP host names, see SAP Note 962955. For more information about the allowed host name length and characters, see SAP Note 611361. To find out the host name, open a command prompt and enter `hostname`. |

| Message Server Port | The message server port number must be unique for the SAP system on all hosts. If there are several message ports number on one host, all must be unique. |

**Port Number of the SAP Message Server:**
3.1 Basic SAP System Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If you do not specify a value, the default port number is used. The Java message server is configured in the SCS instance profile. The Java message server port uses the parameter rdisp/msserv_internal with default value 39&lt;nn&gt;, where &lt;nn&gt; is the instance number of the SCS message server instance. For more information about the parameters used for message server ports, see SAP Note 821875.</td>
</tr>
</tbody>
</table>

Parameters for SAP System Drives

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination drive</td>
<td>Base directory for the SAP system.</td>
</tr>
</tbody>
</table>

Note

If you install a subsequent SAP system, the sap10e share already exists and you cannot select the installation drive. SAPInst uses the installation drive where the sap10e share points to.

Master Password

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Password</td>
<td>This password is used for all new user accounts SAPInst creates and for the secure store key phrase. The length has to be 8 to 14 characters. Depending on your installation scenario there might be more restrictions.</td>
</tr>
</tbody>
</table>

Caution

If you do not create the operating system users manually, SAPInst creates them with the common master password. For more information, see the description of the parameter Operating System Users. In this case, make sure that the master password meets the requirements of your operating system and of your database.

Operating System Users of the SAP System

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| Password of Operating System Users | SAPInst processes the passwords of operating system users as follows:  
  - If the operating system users do not exist, SAP creates the following users:
    - <sapsid>adm
      This user is the SAP system administrator user and is a member of the local Administrators group.
    - SAPService<sapsid>
      This user is the Windows account to run the SAP system. It is not a member of the local Administrators group. |
3.1 Basic SAP System Parameters

**Parameters**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
</table>
| *sapadm*  
The host agent user *sapadm* is used for central monitoring services and is a member of the local *Administrators* group. SAPinst sets the master password for these users by default. You can overwrite and change the passwords either by using the parameter mode [Custom](#) or by changing them on the parameter summary screen.  
- If the operating system users already exist, SAPinst prompts you for the existing password, except the password of these users is the same as the master password. |

**Caution**

Make sure that you have the required user authorization [page 47](#) for these accounts before you start the installation.

### User Management Engine (UME)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| **UME Configuration**  
SAPinst prompts you for how to configure the UME during the input phase of the installation.  
You can choose between the following options:  
- Use Java database (default).  
  - If you choose this option, administrators can manage users and groups with the UME Web admin tool and SAP NetWeaver Administrator only.  
- Use an external ABAP system.
  - If you choose this option, administrators can manage users with the transaction SU01 on the external ABAP system, and, depending on the permissions of the communication user, also with the UME Web admin tool and SAP NetWeaver Administrator.  
You must have created the required users manually on the external ABAP system.  
For more information, see Preparing User Management for an External ABAP System [page 43](#). |

### Using the Java Database:

<table>
<thead>
<tr>
<th>User</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Java Administrator User**  
SAPinst sets the user name *Administrator* and the master password by default. If required, you can choose another user name and password according to your requirements. |
| **Java Guest User**  
SAPinst sets the user name *Guest* and the master password by default. The *Guest* user is for employees who do not belong to a company or who have registered as company users with pending approval. Guest users belong to the default group *Authenticated Users* and have read access only. |

### Using an External ABAP System – Parameters for the ABAP Connection:
### 3.1 Basic SAP System Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Application Server Instance Number | This is the instance number on the application server of the central ABAP system to which you want to connect the Application Server Java.  
To find out the number on the host of the primary application server instance,  
look under the SAP directory `usr/sap/<SID>/DVEBMGS<nn>`. The value `<nn>`  
is the number assigned to the SAP system.                                      |
| Application Server Host    | This is the host name of the relevant application server instance.  
To find out the host name, enter `hostname` at the command prompt of the host running the primary application server instance. |
| Communication User         | This is the name and password of the existing ABAP communication user. You must have created this user manually on the external ABAP system.       |

**Using an External ABAP System – Parameters for the Application Server Java Connection:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator User</td>
<td>This is the name and password of the administrator user that you created on the external ABAP system.</td>
</tr>
<tr>
<td>Administrator Role</td>
<td>The role <code>SAP_J2EE_ADMIN</code> must exist on the external ABAP system.</td>
</tr>
</tbody>
</table>
| Guest User         | This is the name and password of the guest user that you created on the external ABAP system.  
The guest user is for employees who do not belong to a company or who have  
registered as company users with pending approval. Guest users belong to the  
default group `Authenticated Users` and have read access only.                  |
| Guest Role         | The role `SAP_J2EE_GUEST` must exist on the external ABAP system.                                                                         |

**Internet Communication Manager (ICM) User Management**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Password of `webadm` | The administration user `webadm` is created to use the web administration interface for Internet Communication Manager (ICM) and Web Dispatcher.  
SAPInst sets the master password by default. If required, you can choose another  
password. The length of the password must be between 5 and 128 characters.       |

**Host Agent as a Separate Installation**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Password of `sapadm` | The administration user `sapadm` is created to use central monitoring services.  
If this user is not already existing, it is created automatically by SAPInst.  
SAPInst prompts you to enter either the password of the existing user or a new  
password for the user to be created.                                           |
3.2 Hardware and Software Requirements

You check the hardware and software requirements for your operating system (OS) and the SAP instances using the Prerequisite Checker tool that provides information about the requirements that you need to meet before you start the installation. For example, it checks the requirements for the different installation options.

Note

- The values that are checked by the Prerequisite Checker apply to the installation of development systems or quality assurance systems.
- For the most recent updates to the Prerequisite Checker, always check SAP Note 855498.

You can run the Prerequisite Checker as follows:

- Standalone (optional):
To check the hardware and software requirements of the host on which you want to later install an SAP system, you can run the Prerequisite Checker standalone [page 34].

- **Integrated in SAPinst (mandatory):**
  SAPinst automatically runs the Prerequisite Checker when you install your SAP system.

**Recommendation**

We also recommend that you consult the requirements checklists tables, which also provide values for the installation of development systems or quality assurance systems. Depending on the amount of data involved, the requirements might change.

In addition, consider the following information:

- To get precise sizing values for production systems, you choose one of the following options:
  - You use the SAP QuickSizer tool that is available on SAP Service Marketplace at [http://service.sap.com/sizing](http://service.sap.com/sizing). You enter information about your planned system and the tool calculates the requirements.
    
    For more information, see Planning your System Landscape in the Master Guide for your SAP system, which is available on SAP Service Marketplace [page 10].
  - You contact your hardware vendor, who can analyze the load and calculate suitable hardware sizing depending on:
    - The set of applications to be deployed
    - How intensively the applications are to be used
    - The number of users
  - For supported operating system releases, see the Product Availability Matrix on SAP Service Marketplace at [http://service.sap.com/pam](http://service.sap.com/pam).

- Contact your OS vendor for the latest OS patches.
- Make sure that the host name meets the requirements listed in SAP Notes 61361 and 849423.

**Process Flow**

1. If required, you run the Prerequisite Checker standalone [page 34] to check the hardware and software requirements.

  **Caution**
  If you do not fully meet the requirements, you might experience problems when working with the SAP system.

2. In addition, we recommend that you check the hardware and software requirements checklists for the following system variants:
   - **Standard system** [page 35]
   - **Distributed system** [page 36]
3.2 Hardware and Software Requirements

Only valid for: HA (MCS)

- **High-Availability System with MCS** [page 38]

End of: HA (MCS)

- Additional application server instance
  
  If you want to install an additional application server instance, check the requirements listed for a **distributed system** [page 36].

- Application Sharing Server as an Optional Standalone Unit
  
  If you want to install the Application Sharing Server as a standalone unit, you must meet the same requirements than for a **Java standard system** [page 35].

- **Standalone Host Agent** [page 42]

### 3.2.1 Running the Prerequisite Checker in Standalone Mode (Optional)

Before installing your SAP system, you can run the Prerequisite Checker in standalone mode to check the hardware and software requirements for your operating system (OS) and the SAP instances.

**Recommendation**

We recommend that you use **both** the Prerequisite Checker and the requirements tables for reference.

**Note**

When installing your SAP system, SAPinst automatically starts the Prerequisite Checker and checks the hardware and software requirements in the background.

**Prerequisites**

- You have prepared the Installation Master DVD on the required installation host [page 54].

**Procedure**

1. You start **SAPinst** [page 61].
2. On the Welcome screen, choose **<SAP System> Software Life-Cycle Options Additional Preparation Tasks Prerequisites Check**.
3. Follow the instructions in the SAPinst dialogs and enter the required parameters.

**Note**

For more information about each parameter, position the cursor on the parameter field and choose **F1** in SAPinst.
When you have finished, the Parameter Summary screen appears summarizing all parameters you have entered. If you want to make a change, select the relevant parameters and choose Revise.

4. To start the Prerequisite Checker, choose Start.

**Result**

The Prerequisite Check Results screen displays the results found. If required, you can also check the results in file prerequisite_checker_results.html, which you can find in the installation directory.

### 3.2.2 Requirements for a Standard System

If you want to install a standard system, where all instances reside on one host, this host must meet the following hardware and software requirements:

**Hardware Requirements for a Standard System**

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
</table>
| Minimum disk space     | - Database Software: 1 GB (x86_64) 2 GB (IA64)  
- SAP system files (not including paging file): 5 GB (x86_64) 8 GB (IA64)  
- SAP database files (not including paging file): 2 GB  
- Up to 2 GB for each usage type or software unit you want to install.  
- 4.3 GB of temporary disk space for every required installation DVD that you have to copy to a local hard disk | To check disk space:
1. Choose Start ➤ All Programs ➤ Administrative Tools ➤ Computer Management ➤ Disk Management. ➤  
2. Right-click the drive and choose Properties. |
| Minimum RAM            | 1.5 GB                                                                      | To check RAM:
In the Windows Explorer choose Help ➤ About Windows ➤. |
| Paging file size       | 1 times RAM plus 8 GB                                                       | To check paging file size:
1. Right-click My Computer and choose Properties.  
2. Choose Advanced ➤ Performance Settings ➤.  
3. If required, in section Virtual Memory, choose Change. |
| Suitable backup system |                                                                             | —                                                                                                                                          |
Software Requirements for a Standard System

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows operating system</td>
<td>■ <strong>English international 64-bit version</strong> of one of the following:</td>
<td>To check your Windows version:</td>
</tr>
<tr>
<td></td>
<td>● Windows Server 2003 Standard Edition</td>
<td>1. Choose <strong>Start</strong> ➤ <strong>All Programs</strong> ➤ <strong>Accessories</strong> ➤ <strong>Command Prompt</strong> ➤.</td>
</tr>
<tr>
<td></td>
<td>● Windows Server 2003 Enterprise Edition</td>
<td>2. Enter the command <strong>winver</strong>.</td>
</tr>
<tr>
<td></td>
<td>● Windows Server 2003 Datacenter Edition</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ For any version of Windows Server 2003, you need at least service pack 2.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ A suitable Windows Resource Kit is strongly recommended.</td>
<td></td>
</tr>
<tr>
<td>Database software</td>
<td>■ Oracle 10g database server software</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Current Oracle patch set and hot fix, if available.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Note" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td>For more information about the current patch set, see <strong>SAP Note 871735</strong></td>
<td></td>
</tr>
</tbody>
</table>

**3.2.3 Requirements for a Distributed System**

This section provide information about the hardware and software requirements in a distributed system, where the SAP instances can reside on different hosts.

The tables show the requirements for the:

■ Central services instance
■ Database instance
■ Primary application server instance
■ Additional application server instance

![Note](image)

■ The listed values only apply for **development systems** or **quality assurance systems**.
■ If you install several SAP instances on one host, you need to add up the requirements.
## 3.2 Hardware and Software Requirements

### Hardware Requirements for a Distributed System

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space</td>
<td>- Database Software: 1 GB (x86_64) 2 GB (IA64)</td>
<td>To check disk space:</td>
</tr>
</tbody>
</table>
|                               | - Central services instance (SCS) (not including paging file): 5 GB (x86_64) 8 GB (IA64) | 1. Choose [Start] [All Programs] [Computer Management] [Disk Management].
|                               | - Database instance (not including paging file): 2 GB                        | 2. Right-click the drive and choose Properties.   |
|                               | - Primary application server instance (not including paging file): 5 GB (x86_64) 8 GB (IA64)  |
|                               | - In addition you require 4 GB (x86_64), or 8 GB (IA64) per additional platform. |                                                  |
|                               | - Up to 2 GB for each usage type or software unit you want to install.      |                                                  |
|                               | - Additional application server instance (not including paging file): 2.5 GB (x86_64) 5 GB (IA64) |                                                  |
|                               | - Temporary disk space for every required installation DVD that you have to copy to a local hard disk: 4.3 GB |                                                  |
| Minimum RAM                   | 1 GB                                                                         | To check RAM:                                     |
|                               |                                                                             | In the Windows Explorer, choose [Help] [About Windows]. |
| Paging file size              | - Central services instance (SCS): 1 times RAM plus 8 GB                     | To check paging file size:                        |
|                               | - Database instance: 1.5 times RAM recommended by Microsoft                 | 1. Right-click My Computer and choose Properties. |
|                               | - Primary application server instance: 1 times RAM plus 8 GB                | 2. Choose [Advanced] [Performance Settings].       |
| Suitable backup system        |                                                                             | 3. If required, in section Virtual Memory, choose Change. |

11/05/2007 PUBLIC 37/168
Software Requirements for a Distributed System

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows operating system</td>
<td>■ <strong>English international 64-bit version</strong> of one of the following:</td>
<td>To check your Windows version:</td>
</tr>
<tr>
<td></td>
<td>● Windows Server 2003 Standard Edition</td>
<td>1. Choose <strong>Start</strong> ➤ <strong>All Programs</strong> ➤ <strong>Accessories</strong> ➤ <strong>Command Prompt</strong> ➤ winver.</td>
</tr>
<tr>
<td></td>
<td>● Windows Server 2003 Enterprise Edition</td>
<td>2. Enter the command <strong>winver</strong>.</td>
</tr>
<tr>
<td></td>
<td>● Windows Server 2003 Datacenter Edition</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ For any version of Windows Server 2003, you need at least service pack 2.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ A suitable Windows Resource Kit is strongly recommended.</td>
<td></td>
</tr>
<tr>
<td>Database software</td>
<td>■ Database instance:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Oracle 10g database server software</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Current Oracle patch set and hot fix, if available.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Primary application server instance:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Additional application server instance:</td>
<td></td>
</tr>
</tbody>
</table>

Only valid for: HA (MSCS)

### 3.2.4 Requirements for a High-Availability System

This section provide information about the hardware and software requirements in a high-availability system.

**Note**

1. You must check that your cluster hardware is certified.
   AddOn Technology Center for SAP (Add On TCS) certifies hardware platforms for SAP on Microsoft Windows. The cluster must be included in the Microsoft list of certified clusters and its components. You can access the lists at the following Internet addresses:
   - [www.microsoft.com/whdc/hci/default.mspx](http://www.microsoft.com/whdc/hci/default.mspx)
   - [www.saponwin.com](http://www.saponwin.com)
2. You must make sure that the MSCS nodes of the cluster are connected by a private and public...
network:
- The public network enables communication from the MSCS nodes of the cluster to other resources in the local area network (LAN).
- The private network enables internal communication between the MSCS nodes. In particular, it enables the Cluster Service running on all MSCS nodes to regularly exchange messages on the state of the MSCS nodes so that the failure of resources is quickly detected.

3. Each of the MSCS nodes in the cluster must have its own local disks and have access to shared disks that can be reached by the MSCS nodes via a shared bus.

All software — except the Windows operating system, the Oracle home directory, and the MSCS software — is stored on the shared disks.

One of the shared disks must be used exclusively by the quorum (if a single quorum device cluster is used) that stores the cluster registry and records information about the state of the cluster.

You require at least 4 shared disks.

For more information about the distribution of components to local and shared disk, see Distribution of Components to Disks for MSCS [page 121].

⚠ Caution
- All disk controllers must be able to support hardware-based RAID.
- You cannot use a host with a domain controller as an MSCS cluster node.

The following tables show the hardware and software requirements for the:
- Central services instance (SCS)
- Database instance
- Enqueue Replication Server instance (ERS)
- Primary application server instance
- Additional application server instance

The listed values only apply for development systems or quality assurance systems.

⚠ Caution
- If you install several SAP instances on one host, you need to add up the requirements.
- If you install multiple SAP systems in one MS cluster, make sure that together with your hardware partner you have set up the correct sizing for your system configuration.
Hardware Requirements for a High-Availability System

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space</td>
<td>• Database Software:</td>
<td>To check disk space:</td>
</tr>
<tr>
<td></td>
<td>1 GB (x86_64)</td>
<td>1. Choose [Start] [All Programs] [Computer Management] [Disk Management].</td>
</tr>
<tr>
<td></td>
<td>2 GB (IA64)</td>
<td>2. Right-click the drive and choose Properties.</td>
</tr>
<tr>
<td></td>
<td>• Central services instance (SCS) (not including paging file):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 GB (x86_64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 GB (IA64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Database instance (not including paging file):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Enqueue replication server instance (ERS) (not including paging file):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 GB (x86_64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 GB (IA64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Primary application server instance (not including paging file):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.5 GB (x86_64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 GB (IA64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• In addition you require 4 GB (x86_64), or 8 GB (IA64) per additional platform.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Up to 2 GB for each usage type or software unit you want to install.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Additional application server instance (not including paging file):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.5 GB (x86_64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 GB (IA64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Temporary disk space for every required installation DVD that you have to copy to a local hard disk:</td>
<td>4.3 GB</td>
</tr>
<tr>
<td>Minimum RAM</td>
<td>1 GB</td>
<td>To check RAM:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the Windows Explorer, choose [Help] [About Windows].</td>
</tr>
<tr>
<td>Paging file size</td>
<td>• Central services instance (SCS):</td>
<td>To check paging file size:</td>
</tr>
<tr>
<td></td>
<td>1 times RAM plus 8 GB</td>
<td>1. Right-click [My Computer] and choose Properties.</td>
</tr>
<tr>
<td></td>
<td>• Database instance:</td>
<td>2. Choose [Advanced] [Performance Settings].</td>
</tr>
<tr>
<td></td>
<td>1.5 times RAM recommended by Microsoft</td>
<td>3. If required, in section [Virtual Memory], choose [Change].</td>
</tr>
<tr>
<td></td>
<td>• Enqueue replication server instance (ERS):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 times RAM plus 8 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Primary application server instance:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 times RAM plus 8 GB</td>
<td></td>
</tr>
</tbody>
</table>
## 3.2 Hardware and Software Requirements

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Additional application server instance: 1 times RAM plus 8 GB</td>
<td>–</td>
</tr>
<tr>
<td>Suitable backup system</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Software Requirements for a High-Availability System

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
</table>
| Windows operating system    | **English international 64-bit version** of one of the following:  
- Windows Server 2003 Enterprise Edition  
- Windows Server 2003 Datacenter Edition  
- For any version of Windows Server 2003, you need at least service pack 2.  
- A suitable Windows Resource Kit is strongly recommended. | To check your Windows version:  
1. Choose `Start` > `All Programs` > `Accessories` > `Command Prompt`.  
2. Enter the command `winver`.  
   **Note**  
   You must set up the MSCS Cluster Service as described in the Microsoft documentation. During this setup you are asked for a Windows Domain Account to run the Cluster Service. We strongly recommend creating an account different from the `<sapid>adm` user, for example `ClusterServiceuser=sapprdcladm`, where `Clustername=sapprdcl`. |
| Database software           | **Database instance:**  
- Oracle 10g database server software  
- Current Oracle patch set and hot fix, if available.  
  **Note**  
  For more information about the current patch set, see SAP Note 871735  
- Oracle Fail Safe software version 3.3.4  
- Primary application server instance: | – |

---

End of: HA (MSCS)
### 3.2.5 Requirements for the Host Agent as a Separate Installation

If you want to install the host agent separately, the installation host has to meet the following hardware and software requirements:

**Hardware Requirements for the Host Agent**

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space:</td>
<td>- Host agent: 80 MB</td>
<td>To check disk space:</td>
</tr>
<tr>
<td></td>
<td>- Temporary disk space for every required installation DVD that you</td>
<td>1. Choose [Start] ➤ [All Programs] ➤ Administrative Tools ➤ Computer Management ➤ Disk Management. ✗</td>
</tr>
<tr>
<td></td>
<td>have to copy to a local hard disk: 4.3 GB</td>
<td>2. Right-click the drive and choose Properties.</td>
</tr>
<tr>
<td>Minimum RAM:</td>
<td>40 MB</td>
<td>To check RAM:</td>
</tr>
<tr>
<td></td>
<td>In the Windows Explorer choose [Help] ➤ [About Windows] ✗.</td>
<td>1. Right-click <em>My Computer</em> and choose Properties.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. If required, in section Virtual Memory, choose Change.</td>
</tr>
<tr>
<td>Suitable backup system</td>
<td></td>
<td>—</td>
</tr>
</tbody>
</table>

**Software Requirements for the Host Agent**

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows operating system:</td>
<td><strong>English international 64-bit version</strong></td>
<td>To check your Windows version:</td>
</tr>
<tr>
<td></td>
<td>of one of the following:</td>
<td>1. Choose [Start] ➤ [All Programs] ➤ Accessories ➤ [Command Prompt] ✗.</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2003 Enterprise Edition</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2003 Datacenter Edition</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- For any version of Windows Server 2003, you need at least service pack 2.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- A suitable Windows Resource Kit is strongly recommended.</td>
<td></td>
</tr>
<tr>
<td>Database software:</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>
3.3 Preparing User Management for an External ABAP System

For a Java system, you can also deploy user management for an external ABAP system. In this case, you configure the User Management Engine (UME) of Application Server Java (AS Java) for the user management of a separate ABAP system.

If you want to connect more than one Java system to the same ABAP system, you need to work out a concept for the communication, administrator, and guest users for each system.

You can take one of the following approaches:

<table>
<thead>
<tr>
<th>Approach</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each Java system uses different users</td>
<td>No interdependencies between the connected engines</td>
<td>Initially more administration to create the users in the ABAP system</td>
</tr>
<tr>
<td>All Java systems use the same configuration</td>
<td>You create the users only once and enter the same information for every Java systems that you install.</td>
<td>Interdependencies between the connected engines:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- If you change the password of any of the users on the ABAP system, this change affects all connected engines.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- If you change the administrator user’s password, you must also change the password in secure storage on all of the connected Java systems</td>
</tr>
</tbody>
</table>

**Recommendation**

For security reasons, we recommend the first approach.

The procedures below assume that you are using the first approach.

**Prerequisites**

- The ABAP system is based on at least SAP Web AS ABAP release 6.20 SP25.
- In transaction PF0G, check that the roles `SAP_BC_JSF_COMMUNICATION` and `SAP_BC_JSF_COMMUNICATION_RO` exist and make sure that their profiles are generated.
- In transaction PF0G, check that the roles `SAP_J2EE_ADMIN`, `SAP_J2EE_GUEST` and `SAP_BC_FP_ICF` exist. Neither role contains any ABAP permissions, so you do not need to generate any profiles.
- In transaction PF0G, create a role named `ADSCallers`. You do not need to maintain authorization data or generate any profiles for that role.
- For more information, see:
For more information about role maintenance, see the SAP Library at

Administration of the ABAP system

Perform the following administration steps in the ABAP system:

1. In transaction SU01 create a new communication user and assign it to the role SAP_BC_JSF_COMMUNICATION_RO.

   **Recommendation**
   
   We recommend that you assign this user the role SAP_BC_JSF_COMMUNICATION_RO for read-only (display) access to user data with Java tools. If you intend to maintain user data (that is, to change, create, or delete users) with Java tools, you need to assign the role SAP_BC_JSF_COMMUNICATION instead.

   We recommend that you name the user SAPJSF_<SAPSID_Java_System>.

   You can use any password.

   In addition, to make sure that this user can only be used for communication connections between systems and not as a dialog user, assign it the type Communications under Logon data.

2. In transaction SU01 create a new dialog user and assign it to role SAP_J2EE_ADMIN. This is your administrator user in AS Java.

   **Recommendation**
   
   We recommend that you name the user J2EE_ADM_<SAPSID_Java_System>. You can use any password.

   **Caution**
   
   Log on to the SAP system once with this user to change its initial password. Because the installer of AS Java verifies this password, the installation fails if this password is initial.

3. In transaction SU01 create a new dialog user and assign it to role SAP_J2EE_GUEST. This is your guest user in AS Java.
4. In transaction SU01 create the following dialog users:

**Recommendation**

We recommend that you name the user J2EE_GST_<SAPSID_Java_System>. You can use any password.
As this user is only used for anonymous access to the system, we recommend you to deactivate the password and, if required, lock it after installation to prevent anyone from using it for explicit named logons.

4. In transaction SU01 create the following dialog users:

**Caution**

You must have changed the initial passwords [page 77] of these users before you start the installation of the Java system.

- **Users for Adobe Document Services (ADS) (optional):**
  - **ADSUER:**
    In transaction PFCG, assign the role ADSCallers to this user.
  - **ADS_AGENT:**
    In transaction PFCG, assign the role SAP_BC_FP_ICF to this user.

- **SLD Data supplier user (optional):**
  You only have to create this user if you want to install System Landscape Directory (SLD). The SLD data supplier user name that you enter later on during the Java system installation must be identical to this user.

**Recommendation**

We recommend that you name this user SLDDSUSER

- **SLD ABAP API user (optional):**
  You only have to create this user if you want to install System Landscape Directory (SLD). The SLD ABAP API user name that you enter later on during the Java system installation must be identical to this user.

**Recommendation**

We recommend that you name this user SLDAPIUSER

**Note**

For more information on SLD users and security roles, see the SLD User Guide at www.sap.com.
Activities for the Java System

Perform the following steps in the Java system:

1. **Before** the installation of the Java system, make sure that you have the correct user names and passwords of the users listed above for the separate ABAP system.
2. **During** the installation of the Java system, make sure that you enter the correct users and passwords in the corresponding SAPinst dialogs.

3.4 Checking the Windows File System

You need to check that you are using the Windows file system NTFS on hosts where you want to install the SAP system and database. NTFS supports full Windows security and long file names.

Note

You must use NTFS for an SAP system installation. Do **not** install the SAP directories on a FAT partition.

Procedure

1. Open the Windows Explorer.
2. Select the root directory.
   The system displays the type of file system in use.
4. Check that the file system is NTFS.

3.5 Checking the Windows Domain Structure

Note

You do **not** need this step for a local installation.

In Windows, you can implement either of the following domain models for the SAP system:

- **Extra domain**
  In this model, the SAP system is embedded in its own domain, which is specially defined for SAP. A second domain exists for the user accounts.
  In Windows, the SAP domain and user domain must be incorporated in a domain tree. In this tree, the user accounts must form the root domain and the SAP domain must be a child domain of this.

- **Single domain**
  In this model, the SAP system and the user accounts are included in a single domain.
3 Preparation

3.6 Reducing the Size of the File Cache

**Prerequisites**

- You are performing a domain installation.
- You are familiar with checking Windows domain structures. For more information, see the Windows documentation.

⚠️ Caution

You cannot create local users and groups on the host that is used as domain controller. Therefore, we do not support running an SAP instance (including the database instance) on the host where the domain controller is installed.

**Procedure**

For a domain installation, we recommend that you check that all SAP system and database hosts are members of a single Windows domain. We recommend this for all SAP system setups.

### 3.6 Reducing the Size of the File Cache

The Windows file cache competes directly with SAP programs for memory. Therefore, you need to adjust the file cache as described below.

**Procedure**

1. Choose Start Control Panel Network Connections Local Area Connections ➪
2. In the Local Area Connection Status dialog box, choose Properties.
3. In the Local Area Connection Properties dialog box, double-click File and Printer Sharing for Microsoft Networks.
4. Select Maximize data throughput for network applications.

⚠️ Caution

If you cannot select File and Printer Sharing for Microsoft Networks, this option has not yet been installed. To install it, you need the Windows Server CDs.

5. To confirm your entries, choose OK.

### 3.7 Required User Authorization for the Installation

Although SAPinst automatically grants the rights required for the installation to the user account used for the installation, you have to check whether this account has the required authorization to perform the installation. The authorization required depends on whether you intend to perform a domain or local installation. If necessary, you have to ask the system administrator to grant the
account the necessary authorization **before** you start the installation. If you attempt the installation with an account that has not the required authorization, the installation aborts. This section informs you about the authorization required for a domain and a local installation.

⚠️ **Caution**

Do not use the user `<sapsid>adm` for the installation of the SAP system.

### Domain Installation

For a domain installation the account used for the installation needs to be a member of the local **Administrators** and the domain **Admins** group of the domain involved. All machines in the system must belong to the same domain. In a domain installation, the user information is stored centrally on the domain controller and is accessible to all hosts in the system.

If the SAP system is to be distributed across **more than one** machine, SAP strongly recommends you to perform a domain installation to avoid authorization problems.

⚠️ **Caution**

- If you install a distributed system as a local installation, this can lead to authorization problems for the operating system users `<sapsid>adm` and `SAPService<SAPSID>`. It can also lead to problems with the transport directory, which is usually shared by several SAP systems. Therefore, SAP does not support a local installation for a distributed system and recommends you to install a distributed system as a domain installation.

  - If you still want to perform a local installation for a distributed system, make sure that:
    - You use the same password for the `<sapsid>adm` or the `SAPService<SAPSID>` user on all hosts.
    - The password for the `<sapsid>adm` and `SAPService<SAPSID>` user can differ.
    - You use the same master password on all hosts.
    - All hosts belong to the same Windows work group.

<table>
<thead>
<tr>
<th>Only valid for: HA (MSCS)</th>
</tr>
</thead>
</table>

- In an **MSCS** configuration, you always have to perform a domain installation.

<table>
<thead>
<tr>
<th>End of: HA (MSCS)</th>
</tr>
</thead>
</table>

- For performance and security reasons, SAP does not support an SAP system installation on a domain controller.

- If for any reason, the account used for the installation is not a member of the domain **Admins** group, you can perform the installation with a domain user who is a member of the local **Administrators** group. However, the domain administrator has to prepare the system appropriately for you.

For more information, see *Performing a Domain Installation without being a Domain Administrator* [page 49].

For a domain installation, you need to:

1. Check that the account used for the installation is a member of the domain **Admins** group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the domain Admins group.

Local Installation
For a local installation the account used for the installation needs to be a member of the local Administrators group of the machine involved. In a local installation, all Windows account information is stored locally on one host and is not visible to any other hosts in the system.

If the SAP system is to run on a single machine, you can perform a local installation.

For a local installation, you need to:

1. Check that the account used for the installation is a member of the local Administrators group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the local Administrators group.

3.8 Performing a Domain Installation Without Being a Domain Administrator

If for any reason, the account used for the installation is not a member of the domain Admins group, you can perform the installation with a domain user who is a member of the local Administrators group. In this case, the domain administrator has to prepare the system appropriately for you, as described in this section.

Note
You normally perform a domain installation of the SAP system with an user who is a member of the domain Admins group, as described in Required User Authorization for the Installation [page 47].

The domain administrator has to:

1. Create the new global group SAP_<SAPSID>_GlobalAdmin.
2. Create the two new SAP system users <sapsid>adm and SAPService<SAPSID>.
3. Add the users <sapsid>adm and SAPService<SAPSID> to the newly created group SAP_<SAPSID>_GlobalAdmin.

Prerequisites
You must perform this procedure as a domain administrator.

Creating the New Global Group SAP_<SAPSID>_GlobalAdmin

1. Log on as domain administrator.
2. To start the Active Directory Users and Computers Console, choose:

   → Start → All Programs → Administrative Tools → Active Directory Users and Computers →

4. Enter the following:
   Group name: SAP_<SAPSID>_GlobalAdmin

   **Note**
   Enter the SAP_<SAPSID>_GlobalAdmin group exactly as specified in the correct uppercase and lowercase.

5. Select the following:
   a) Group scope: Global
   b) Group type: Security

6. Choose OK.

### Creating the New SAP System Users <sapsid>adm and SAPService<SAPSID>

1. In Active Directory Users and Computers Console, right-click Users in Tree and choose:
   New User

2. Enter the following:

   **Note**
   Enter the <sapsid>adm and SAPService<SAPSID> user exactly as specified in the correct uppercase and lowercase.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input for &lt;sapsid&gt;adm</th>
<th>Input for SAPService&lt;SAPSID&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Initials</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Last name</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Full name</td>
<td>&lt;sapsid&gt;adm</td>
<td>SAPService&lt;SAPSID&gt;</td>
</tr>
<tr>
<td>User logon name</td>
<td>&lt;sapsid&gt;adm</td>
<td>SAPService&lt;SAPSID&gt;</td>
</tr>
</tbody>
</table>

3. Choose Next and enter the following:
   **Password:** <password>
3.9 Preparing the SAP System Transport Host

Confirm password: <password>

4. Select Password never expires

Note: Make sure that no other options are selected.

5. Choose Next  Finish.

Adding the <sapsid>adm User to the SAP_<SAPSID>_GlobalAdmin Group

1. In the Users folder, double-click the newly created user account <sapsid>adm in the list on the right.
2. Choose Member  Add.
3. Select the new SAP_<SAPSID>_GlobalAdmin group and choose Add to add it to the list.

Note: By default, the user is also a member of the Domain Users group.

4. Choose OK twice.

Adding the SAPService<SAPSID> User to the SAP_<SAPSID>_GlobalAdmin Group

1. In the Users folder, double-click the newly created user account SAPService<SAPSID> in the list on the right.
2. Choose Member  Add.
3. Select the new SAP_<SAPSID>_GlobalAdmin group.
4. Choose Add to add it to the list, and then OK.
5. Choose OK to close SAPService<SAPSID> Properties.

3.9 Preparing the SAP System Transport Host

The transport host has a directory structure that is used by the SAP transport system to store transport data and metadata. When you install an SAP system, SAPInst by default creates the transport directory on the primary application server instance host in \usr\sap\trans.
3.9 Preparing the SAP System Transport Host

In an MPCS configuration, SAPInst by default creates the transport directory on the (ABAP) central services instance host in \usr\sap\trans.

If you do not intend to use the directory structure of the system you are going to install, but want to use another new transport directory or an already existing transport directory, you need to prepare the transport host you are going to use:

- If the directory structure already exists, you must set up its security to allow the new system to write to it.
- If it does not yet exist, you must create the core directory structure and a share to export it for other computers as well as set the security on it.

**Procedure**

1. If the transport directory does not yet exist, do the following:
   a) Create the directory \usr\sap\trans on the host to be used as the transport host.
   b) Share the \usr\sap directory on the transport host as SAPMNT and put the security settings for Everyone to Full Control for this share.
      This enables SAPInst to address the transport directory in the standard way as \SAPTRANSHOST\SAPMNT\trans.
2. Grant Everyone the permission Full Control for the transport directory.

**Caution**

Remove the Full Control to Everyone permission after you have finished the installation with SAPInst and only grant Full Control on this directory to the SAP_<SAPSID>_Global1Admin groups of all the systems that are part of your transport infrastructure. SAPInst assigns the appropriate rights with the help of an additional SAP_LocalAdmin group. For more information, see *Automatic Creation of Accounts and Groups* [page 104].

**Note**

If, during the installation with SAPInst, you select the check box *SAP System will be under NWDI control* on the SAPInst screen *SAP System NWDI Landscape*, SAPInst copies all SCAs belonging to the usage types or software units that you installed to the global transport directory. For more information, see:

- [http://help.sap.com](http://help.sap.com) &lt;your product&gt; &gt; SAP NetWeaver Library &gt; Administrator’s Guide &gt; Software Life Cycle Management &gt; Software Logistics &gt; SAP NetWeaver Development Infrastructure &gt; Maintenance of an NWDI-Driven System Landscape

Only valid for: HA (MPCS)

Note

In an MPCS configuration, SAPInst by default creates the transport directory on the (ABAP) central services instance host in \usr\sap\trans.
3.10 Generating the SAP Solution Manager Key

The SAP Solution Manager is the strategic application management platform for customers and for collaboration between customers and SAP. You need a SAP Solution Manager to upgrade or install all SAP software.

During the installation of the primary application server instance, you are prompted to enter the SAP Solution Manager Key.

You can generate all needed keys for your entire system landscape – development, quality assurance, and production systems – in one SAP Solution Manager system. Even if you plan to install several solution landscapes (for example in different countries), one SAP Solution Manager is still sufficient. For more information about SAP Solution Manager, see http://service.sap.com/solutionmanager.

Prerequisites

- You require at least SAP Solution Manager 4.0 Support Package Stack (SPS) 9.
- If required, you can install SAP Solution Manager:
  - You order SAP Solution Manager as described in SAP Note 628901.
  - You install SAP Solution Manager as described in the documentation Installation Guide – SAP Solution Manager 4.0 on <OS>: <Database> on SAP Service Marketplace at:
    - http://service.sap.com/instguides

Procedure

1. In your SAP Solution Manager system, call transaction SMSY (System Landscape Maintenance).
2. To create your SAP system in the system landscape, proceed as follows:
   a) Select the landscape component Systems and choose Create New System from the context menu.
   b) Enter the system ID in the dialog box as the system.
   c) Select the relevant product and the corresponding product version from the input help and choose Save.
   d) Fill in the system data as much as possible.
      For more information, see the online help at Help ➤ Application Help ➤.
   e) Save your entries.
3. To generate the key, choose Other object... from the menu System Landscape.
4. Set the indicator System and choose the system that you want to install from the input help.
   If you created the system in the SAP Solution Manager in the previous step, choose this system.
5. Choose Generate Installation / Upgrade Key.
6. Enter the requested information.
7. Choose Generate Key.

Result

The system displays the key. Enter this key during the input phase of the installation
3.11 Preparing the Installation DVDs

This section describes how to prepare the installation DVDs, which are available as follows:

- You obtain the installation DVDs as part of the installation package, which is the normal case.
- You download the installation DVDs from SAP Service Marketplace, as described at the end of this section.

The tables below list the installation DVDs that are required for each instance of your SAP system. Depending on your installation type, one or more instances can reside on the same host. You need to keep this in mind when you make the required installation media available on each installation host.

**Recommendation**

We recommend that you make all required DVDs available in parallel.

**Caution**

If you perform a local installation and you have only one DVD drive on your installation host, you must copy at least the Installation Master DVD locally on your computer.

**Caution**

- If you copy the installation DVDs to disk, make sure that the paths to the location of the copied DVDs do not contain any blanks.
- If you use network drives for mounting the Export DVDs, make sure that the `<sapid>adm` user has access to the UNC paths of the network drives. If the user does not yet exist, you have to create it manually [page 49] before you install the database instance.

1. Identify the required DVDs for your installation as listed below and keep them separate from the remaining DVDs. This helps you to avoid mixing up DVDs during the installation.

**Caution**

The media names listed in the tables below are abbreviated.

**Note**

You can find the Software Component Archives (SCAs) for the installation of SAP NetWeaver usage types on the NetWeaver Java DVD.
The following table shows the required DVDs for the installation of a productive system of SAP NetWeaver Composition Environment:

<table>
<thead>
<tr>
<th>SAP Instance Installation</th>
<th>Required DVDs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central services instance, primary application server</td>
<td>• Installation Master DVD</td>
</tr>
<tr>
<td>instance, additional application server instance</td>
<td>• NetWeaver Java DVD</td>
</tr>
<tr>
<td></td>
<td>• RDBMS Client DVD</td>
</tr>
<tr>
<td></td>
<td>• RDBMS DVD</td>
</tr>
<tr>
<td></td>
<td>• Kernel DVD</td>
</tr>
<tr>
<td>Database instance</td>
<td>• Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>• NetWeaver Java DVD</td>
</tr>
<tr>
<td></td>
<td>• RDBMS DVD</td>
</tr>
<tr>
<td></td>
<td>• RDBMS Patch DVD</td>
</tr>
</tbody>
</table>

Host Agent (Standalone)

<table>
<thead>
<tr>
<th>SAP Instance Installation</th>
<th>Required DVDs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Agent</td>
<td>• Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>• Kernel DVD</td>
</tr>
</tbody>
</table>

2. Use one of the following methods to make DVDs available in parallel:
   - Before the installation:
     - Have sufficient DVD drives
     - Copy DVDs manually to local hard disks
   - During the installation:
     - Use the SAPinst Media Browser dialog. You can check the entered location and then copy the entire DVD to the path you entered in the Copy Package to column.

**Downloading Installation DVDs from SAP Service Marketplace (Optional)**

You normally obtain the installation DVDs as part of the installation package from SAP. However, you can also download installation DVDs from SAP Service Marketplace at:

http://service.sap.com/swdc Downloads Installations and Upgrades Entry by Application Group <your solution> <release of your solution> <your operating system> <your database>.

**Note**

If you download installation DVDs, note that DVDs might be split into several files. In this case, you have to reassemble the required files after the download.
To extract the downloaded SAR files make sure that you use the latest SAPCAR version, which you can find on SAP Service Marketplace at [http://service.sap.com/swdc](http://service.sap.com/swdc). You need at least SAPCAR 700 or SAPCAR 640 with patch level 4 or higher because older versions of SAPCAR can no longer unpack current SAR files. For more information, see SAP Note [212876](http://service.sap.com/swdc).

1. Create a download directory on the host on which you want to run SAPinst.
2. Identify all download objects that belong to one installation DVD according to one or both of the following:
   - **Material number**
     All download objects that are part of an installation DVD have the same material number and an individual sequence number:
     \[<\text{material\_number}>\_<\text{sequence\_number}>\]

   **Example**
   
   51031387_1
   51031387_2
   ...

   - **Title**
     All objects that are part of an installation DVD have the same title, such as
     \[<\text{solution}>\_<\text{DVD\_name}>\_<\text{OS}>\text{ or }<\text{database}>\_<\text{RDBMS}\_<\text{OS}>\text{ for RDBMS DVDs.}\]

3. Download the objects to the download directory.
4. Extract the individual download objects using SAPCAR, starting with the lowest sequence number – for example 51031387_1, then 51031387_2, and so on.
   During the download SAPCAR sets up the structure of the installation DVD.

**Note**

SAPCAR asks if you want to replace existing files, for example `LABELIDX.ASC`. Always accept with **Yes**.
4 Installation

This section includes the installation steps that you have to perform for the:

- Standard system
- Distributed system [Only valid for HA (MSCS)]
- High-availability system [End of HA (MSCS)]
- Additional application server instance
- Host agent

**Standard System**

1. You install the Oracle database software [page 59] on the host where you install the SAP system.

   ![Note](image)
   This step is not required if you install a system into an existing database (MCOD) [page 21].

2. If required, you set up multiple Oracle Homes [page 61] on the host where you install the SAP system.

   ![Note](image)
   This step is not required if you install a system into an existing database (MCOD) [page 21].

3. You install the SAP system with SAPinst [page 61].

   ![Note](image)
   In a standard system all mandatory instances are installed on one host in one installation run.

4. You can now continue with Post-Installation [page 73].

**Distributed System**

1. On the host where the primary application server instance is to run, you run SAPinst [page 61] to install the central services instance.

2. On the database instance host, you install the Oracle database software [page 59].
3. If required, on the database instance host, you set up multiple Oracle Homes [page 61].

4. On the database instance host, you run SAPinst [page 61] to install the database instance.
5. On the primary application server instance host, you run SAPinst [page 61] to install the primary application server instance.
6. If required, on the additional application server instance host(s), you install the additional application server instance(s) (see below).
7. You can now continue with Post-Installation [page 73].

Only valid for: HA (MSCS)

**High-Availability System**

If you want to perform a Microsoft Cluster Service (MSCS) installation, see Installation [page 141] in chapter High Availability with Microsoft Cluster Service.

1. You perform the MSCS-specific installation steps [page 141].
2. You can now continue with Post-Installation [page 73].

End of: HA (MSCS)

**Additional Application Server Instance(s)**

You perform the following steps on each host where you install the additional application server instance(s).

1. You run SAPinst [page 61] to install the additional application server instance(s).

Only valid for: HA (MSCS)

**Caution**

In a high-availability system, you must install at least one additional application server instance.

End of: HA (MSCS)

2. You can now continue with Post-Installation [page 73].

**Installation Steps for Additional Components and Tools for SAP NetWeaver CE (Optional)**

- You install additional components [page 69] for SAP NetWeaver Composition Environment, such as
  - Composition Tools
4.1 Installing the Oracle Database Software

- Adobe Document Services
- Composite Voice
- IDE Update Site
- You install SAP Memory Analyzer [page 71] for SAP NetWeaver Composition Environment.

Host Agent on a Host without an SAP Component

1. You run SAPinst [page 61] to install the Host Agent.
2. You can now continue with Post-Installation [page 73].

4.1 Installing the Oracle Database Software

This section describes how to install the Oracle 10g database server software on the database host.

Note

- As of Oracle 10g there is no need to manually install the Oracle client software on the application server, as SAPinst automatically installs the client software in the DIR_CT_RUN directory.
- For supplementary information about Oracle 10g, see the documentation provided by Oracle on the RDBMS DVD under <DVD_Drive>:\NT\<platform>\database\doc\index.htm
- If you have already installed an Oracle database instance or the Oracle software, and you want to install an additional database instance, you have to decide whether you want to use single or multiple Oracle Homes [page 23].

Only valid for: HA (MSCS)

Caution

- You have to install the Oracle server software on all MSCS nodes.
- If you use multiple Oracle Homes, you must have one ORACLE_HOME per database instance on every cluster node on local disks.
- All ORACLE_HOMES must use the same disks and directories and ORACLE_HOME names on all DB MSCS nodes.

End of: HA (MSCS)

Procedure

1. On the database server, start the Oracle Universal Installer as follows:
   - Place the Oracle in the DVD drive and change to the directory: <DVD_DRIVE>:\NT\<platform>
2. Double-click the file sapserver.cmd.
3. In the dos-box, specify the drive letter of the local disk where you want to install the Oracle software, and the <DBSID>.
4. Install the Oracle Database Software

4.1 Installing the Oracle Database Software

**Note**
The dos-box only appears if you perform a new installation (or under a different user), or if `<Oracle_Home>` and `<DBSID>` are not set.

4. In the Oracle Universal Installer, enter the information as shown in the following table:

<table>
<thead>
<tr>
<th>Window</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Specify File Locations</strong></td>
<td>If this screen appears, do the following:</td>
</tr>
<tr>
<td></td>
<td>- Under <strong>Source</strong>:</td>
</tr>
<tr>
<td></td>
<td>- For <strong>Path</strong>:</td>
</tr>
<tr>
<td></td>
<td>Shows the path to the Oracle source software.</td>
</tr>
<tr>
<td></td>
<td>Do <strong>not</strong> change the path.</td>
</tr>
<tr>
<td></td>
<td>- Under <strong>Destination</strong>:</td>
</tr>
<tr>
<td></td>
<td>- For <strong>Name</strong>:</td>
</tr>
<tr>
<td></td>
<td>Enter the name of the new <code>&lt;Oracle_Home&gt;</code> directory. We recommend that you use the name <code>&lt;SAPSID&gt;</code>&lt;ORACLE_VERSION&gt;, for example, C12102</td>
</tr>
<tr>
<td></td>
<td>- For <strong>Path</strong>:</td>
</tr>
<tr>
<td></td>
<td>Enter the path of a new <code>&lt;Oracle_Home&gt;</code> directory. We recommend that you use the path: <code>&lt;DRIVE&gt;:\ORACLE\&lt;DBSID&gt;\&lt;ORACLE_VERSION&gt;</code>, for example, C:\ORACLE\C12\102</td>
</tr>
</tbody>
</table>

**Note**
Do **not** specify an already existing `<Oracle_Home>` directory. You must specify a new directory.

Choose Next.

<table>
<thead>
<tr>
<th>Window</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Summary</strong></td>
<td>Choose Install.</td>
</tr>
<tr>
<td><strong>Oracle Net Configuration Assistant: Welcome</strong></td>
<td>If this dialog appears, select <strong>Perform typical configuration</strong>.</td>
</tr>
<tr>
<td><strong>Configuration Assistants</strong></td>
<td><strong>Note</strong>&lt;br&gt;If you get an error message, choose <strong>OK</strong>. Ignore the following <strong>Warning</strong> screen and choose <strong>OK</strong>.&lt;br&gt;Choose Next.</td>
</tr>
<tr>
<td><strong>End of Installation</strong></td>
<td>Choose Exit to close the Oracle Universal Installer.</td>
</tr>
</tbody>
</table>

5. Install the latest patch set and hot fix (if available) as described in **SAP Note 871735**.
4.2 Setting Up Multiple Homes (Optional)

This section only applies, if you want to use multiple Oracle Homes [page 23].

Procedure

1. Remove all parts referring to `<Oracle_Home>\bin` from the system environment variable `PATH`:
   a) Start the Oracle Universal Installer with \Start\Programs\Oracle - <Home_Name>\Oracle Installation Products\Universal Installer.
   b) In the Welcome screen, choose Installed Products.
   c) In the Inventory screen, choose the Environment tab.
   d) Deselect all components and choose Apply.
2. Update or create, if not available, the user environment variable `PATH` of the user who performs the installation with SAPinst:
   a) Choose \My Computer\Properties\Advanced\Environment Variables.
   b) Under User variable for `<user>` modify or create, if not available, the value `PATH` to include the `<Oracle_Home>\bin`, which you want to use for the installation.

Note

You also have to modify the user environment variable `PATH` for all other users using the Oracle software.

4.3 Running SAPinst

This procedure tells you how to install an SAP system with SAPinst. SAPinst includes a SAPinst GUI and a GUI server, which both use Java.

This section describes an installation where SAPinst, SAPinst GUI, and the GUI server are running on the same host. If required, you can instead perform a remote installation with SAPinst [page 97], where SAPinst GUI is running on a separate host from SAPinst and the GUI server.

When you start SAPinst, SAPinst GUI and the GUI server also start. SAPinst GUI connects via a secure SSL connection to the GUI server and the GUI server connects to SAPinst.
Note the following information about SAPinst:

- SAPinst normally creates the installation directory sapinst_instdir, where it keeps its log files, and which is located directly in the Program Files directory. If SAPinst is not able to create sapinst_instdir there, it tries to create sapinst_instdir in the directory defined by the environment variable TEMP.

  Recommendation
  We recommend that you keep all installation directories until the system is completely and correctly installed.

- SAPinst creates a subdirectory for each installation option called <sapinst_instdir>\<installation_option_directory>, which is located in %ProgramFiles%.
- The SAPinst Self-Extractor extracts the executables to a temporary directory (TEMP, TMP, TMPDIR, or SystemRoot). These executables are deleted after SAPinst has stopped running. Directories called sapinst_exe.xxxxxx.xxxx sometimes remain in the temporary directory. You can safely delete them. The temporary directory also contains the SAPinst Self-Extractor log file dev_selfex.out, which might be useful if an error occurs.

  Caution
  If SAPinst cannot find a temporary directory, the installation terminates with the error FCO-00058.

- During the installation, the default ports 21200, 21212, and 4239 are used for communication between SAPinst, GUI server, SAPinst GUI, and HTTP server. SAPinst uses port 21200 to communicate with the GUI server. The GUI server uses port 21212 to communicate with SAPinst GUI. 4239 is the port of the HTTP server, which is part of the GUI server. You get an error message if one of these ports is already in use by another service. In this case, open a command prompt and change to the required directory as follows:

  <DVD drive>:\DATA_UNITS\IM.Windows_<platform>

  Enter the following command in a single line:

  sapinst.exe SAPINST_DIALOG_PORT=<free_port_number_sapinst_to_gui_server>
  GUISERVER_DIALOG_PORT=<free_port_number_gui_server_to_sapinst_gui>
  GUISERVER_HTTP_PORT=<free_port_number_http_server>

- To get a list of all available SAPinst properties, go to the directory (%TEMP%\sapinst_exe.xxxxxx.xxxx), after you have started SAPinst, and enter the following command:

  sapinst.exe -p

- If you want to terminate SAPinst and the SAPinst Self-Extractor, choose one of the following options:
  - Right-click the icon for the SAPinst output window located in the Windows tray and choose Exit.
Click the icon for the SAPinst output window located in the Windows tray and choose File Exit.

Using SAPinst GUI

The following table shows the most important functions that are available in SAPinst GUI:

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function key</td>
<td>F1</td>
<td>Displays detailed information about each input parameter</td>
</tr>
<tr>
<td>Menu option</td>
<td>File Exit</td>
<td>Stops the SAPinst GUI, but SAPinst and the GUI server continue running</td>
</tr>
<tr>
<td>Note</td>
<td></td>
<td>If you need to log off during the installation from the host where you control the installation with SAPinst GUI, the installation continues while you are logged off. You can later reconnect to the same SAPinst installation from the same or another host. For more information, see Starting SAPinst GUI Separately [page 98].</td>
</tr>
<tr>
<td>Menu option</td>
<td>SAPinst Log Browser</td>
<td>Displays the Log Viewer dialog This dialog enables you to access the following log files directly: Installation log (sapinst_dev.log) Log files from the SAPinst GUI server These log files might help you during troubleshooting with SAPinst [page 101].</td>
</tr>
<tr>
<td>Menu option</td>
<td>SAPinst Cancel</td>
<td>Cancels the installation with the following options: Stop Stops the installation (SAPinst GUI, SAPinst and the GUI server) without further changing the installation files. You can restart and continue the installation later from this point. Continue Continues the installation</td>
</tr>
<tr>
<td>Button</td>
<td>Retry</td>
<td>Performs the installation step again (if an error has occurred)</td>
</tr>
<tr>
<td>Button</td>
<td>Stop</td>
<td>Stops the installation without further changing the installation files You can continue the installation later from this point.</td>
</tr>
<tr>
<td>Button</td>
<td>Continue</td>
<td>Continues with the option you have chosen before</td>
</tr>
</tbody>
</table>
4.3 Running SAPinst

Prerequisites

- You use an account with the required user authorization to install the SAP system with the SAPinst tool [page 47].
- You need at least 130 MB of free space in the installation directory for each Java installation option. In addition, you need 60-200 MB free space for the SAPinst executables.
- Make sure that you have defined the most important SAP system parameters as described in Basic SAP System Parameters [page 26] before you start the installation.
- Check that your installation host(s) meets the requirements for the installation option(s) that you want to install. For more information, see Running the Prerequisite Checker [page 34].
- If you are installing a second or subsequent SAP system in an existing database, make sure that the database is up and running before starting the installation. For more information, see Installation of Multiple Components in One Database [page 21].

Procedure

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Start SAPinst from the SAP Installation Master DVD by double-clicking sapinst.exe from the following path:
   \<DVD drive>\DATA_UNITS\IM_WINDOWS\<platform>
   SAPinst GUI starts automatically by displaying the Welcome screen. However, if there is only one component to install, SAPinst directly displays the first input dialog without presenting the Welcome screen.
3. In the Welcome screen, choose the required SAPinst installation option [page 65] from the tree structure.

   **Note**

   If you want to use the following installation options listed under Software Life-Cycle Options, you must start them before you start the installation of the SAP system:
   - Operating System Users and Groups
     Choose this option, if the operating system users do not yet exist and you do not want to create them manually.

   **Note**

   Make sure that you have the required user authorization [page 47] for these accounts before you start the installation.

4. If SAPinst prompts you to log off from your system, log off and log on again. SAPinst restarts automatically.
5. Follow the instructions in the SAPinst dialogs and enter the required parameters.
For more information about the input parameters, position the cursor on the required parameter and press [F1].

6. To start the installation choose Start.
SAPinst starts the installation and displays the progress of the installation. When the installation has successfully completed, SAPinst shows the dialog Execution of '<Option_Name>' has been completed successfully.

7. If you want to install an additional application server instance for a standard (central) or distributed system, choose the installation option ▶ <SAP System> ▶ Software Life-Cycle Options ▶ Additional Application Server Instances ▶ Additional application server instance ▶.

8. We recommend deleting all files in the directory %userprofile%\.sdtgui\.

**More Information**

- Interrupted Installation with SAPinst [page 95]
- Performing a Remote Installation with SAPinst (Optional) [page 97]
- Starting SAPinst GUI Separately (Optional) [page 98].
- Entries in the Services File Created by SAPinst [page 100]
- How to Avoid Automatic Logoff by SAPinst [page 100]
- Troubleshooting with SAPinst [page 101]

### 4.4 SAPinst Installation Options

This section provides information about the following installation options in SAPinst:

- Installation Options
- Software Life-Cycle Options

Note

Choose the required installation options from the tree structure **exactly** in the order they appear for each system variant.

**Multiple Oracle Homes only:**

SAPinst uses default values for the Oracle Home and Listener configuration. Therefore, if you use multiple Oracle Homes, you must specify the new Oracle home, as well as the listener port number. You can change these values on the SAPinstParameter Summary screen during the database instance installation. On the Parameter Summary screen, check both Oracle Database System and Oracle Listener Configuration and use the Revise button. On the upcoming screen change the Oracle Home and the Listener port number. Make sure to use a free port number, and do **not** use the numbers 1521 or 1527 as these may be already in use by default.
4.4  SAPinst Installation Options

- If required, install an additional application server instance for a standard system (all instances on one host) or distributed system by choosing "<SAP System> » Software Life-Cycle Options » Additional Application Server Instance » Additional Application Server Instance".

- If required, install additional CE components by choosing "<SAP System> » Software Life-Cycle Options » Additional CE Components » Additional CE components".

- If required, install SAP Memory Analyzer by choosing "<SAP System> » Software Life-Cycle Options » SAP Memory Analyzer » SAP Memory Analyzer".

Installation Options

You choose "SAP Systems with <your database>" to install a SAP system with usage types or software units. You can install the following system variants:

- Standard System

### Installation Options for a Standard System

<table>
<thead>
<tr>
<th>Installation Option</th>
<th>Remarks</th>
</tr>
</thead>
</table>
| Standard System     | Installs a complete SAP system including the following instances on one host:  
|                     | ● Central services instance (SCS)  
|                     | ● Database instance  
|                     | ● Primary application server instance  
|                     | You can install a standard system in the following parameter modes:  
|                     | ● Typical Mode  
|                     | If you choose Typical, automatic default settings will be provided. You only have to respond to a small selection of prompts. However, you can change any of the default settings on the parameter summary screen.  
|                     | ● Custom Mode  
|                     | If you choose Custom, all installation parameter will be prompted. In the end, you can still change any of these parameters on the parameter summary screen. |

**Note**

You require at least usage type AS Java or AS ABAP. You can choose the usage types or software units on the next screen.

- Distributed System
### Installation Options for a Distributed System

<table>
<thead>
<tr>
<th>Installation Options</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central Services Instance (SCS)</td>
<td>Installs a central services instance (SCS) and prepares the SAP global host. Mandatory step in installing a distributed SAP system with usage types or software units based on AS Java.</td>
</tr>
<tr>
<td>Database Instance</td>
<td>Installs a database instance. Mandatory step in installing a distributed SAP system. You must have finished the Central Services Instance (SCS) installation, before you can choose this installation option.</td>
</tr>
<tr>
<td>Primary Application Server Instance</td>
<td>Installs a primary application server instance and enables additional software units. Mandatory step in installing a distributed SAP system on several hosts. You must have finished the database instance installation.</td>
</tr>
</tbody>
</table>

*Only valid for: HA (MSCS):HA (UNIX):HA (z/OS)*

#### High-Availability System

### Installation Options for a High Availability System

<table>
<thead>
<tr>
<th>Installation Options</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central Services Instance (SCS)</td>
<td>Installs a central services instance (SCS)</td>
</tr>
<tr>
<td>First MSCS Node</td>
<td>Performs the following steps on the first Microsoft Cluster Service (MSCS) node:</td>
</tr>
<tr>
<td></td>
<td>• Creates the SAP cluster group</td>
</tr>
<tr>
<td></td>
<td>• Adds the ASCS and SCS instances to the SAP cluster group</td>
</tr>
<tr>
<td></td>
<td>• Adds the SCS instance to the SAP cluster group</td>
</tr>
<tr>
<td></td>
<td>• Adds the ASCS instance to the SAP cluster group</td>
</tr>
<tr>
<td>Database Instance</td>
<td>Installs a database instance</td>
</tr>
<tr>
<td>Host Agent</td>
<td>Installs the host agent</td>
</tr>
<tr>
<td>Additional MSCS Node</td>
<td>Configures an additional Microsoft Cluster Service (MSCS) node to run the SAP cluster group You must have completed the configuration of the first MSCS node and the database instance installation.</td>
</tr>
<tr>
<td>Enqueue Replication Server Instance</td>
<td>Installs an enqueue replication server, which contains a replica of the lock table (replication server)</td>
</tr>
</tbody>
</table>
### Software Life-Cycle Options

You use the options located in this folder to perform the following tasks or to install the following components:

<table>
<thead>
<tr>
<th>Installation Option</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Preparations</td>
<td></td>
</tr>
<tr>
<td>Host Agent</td>
<td></td>
</tr>
<tr>
<td>Choose <code>Additional Preparations</code> <code>Host Agent</code> to install the host agent with the profiles <code>SAPSystem=99</code> and <code>SAPSystemName=SAP</code>.</td>
<td></td>
</tr>
<tr>
<td>The host agent contains all of the required elements for centrally monitoring any host.</td>
<td></td>
</tr>
<tr>
<td>Normally you do not need to install the host agent separately, because it is automatically installed during the installation of all SAP NetWeaver components, except TREP.</td>
<td></td>
</tr>
<tr>
<td>You only need to install the host agent separately in the following cases:</td>
<td></td>
</tr>
<tr>
<td>- You want to centrally monitor a host that does not have an SAP component.</td>
<td></td>
</tr>
<tr>
<td>- You want to perform an upgrade to SAP NetWeaver.</td>
<td></td>
</tr>
<tr>
<td>For more information, see <em>Host Agent as a Separate Installation</em> [page 17].</td>
<td></td>
</tr>
<tr>
<td>Operating system users and groups</td>
<td></td>
</tr>
<tr>
<td>Creates all operating system users for your SAP system if they do not yet exist.</td>
<td></td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td></td>
</tr>
<tr>
<td>- Perform this SAPinst option <strong>before</strong> you start the installation of your SAP system.</td>
<td></td>
</tr>
<tr>
<td>- Make sure that you have the <strong>required user authorization</strong> [page 47] for these accounts before you start the installation.</td>
<td></td>
</tr>
<tr>
<td>Prerequisites check</td>
<td></td>
</tr>
<tr>
<td>Choose <code>Additional Preparations</code> <code>Prerequisites Check</code> if you want to check your hardware and software requirements <strong>before</strong> you start the installation.</td>
<td></td>
</tr>
<tr>
<td>Otherwise, SAPinst automatically checks the hardware and software requirements during the installation with the Prerequisite Checker. If any changes are necessary to the SAP system or operating system settings,</td>
<td></td>
</tr>
</tbody>
</table>
### 4.5 Installing Additional Components (Optional)

You can install the following additional components:

- Composition Tools
- Adobe Document Services
- Composite Voice
- IDE Update Site

**Prerequisites**

You need to fulfill the same hardware and software requirements as for your already installed production system plus an additional 2 GB RAM.

---

<table>
<thead>
<tr>
<th>Installation Option</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Application Server Instances</td>
<td>SAPInst automatically prompts you. For more information, see Running the Prerequisites Checker in Standalone Mode [page 34].</td>
</tr>
<tr>
<td>Additional CE Components</td>
<td>Choose to install one or more additional application server instance(s) in an already installed SAP system, if required.</td>
</tr>
<tr>
<td>SAP Memory Analyzer</td>
<td>Choose this option to install SAP Memory Analyzer. SAP Memory Analyzer helps you to analyze Java heap dumps, easily find big chunks of memory or complex memory aggregation patterns in your data structures and identify who is keeping this memory alive.</td>
</tr>
<tr>
<td>System Copy</td>
<td>Choose this option to perform a system copy. For more information, see the system copy guide for your SAP system on SAP Service Marketplace at: <a href="http://service.sap.com/instguides">http://service.sap.com/instguides</a></td>
</tr>
<tr>
<td>Uninstall</td>
<td>Choose this option to uninstall your SAP system, standalone engines, or optional standalone units. For more information, see Deleting an SAP System [page 107].</td>
</tr>
</tbody>
</table>
4.5 Installing Additional Components (Optional)

Note

- Before installing additional components, you need to stop all application servers manually.
- Before installing additional components and in the case that you made changes to the default template settings, see SAP Note 953763.

Procedure

Note

When installing from a network share make sure that everyone has read access to this share. The installation routine creates users such as \$\text{sid}\_\text{adm}$ (for example, ce1adm). During the installation SAPInst does a user switch to this user. If the newly created user does not have permissions to the network share where the installation is running from, the installation will fail.

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Run SAPInst [page 61].
3. In the Welcome screen, choose $\Rightarrow$ SAP NetWeaver CE Productive System $\Rightarrow$ Software Life-Cycle Options $\Rightarrow$ Additional CE Components $\Rightarrow$ Install Additional Components $\Rightarrow$.
4. Choose whether you want to run the installation in Typical mode or in Custom mode.
   - If you select Typical, the installation wizard provides automatic default settings and you only have to respond to a small selection of prompts. The rest is set by default. If you select Custom, you have to respond to all prompts.

Note

If you want to install the offline documentation for SAP NetWeaver CE, you need to choose Custom mode.

After the installation, you can access the offline documentation by choosing $\Rightarrow$ Start $\Rightarrow$ All Programs $\Rightarrow$ SAP NetWeaver Composition Environment $\Rightarrow$ <SAPSID> $\Rightarrow$.

5. Follow the screens and enter the required parameters.

Note

For more information about the input parameters and information about restrictions for passwords, position the cursor on the required parameter and press F1.

After you have entered all requested input parameters, SAPInst displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that SAPInst set by default. If required, you can revise the parameters before starting the installation.

6. To start the installation, choose Start. SAPInst starts the installation and displays the progress of the installation. When the installation has successfully been completed, SAPInst shows the dialog Execution of <Service_Name> has been completed successfully.
4.6 Installing SAP Memory Analyzer (Optional)

SAP Memory Analyzer helps you to analyze Java heap dumps, easily find big chunks of memory or complex memory aggregation patterns in your data structures and identify who is keeping this memory alive. New and innovative analysis techniques support the user with an extremely fast and powerful feature set. The tool (Eclipse RCP application) was developed to analyze real productive heap dumps, which tend to get enormous in size with hundreds of millions of objects. Performance, low resource consumption and especially the newly developed innovative analysis techniques make it a helpful tool, even to small application heap dumps.

You can install SAP Memory Analyzer as an additional tool.

Procedure

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Run SAPinst [page 6].
3. In the Welcome screen, choose SAP NetWeaver CE Productive System ➔ Software Life-Cycle Options ➔ SAP Memory Analyzer ➔ Install SAP Memory Analyzer ➔.
4. Choose whether you want to run the installation in Typical mode or in Custom mode. If you select Typical, the installation wizard provides automatic default settings and you only have to respond to a small selection of prompts. The rest is set by default. If you select Custom, you have to respond to all prompts.

Note

If you want to install the offline documentation for SAP NetWeaver CE, you need to choose Custom mode. After the installation, you can access the offline documentation by choosing Start ➔ All Programs ➔ SAP NetWeaver Composition Environment ➔ <SAPSID> ➔.
5. Follow the screens and enter the required parameters.

Note
For more information about the input parameters and information about restrictions for passwords, position the cursor on the required parameter and press [F1].

After you have entered all requested input parameters, SAPinst displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that SAPinst set by default. If required, you can revise the parameters before starting the installation.

6. To start the installation, choose Start. SAPinst starts the installation and displays the progress of the installation. When the installation has successfully been completed, SAPinst shows the dialog 

Execution of <Service_Name> has been completed successfully.
5 Post-Installation

This section includes the post-installation steps that you have to perform for the:
- Standard, distributed or high-availability system
- Additional application server instance
- Host agent as a separate installation

Post-Installation Steps for a Standard, Distributed, or High-Availability System

Note
In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.

1. If required, you perform a full system backup [page 86] immediately after the installation has finished.
2. You check whether you can log on to the SAP system [page 74].

Note
In a distributed or high-availability system you check whether your can log on to every instance of the SAP system that you installed.

3. You ensure user security [page 77].
4. You install the SAP license [page 78].
5. You configure the remote connection to SAP support [page 76].
6. On the primary application server instance host, you apply the latest kernel and Support Packages [page 76].
7. You check the Java manuals [page 81] for information that is relevant for running your Java system.
8. You perform CE-specific post-installation steps [page 82].
9. On the database instance host, you perform Oracle-specific post-installation steps [page 85].
10. You perform a full system backup [page 86].

Post-Installation Steps for an Additional Application Server Instance

1. You check whether you can log on to the additional application server instance [page 74].
2. You perform a full system backup [page 86].

Post-Installation Steps for the Host Agent as a Separate Installation
You perform the post-installation steps for the Host Agent [page 80].
5.1 Logging On to the Application Server

You need to check that you can log on to the application server using the following standard users:

Java Standalone Users

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>User Name Storage: External ABAP System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Administrator</td>
<td>You create this user manually during the installation process.</td>
</tr>
</tbody>
</table>

⚠️ Recommendation

We recommend that you call the user J2EE_Admin_<SAPSID_Java_System>
The maximum length is 12 characters.

Prerequisites

- The SAP system is up and running.

Logging On to the Java Application Server

You access AS Java with a URL using a Web browser from your client machines. To log on to the Java application server, proceed as follows:

1. Start a Web browser and enter the following URL:
   
   `http://hostname_of_Java EE_Engine_Server>:5<Instance_Number>00`

   ⚠️ Note
   
   You must always enter a two-digit number for `<Instance_Number>`. For example, do **not** enter 1 but instead enter 01.

   ⚠️ Example
   
   If you installed the SAP NetWeaver Application Server Java on host saphost06 and the instance number of your SAP NetWeaver Application Server Java is 04, enter the following URL:
   
   `http://saphost06:50400`

   The start page of the SAP NetWeaver Application Server Java appears in the Web browser.

2. Log on by pressing the icon of any of the provided applications, for example the SAP NetWeaver Administrator.
5.2 Installing the SAP License

You must install a permanent SAP license. When you install your SAP system, a temporary license is automatically installed. This temporary license allows you to use the system for only four weeks from the date of installation.

⚠️ Caution

Before the temporary license expires, you must apply for a permanent license key from SAP. We recommend that you apply for a permanent license key as soon as possible after installing your system.

Procedure

For information about the installation procedure for the SAP license, see:


Note

The license key is bound to the hardware key of the host where the message server is running. In a high-availability system with MSCS, the message server is part of the (A)SCS instance that can run on different MSCS node. Therefore you must install the SAP license on both nodes. You have to do failover from the first MSCS node where the (A)SCS instance is installed to the second MSCS node. Use the hardware key of the second MSCS node for the installation of the second SAP license.

More Information

For more information about SAP license keys and how to obtain them, see SAP Service Marketplace at http://service.sap.com/licensekey.

5.3 Configuring the Transport Management System

You have to perform some steps to be able to use the Transport Management System.

Procedure

1. Perform post-installation steps for the transport organizer:
   a) Call transaction SE06.
   b) Select Standard Installation.
c) Choose Perform Post-Installation Actions.

2. Call transaction STMS in your SAP Solution Manager system to configure the domain controller in the Transport Management System (TMS).

   Only valid for: HA (MSCS)

3. In a high-availability system with MSCS, you must configure all systems in the TMS landscape. To do this implement SAP Note 943334.

Result
You can now perform Java transports in the TMS of your SAP Solution Manager system.

More Information
For more information, see the SAP Library at http://help.sap.com <your product> SAP NetWeaver Library SAP NetWeaver Library: Function-Oriented View Application Server ABAP Administration Tools for AS ABAP Change and Transport System

5.4 Configuring the Remote Connection to SAP Support

SAP offers its customers access to support and a number of remote services such as the EarlyWatch Service or the GoingLive Service. Therefore, you have to set up a remote network connection to SAP. For more information, see SAP Service Marketplace at http://service.sap.com/remoteconnection.

5.5 Applying the Latest Kernel and Support Packages

You have to apply the latest kernel and Support Packages for your SAP system from SAP Service Marketplace.

Caution
Before you apply support packages, make sure that you read the release notes for your SAP system. You can find these on SAP Service Marketplace at http://service.sap.com/releasenotes. The release notes might include information about steps you have to perform after you have applied the support packages.

Procedure
5.6 Ensuring User Security

You need to ensure the security of the users that SAPinst creates during the installation. For security reasons, you also need to copy the installation directory to a separate, secure location – such as a DVD – and then delete the installation directory.

Recommendation

In all cases, the user ID and password are only encoded when transported across the network. Therefore, we recommend using encryption at the network layer, either by using the Secure Sockets Layer (SSL) protocol for HTTP connections, or Secure Network Communications (SNC) for the SAP protocols dialog and RFC.

For more information, see the SAP Library at:


Caution

Make sure that you perform this procedure before the newly installed SAP system goes into production.

Prerequisites

If you change user passwords, be aware that SAP system users might exist in multiple SAP system clients (for example, if a user was copied as part of the client copy). Therefore, you need to change the passwords in all the relevant SAP system clients.

Procedure

For the users listed below, take the precautions described in the relevant SAP security guide, which you can find on SAP Service Marketplace at http://service.sap.com/securityguide:
5 Post-Installation
5.6 Ensuring User Security

Operating System and Database Users

<table>
<thead>
<tr>
<th>User</th>
<th>User Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>&lt;sapsid&gt;adm</td>
<td>SAP system administrator</td>
</tr>
<tr>
<td></td>
<td>SAPService&lt;SAPSID&gt;</td>
<td>User to run the SAP system</td>
</tr>
<tr>
<td>Oracle database user</td>
<td>SAP&lt;SCHEMA_ID&gt;</td>
<td>Oracle database owner (that is, the owner of the database tables)</td>
</tr>
<tr>
<td></td>
<td>SYSTEM</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>SYS</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>OUTLN</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>DBSNMP</td>
<td>–</td>
</tr>
</tbody>
</table>

Host Agent User

<table>
<thead>
<tr>
<th>User</th>
<th>User Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>sapadm</td>
<td>SAP system administrator You do not need to change the password of this user after the installation. This user is for administration purposes only.</td>
</tr>
</tbody>
</table>

Note

You can set up Java standalone users with the SAP User Management Engine (UME) in one of the following ways:

- With the users stored in an external ABAP system – see the first table above
- With the users stored in the database – see the second table above

The next two tables show these ways of managing the users.

SAP System Users Stored in an External ABAP System

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: External ABAP System</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>This user’s password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the Config Tool. For more information, see Checking the SAP Java Documentation [page 81].</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Recommendation</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>We recommend that you call the user J2EE_ADM.&lt;SAPSID._Java_System&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The maximum length is 12 characters.</td>
<td></td>
</tr>
<tr>
<td>User</td>
<td>User Name Storage: External ABAP System</td>
<td>Comment</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Guest</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>Lock this user for interactive logon.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Recommendation" /></td>
<td>We recommend that you call the user J2EE_GST_&lt;SAPSID_Java_System&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The maximum length is 12 characters.</td>
</tr>
<tr>
<td>Communication user for Application Server Java</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>Specify this user as a Communications user and not as a dialog user.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Recommendation" /></td>
<td>We recommend that you call the user SAPJSF_&lt;SAPSID_Java_System&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The maximum length is 12 characters.</td>
</tr>
<tr>
<td>Users for Adobe Document Services (ADS)</td>
<td>ADSUSER</td>
<td>User exists at least in the clients 000 and 001 of the external ABAP system.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You must have created this user manually in the external ABAP system before you started the installation. For more information, see Preparing User Management for an External ABAP System [page 43].</td>
</tr>
<tr>
<td>Data supplier user for System Landscape Directory (SLD) (optional)</td>
<td>The name that you gave this user when you created it manually [page 43]. The recommended name is SLDUSER.</td>
<td>User exists at least in the clients 000 and 001 of the external ABAP system.</td>
</tr>
<tr>
<td>ABAP API user for System Landscape Directory (SLD) (optional)</td>
<td>The name that you gave this user when you created it manually [page 43]. The recommended name is SLDAPIUSER.</td>
<td>User exists at least in the clients 000 and 001 of the external ABAP system.</td>
</tr>
</tbody>
</table>
5.7 Post-Installation Steps for the Host Agent

You have to perform the following steps on each host where the host agent is installed. This applies whether the host agent is installed on a host within the SAP system or separately on another host.

Procedure

1. You check whether the installed services are available as follows:
   a) Log on as user sapadm.
   b) Check whether the following services are available:
      - The control program saphostexec
      - The operating system collector saposcol
The SAP NetWeaver Management agent SAPHostControl (sapstartsrv in host mode)

Note
When the host is booted, the services SAPHostControl and SAPHostExec automatically start the installed programs

2. You configure the host agent according to your requirements.

More Information
For more information, see the SAP Library at:


5.8 Checking the SAP Java Documentation

Here you can find information in the SAP Library about the configuration of Application Server Java (AS Java) and about SAP Java technology.

Procedure
1. Go to the following place in the documentation:


2. Check the following documentation for information relevant to running your Java system:

<table>
<thead>
<tr>
<th>Manual</th>
<th>Contents</th>
</tr>
</thead>
</table>
| Architecture Manual | This manual describes the architecture of a Java or ABAP+Java system. It contains information on:  
- Java cluster architecture including central services, load balancing, and high availability.  
- Application Server Java (AS Java) system architecture  
- SAP NetWeaver Java development infrastructure, including SAP NetWeaver Developer Studio |

Note
The SAP NetWeaver Developer Studio is the SAP development infrastructure for Java. The Architecture Manual describes the integration of the SAP NetWeaver Developer Studio into the SAP development infrastructure.
### Manual Contents

**Administration Manual**
This manual describes how to administer the SAP system, focusing on AS Java. It contains information on:
- System landscape administration
- Software life-cycle management

![Note]
This part of the manual contains important information about:
- Installation information
- System Landscape Directory (SLD)
- Software Lifecycle Manager (SLM)
- Java Support Package Manager
- Administration of SAP NetWeaver Java Development Infrastructure (JDI)

- AS Java and AS Java security
- Supportability and performance management
- Administration and configuration of Web Dynpro runtime environment
- Administration of the XML Data Archiving Service (XML DAS)

![Caution]

**Java Development Manual**
This manual describes the technologies for developing Java-based business applications. It explains how to use the SAP Netweaver Developer Studio, which is the SAP Java development environment.

**Migration Manual**
This manual contains all the information you need to migrate an application created in J2EE Engine 6.20.

### More Information
For troubleshooting AS Java, see the [J2EE Engine Problem Analysis Guide](http://service.sap.com/instguidesnw) at:

#### 5.9 CE-Specific Post-Installation Activities

This section describes the steps that you have to perform after the installation has finished successfully.
Running the Configuration Wizard (Optional)

Note
You can run the configuration wizard only once and only directly after installing and patching your SAP system.

After SAPinst has finished, run the configuration wizard to apply automated configuration tasks to your system.

For SAP NetWeaver CE, you need to run the following configuration tasks, depending on the installed components:

- Configuration of Services Registry Webservice Destinations
- Configuration and Mirroring of local NWDS Update Site
- Initial setup ADS in CE

For more information about how to start the configuration wizard, see the configuration documentation in the SAP Solution Manager.

Enabling Adobe Document Services

If you have installed SAP NetWeaver Composition Environment with the Adobe Document Services add-on a Windows platform, you must complete the following post-installation steps to enable the add-on. In case you have installed an AS Java cluster, apply the procedure to the central host, as well as to all hosts where additional application server instances are running.

1. Using the SAP Management Console, stop the AS Java system.

2. From the Start menu, open ▶ Control Panel ▶ Administrative Tools ▶ Computer Management ▶ Services and Applications ▶ Services ▶.

3. Select SAP<SID>_<<Instance_Number>> (for example, SAPCE1_00) and open Properties from the context menu.

4. On the Log On tab page, enable the Local System account indicator.

5. Repeat the above steps for the second SAP<SID>_<<Instance_Number>> service that you see in the list.

6. Start the AS Java system.

Adobe LiveCycle Designer

For more information about how to install and configure the Adobe LiveCycle Designer see SAP Note 962763.

Enabling Services Registry

You must apply additional configuration steps to enable Services Registry after you have installed an SAP NetWeaver Composition Environment system containing the following components:
Java Application Server and Composition Platform
Java Application Server and Adobe Document Services

To enable Services Registry, you must apply the following configuration template to your system:

CE_Complete_Stack_production_full

**Note**

For more information about what configuration templates are available, see Configuration Templates [page 91].

For more information about applying configuration templates, see: [http://help.sap.com/nwce](http://help.sap.com/nwce)
- SAP NetWeaver Composition Environment Library
- Administrator’s Guide
- Configuration of SAP NetWeaver CE
- Initial System Configuration
- AS Java Configuration
- Activating a Configuration Template

See also

- SAP NetWeaver Composition Environment Library
- Developer’s Guide
- Developing and Composing Applications
- Consuming Enterprise Services
- Searching for Services
- Services Registry
- Tasks
- Searching & Browsing Service Definitions
- Configuring the Services Registry

### Configuring the Portal in SAP NetWeaver CE

After installing the portal in SAP NetWeaver CE, a number of deactivated or irrelevant tools are displayed in the UI. To display the correct portals tools for CE, proceed as follows:

1. Open a browser and log on to your portal as an administrator.
2. In the same browser session, enter the following URL:
   
   ```
   content.layers.ContentLayersTool
   ```

   where `<host>` is the host name of your server and `<httpport>` is the port number of your server.
3. In the Portal Mode Configuration Tool, choose *Activate Development Mode* to restore the portal tools and content that are assigned to the development mode.
4. Restart or refresh your browser.
5. In the SAP Management Console, restart the server.

You may then continue with the mandatory and optional configuration steps as described in

- SAP NetWeaver Composition Environment Library
- Administrator’s Guide
- Configuration of SAP NetWeaver Composition Environment
- Configuration for CE Additional Components
- Configuring the Portal

### Changing the Password for the Internet Communication Manager (ICM)

You can monitor and manage the Internet Communication Manager (ICM) from the command line program.

After the installation of your SAP NetWeaver CE system has successfully finished, you need to change the ICM password manually. To do so, proceed as follows:
1. Log on at operating system level to the computer where the ICM is running.
2. Start the program `icmon` with `icmon -a profile=<instance_profile>` to maintain the authentication file (default: `authfile.txt`).
3. Choose `a` to add a user.
4. Choose `c` to change the password of the existing user.
5. Choose `s` to save your settings.

Further Configuration Steps

After installing your SAP NetWeaver CE system and performing the post-installation steps to get the system up & running, you may need to perform further configuration steps. Refer to the following documentation to proceed with your tasks:

- If you are a system administrator, refer to `http://help.sap.com/nwce` > Administrator's Guide. It contains information about how to configure and administer your system.
- If you are a developer, refer to `http://help.sap.com/nwce` > Developer's Guide. It provides guidelines for developing applications using the SAP NetWeaver CE.

Note

The SAP NetWeaver CE documentation is also available offline as a part of your installation. To access it, choose `Start` > `All Programs` > `SAP NetWeaver` > `Composition Environment 1.0` > `Documentation`.

5.10 Performing Oracle-Specific Post-Installation Steps

You have to perform the following Oracle-specific post-installation steps:

Security Setup for the Oracle Listener

If the Oracle security setup defined by the standard installation is not restrictive enough for your purposes, see SAP Note 186119 to configure the Oracle listener to accept only connections from specific hosts.

Checking the Recommended Oracle Database Parameters

When installing the Oracle database, a standard database parameter set is used. To take into account the size and configuration of your SAP system, and to enable new Oracle features, check and apply the parameter settings as described in SAP Note 830576.
5.11 Performing a Full System Backup

You must perform a full system backup after the configuration of your SAP system. If required, you can also perform a full system backup after the installation (recommended). In addition, we recommend you to regularly back up your database.

Prerequisites

- You are logged on as user <sapsid>adm.
- You have shut down the SAP system and database.

Procedure

Back up your system including the operating system disk, system state, and all other disks.

Note

- You must configure your third-party backup tool, if used, for the database backup.
- If you use BR*TTOOLS for the database backup, refer to the following Oracle documentation in the SAP Library at: http://help.sap.com <your product> SAP NetWeaver Library Administrator’s Guide Technical Operations for SAP NetWeaver (TOM) Administration of Databases Database Administration for Oracle:
  - SAP Database Guide: Oracle (BC-DB-ORA-DBA)
  - CCMS: Oracle
6 Updating SAP NetWeaver Composition Environment

If you want to apply the latest support packages and patches to your SAP NetWeaver CE system or update your applications, use the update management service of SAP NetWeaver CE.

Before You Start the Update

Before you start the update, apply SAP Note 1088002. You need to perform this once on each system.

Updating Your SAP NetWeaver CE System Manually

If you have a system that was installed with SP0 or SP1, proceed as follows:

   Search for SERVERCORE01_0-10004571.SCA SP01 for J2EE ENGINE SERVERCORE 7.05.
   Before deploying the SCA using telnet, change the permissions using the following command:
   ```
   chmod 777 SERVERCORE01_0-10004571.SCA
   ```
   For more information, see SAP Note 1073329.
2. Manually deploy the three XI third-party SDAs using telnet.
   For more information, see SAP Note 1088386.
3. Exchange the engine template.

Note

Before changing the current template, note down the name of the currently active template. You will need it at the end of the update procedure to reactivate the original template again.

a) Navigate to the configtool subdirectory of your installation directory, for example
   ```
   C:\usr\sap\CE1\J01\j2ee\configtool
   ```
   b) Run the file configtool.bat.
   c) Highlight the template and choose File > Change System Template.
   d) Switch from the current template to the instance_development template.
   e) Save your settings and restart the server.

   To do this, open SAP Management Console, select the node and choose the restart option.
Caution

If you are running a cluster system, you need to check that all instances are running the correct template before proceeding to update the main instance.


5. Stop the SAP Management Console.

6. From the download folder from SAP Service Marketplace, run the update tool `update<ID>.exe` to apply patches and updates to your SAP NetWeaver CE system.

   After running the update tool wait until the engine is fully started.

7. To complete the update process, change back the system template to the original one.

Caution

If you are running a cluster system, make sure that you change back to the original template on all dialog instances.

8. Restart the system.

Update Management Service

Update Management Service is intended to help automate the process of downloading and installing the latest Support Package Stack from SAP Service Marketplace. The Update Management tool will connect to SAP Service Marketplace and look for the latest support package stack available for your system. For example, if your system is on SP3 and the latest support package available is SP5, the Update Management Service will download and apply SP5 to your system. If, however, you want to go to an intermediate support package stack, you have to download the stack manually.

Procedure


2. Follow the on-screen instructions and enter the required logon information.

3. The Update Management tool checks the system for installed components and support package stack level.

4. The Update Management tool checks for updates and new support package stacks on SAP Service Marketplace and applies them automatically.

When the update has successfully completed, SAPinst shows the dialog The system is up-to-date.
7 Additional Information

The following section provides additional information about the installation of SAP NetWeaver Composition Environment.

7.1 Transporting Self-Developed Software Component Archives (SCA) into the System

Prerequisites
You have developed your own Software Component Archives (SCA) and want to transport them into your SAP NetWeaver CE system.

Procedure
To transport your SCAs to the SAP NetWeaver CE system, proceed as follows:
1. Run the update tool as described in Updating the SAP NetWeaver CE system [page 87].

Note
If the tool displays descriptions such as Applying Support Packages, you can ignore them.

2. In the dialog screens, specify the directory where your SCAs are located.
3. Follow the on-screen instructions.

7.2 Troubleshooting – Repairing an Inconsistent MaxDB Installation

Prerequisites
During the preinstallation phase, the installation tools checks the Microsoft Windows registry for already installed MaxDB software.
If the registry key is found but there is no software on the hard drive, you receive the following message:
The existing MaxDB software is not consistent. Check the file system and registry.
The most common reason for this inconsistency is the manual deletion of the software from the file system without using the specified tools.
7.3 Restarting the MaxDB Server Manually

If, after a reboot, the database server is not running automatically, you need to restart the MaxDB server manually.

Production Systems
To restart the MaxDB server manually, proceed as follows:

1. Open a command prompt and enter the following command: `net start sapdbwww`
   * OR
   Choose `Start > All Programs > Administrative Tools > Services`. Double-click on SAP DB WWW and choose `Start`.
2. Open the SAP Management Console and choose `SAP Systems > <SAPSID> <machine name>`.
3. Enter the master password and choose `Logon`.
4. Choose `Online`. When the database server is online, you can restart the engine.

Development Systems
To restart the MaxDB server manually, choose `Start > All Programs > SAP NetWeaver Composition Environment CE > Application Server <SAPSID> Start Application Server`. 
7.4 Restarting the MS SQL Server Manually

If, after a reboot, the database server is not running automatically, you need to restart the MS SQL Server manually.

Procedure
1. Choose Start ➤ All Programs ➤ Administrative Tools ➤ Services.
2. Look for the service named SQL Server <name>, where <name> is MSSQLSERVER for the default instance or <instance name> for a named instance.
3. If the service status is not started, right-click the service and choose Start in the context menu.
4. To insure the service is started automatically after each system restart, right-click it and choose Properties. Select Automatic as the startup type.

7.5 Configuration Templates

Configuration templates contain the predefined instance configuration for specific scenarios. They are automatically applied according to the installation option you have selected. The templates are designed to optimize system performance by applying certain configuration to the Java Virtual Machine and the application server, as well as by applying startup filters to AS Java services and applications to start only those relevant for the selected installation options. The following table provides information about the available templates with SAP NetWeaver Composition Environment. In the template name, replace the <system_mode> parameter by development (for the templates relevant to systems installed in development mode) or production (for the templates relevant to systems installed in productive mode).

<table>
<thead>
<tr>
<th>Configuration Template</th>
<th>Selected Installation Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE_Java_EE_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation</td>
</tr>
<tr>
<td>CE_Composition_Environment_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Composition Platform Installation</td>
</tr>
<tr>
<td>CE_Adobe_Document_Service_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Adobe Document Services Add-on Installation</td>
</tr>
<tr>
<td>CE_Composite_Voice_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Voice Add-on Installation</td>
</tr>
<tr>
<td>CE_Complete_Stack_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Composition Platform Installation + Adobe Document Services Add-on Installation</td>
</tr>
</tbody>
</table>
If your selection cannot be mapped to one of the combinations in the above table, the template CE_Complete_Stack_<system_mode>_full is applied. It starts all applications and services needed to run the complete stack.

You can manually apply a different configuration template if you want to switch to another installation option. For example, by changing from template CE_Complete_Stack_<system_mode>_full to CE_Java_EE_<system_mode>_full, you achieve shorter startup times and less memory consumption, but also less functionality since not all applications and services are running.

For more information about applying configuration templates, see | http://help.sap.com/nwce | Administrator’s Guide | Configuration of SAP NetWeaver CE | Initial System Configuration | AS Java Configuration | Activating a Configuration Template |.

**Note**

Make sure that you do not apply a development template to a productive system or vice versa.

### 7.6 SAP Directories

This section describes the SAP directories that SAPinst creates during the installation.

[Only valid for: HA (MCS)]

If you want to install an MCS system, see also: Directories in an MCS Configuration [page 125].

[End of: HA (MCS)]

SAPinst creates the following base directories required for the SAP system:

- **\usr\sap**

  This directory is created on the:

  - **Global** host and **shared** with the network share sapmnt

    The global host is the host where the SCS and primary application server instance is installed.

    On global hosts, the \usr\sap directory contains general SAP software, global and local (instance-specific) data.

    For this, the following directories are created in \usr\sap\<SAPSID>\SYS:

    - global (contains globally shared data)
    - profile (contains the profiles for all instances)
    - exe (contains executable replication directory for all instances and platforms)

    All instances of an SAP system access this directory on the global host using the Universal Naming Convention (UNC) path.

  - **Local** host and **shared** with the network share saploc.

    On local hosts, the \usr\sap directory contains copies of the SAP software and local (instance-specific) data.

    The executables on the local host are replicated from those on the global host each time the local instance is started.
In MSCS this directory is located on a local disk. You have at least two disk drives with a \usr\sap\ directory structure.

Note
Since SAP traces for the instance are created in a subdirectory of \usr\sap, make sure there is sufficient space available in this directory.

\usr\sap\trans
The transport directory contains SAP software for the transport of objects between SAP systems. SAPinst by default creates it on the SAPGLOBALHOST.

If you want to have it created on another host, or if you want to use an already existing transport host of your SAP system landscape, you can specify another host during the installation. In this case, you have to prepare that host to allow the new SAP system to use it as transport host. For more information, see Preparing the SAP System Transport Host [page 51].

Directory Structure
The global host has the SAP\<SAPSID>\SYS directory structure. The global data is stored in the global directories on the global host and physically exists only once for each SAP system. Other application servers access the global data using the UNC path \\SAPGLOBALHOST\sapmnt. The SAP programs access their instance-specific data with the UNC path \\SAPLOCALHOST\saploc. If the UNC path points to a local directory, the local path (and not the UNC path) is used to access the directory.

In a distributed system, the parameters SAPGLOBALHOST and SAPLOCALHOST have the same values on the global host.

Every time an instance starts, the SAP copy program sapcpe compares the binaries in the <platform>-directory on the global host and the binaries in the exe-directory on the application server. If the binaries in the exe directory differ from those in the <platform>-directory, sapcpe replaces them with the newer version of the global host.

The following figures show how the physical directory \usr\sap is shared on the global host in a standard and in a distributed system. In both cases, the UNC paths are used as follows:

- \\SAPGLOBALHOST\sapmnt to access global directories
- \\SAPLOCALHOST\saploc to access local instance-specific data
**Figure 7:** Directory Structure on the Global Host in a Standard (Central) Java System

![Diagram of Directory Structure on the Global Host in a Standard (Central) Java System](image)

Key:
- `Replication by sapcpo`
- `uc = Unicode`

**Figure 8:** Directory Structure for a Distributed Java System

![Diagram of Directory Structure for a Distributed Java System](image)

Key:
- `Replication by sapcpo`
- `uc: Unicode`

On global host:
- `SAPGLOBALHOST = SAPLOCALHOST`
7.7 Additional Information About SAPinst

The following sections provide additional information about SAPinst [page 61]:

- Interrupted Installation with SAPinst [page 95]
- Performing a Remote Installation with SAPinst (Optional) [page 97]
- Starting SAPinst GUI Separately (Optional) [page 98]
- Entries in the Services File Created by SAPinst [page 100]
- How to Avoid Automatic Logoff by SAPinst [page 100]
- Troubleshooting with SAPinst [page 101]

7.7.1 Interrupted Installation with SAPinst

The SAP system installation might be interrupted for one of the following reasons:

- An error occurred during the dialog or processing phase:
SAPinst does not abort the installation in error situations. If an error occurs, the installation pauses and a dialog box appears. The dialog box contains a short description about the choices listed in the table below as well as a path to a log file that contains detailed information about the error.

You interrupted the installation by choosing Exit in the SAPinst menu.

The following table describes the options in the dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retry</td>
<td>SAPinst retries the installation from the point of failure without repeating any of the previous steps. This is possible because SAPinst records the installation progress in the keydb.xml file. We recommend that you view the entries in the log files, try to solve the problem and then choose Retry. If the same or a different error occurs again, SAPinst displays the same dialog box again.</td>
</tr>
<tr>
<td>Stop</td>
<td>SAPinst stops the installation, closing the dialog box, the SAPinst GUI, and the GUI server. SAPinst records the installation progress in the keydb.xml file. Therefore, you can continue the installation from the point of failure without repeating any of the previous steps. See the procedure below.</td>
</tr>
<tr>
<td>Continue</td>
<td>SAPinst continues the installation from the current point.</td>
</tr>
</tbody>
</table>

**Procedure**

This procedure describes the steps to restart an installation, which you stopped by choosing Stop, or to continue an interrupted installation after an error situation.

1. Log on to your remote host as a user who is a member of the local administrators group.
2. Mount your Installation Master DVD.
3. Restart SAPinst by double-clicking sapinst.exe You can also start SAPinst by entering the following commands at the Windows command prompt:
   
   ```
   cd <DVD drive>:\IM_WINDOWS<platform>
   ```

4. From the tree structure in the Welcome screen, select the installation option that you want to continue and choose Next.

   ![Note]

   If there is only one component to install, the Welcome screen does not appear.

5. In the What do you want to do? screen, decide between the following alternatives and confirm with OK.
### 7.7.2 Performing a Remote Installation with SAPinst (Optional)

You use this procedure to install your SAP system on a remote host. In this case, SAPinst and the GUI server run on the remote host, and SAPinst GUI runs on the local host. The local host is the host from which you control the installation with SAPinst GUI.

#### Prerequisites

- The remote host meets the prerequisites before starting SAPinst as described in Running SAPinst [page 61].
- Both computers are in the same network and can “ping” each other.
  
  To test this:
  - Log on to your remote host and enter the command `ping <local host>`.
  - Log on to the local host and enter the command `ping <remote host>`.

#### Procedure

1. Log on to your remote host as a user who is a member of the local administrators group.
2. Insert the Installation Master DVD in the DVD drive on your remote host.
3. Enter the following commands:
   ```
   cd <DVD drive>:\DATA_UNITS\IM_WINDOWS_<platform>
   sapinst.exe -nogui
   ```
   For more information, see Running SAPinst [page 61].
   SAPinst now starts and waits for the connection to the SAPinst GUI. You see the following at the command prompt:
   ```
   guiengine: no GUI connected; waiting for a connection on host <host_name>, port <port_number> to continue with the installation
   ```
4. Start SAPinst GUI on your local host, as described in Starting SAPinst GUI Separately [page 98].
7.7.3 Starting SAPinst GUI Separately (Optional)

You use this procedure to start SAPinst GUI separately. You might need to start SAPinst GUI separately in the following cases:

- You have logged off from SAPinst.
  - If you logged off during the installation and you later want to reconnect to the installation while it is still running, you can start SAPinst GUI separately.
- You want to perform a remote installation [page 97].
  - If SAPinst GUI runs on a different host from SAPinst and the GUI server, you have to start SAPinst GUI separately.

Starting SAPinst GUI on a Windows Platform

1. Log on as a member of the local administrators group.
2. Insert the SAP Installation Master DVD into your DVD drive.
3. Change to the directory of the sapinst executables:
   `<DVD drive>:\DATA_UNITS\IM_WINDOWS_<platform>_<DB>`

   Note
   If you want to start SAPinst GUI on a Windows 32-bit platform, change to the following directory:
   `<Installation_Master_DVD>\DATA_UNITS\SAPINSTGUI_710_WINDOWS_I386`

4. Start SAPinst GUI by double-clicking `sapinstgui.exe`
   SAPinst GUI starts and tries to connect to the GUI server and SAPinst, using the local host as default.
   If SAPinst and the GUI server are running on another host, SAPinst GUI cannot connect and the SAP Installation GUI Connection dialog appears.
   In this case, enter the name of the host on which SAPinst is running and choose Log on.
   The first dialog of the installation appears and you can perform the remote installation from your local host.

   Note
   Optionally you can start `sapinstgui.exe` with the following parameters:
   - `host=<host name>`, where `<host name>` is the host name of the installation host
   - `port=<nr>`, where `<nr>` is the port number for the connection to the GUI server
   - `-accessible` enables the Accessibility mode
   Example:
   `./sapinstgui.exe host=lsi1209 port=3000 -accessible`
Starting SAPinst GUI on a UNIX Platform

1. Log on as user root.

   **Caution**
   Make sure that the root user has not set any environment variables for a different SAP system or database.

2. Mount your Installation Master DVD.

   **Note**
   Mount the DVD locally. We do **not** recommend that you use Network File System (NFS).

3. Change to the directory of the sapinst executables:
   
   `<Installation_Master_DVD>/DATA_UNITS/IM_<OS>_<DB>`

   **Note**
   If you want to start SAPinst GUI on a Linux 32-bit platform, change to the following directory:
   
   `<Installation_Master_DVD>/DATA_UNITS/SAPINSTGUI_710_LINUX_I386`

4. Start SAPinst GUI by executing `./sapinstgui`
   
   SAPinst GUI starts and tries to connect to the GUI server and SAPinst, using the local host as default.

   If SAPinst and the GUI server are running on another host, SAPinst GUI cannot connect and the `SAP Installation GUI Connection` dialog appears.

   In this case, enter the name of the host on which SAPinst is running and choose **Log on**.

   The first dialog of the installation appears and you can perform the remote installation from your local host.

   **Note**
   Optionally you can start `sapinstgui` with the following parameters:
   
   - `host=<host name>`, where `<host name>` is the host name of the installation host
   - `port=<nr>`, where `<nr>` is the port number for the connection to the GUI server
   - `- accessible` enables accessibility mode

   Example:
   
   `./sapinstgui host=lsi1209 port=3000 -accessible`
7.7.4 Entries in the Services File Created by SAPinst

After the installation has finished successfully, SAPinst has created the following entries for port names in <drive>:\WINDOWS\system32\drivers\etc\services:

- sapdpXX = 32XX/tcp
- sapdbXXs = 47XX/tcp
- sapgwXX = 33XX/tcp
- sapgwXXs = 48XX/tcp

where XX is set from 00 to 99.

Note

If there is more than one entry for the same port number, this is not an error.

7.7.5 How to Avoid Automatic Logoff by SAPinst

When you install the SAP system with SAPinst, the SAPinst installation tool checks whether the user account used for the installation has the required privileges and authorization. For a domain installation, the account needs to be both a member of the local Administrators and the domain Admins group. For a local installation, the account needs to be a member of the local Administrators group.

In both cases, the user account must be authorized to:

- Act as part of the operating system
- Adjust memory quotas for a process
- Replace a process-level token

If the user account does not have these rights assigned, SAPinst automatically logs the account off to assign them. To avoid SAPinst logging the account off, you can set these rights manually before you start the installation.

Procedure

You perform the following steps to assign these rights to the user account used for the installation.

Caution

Be aware that domain policies override locally defined policies. This means that if you want to grant domain administrator rights for a user who belongs to the local Administrators group, make sure that you have also defined domain administrator rights for this user on domain level.

2. In the Local Security Settings window, choose Local Policies > User Rights Assignment.
3. Double-click the required right under Policy and choose Add User or Group.
4. In the Select Users and Groups window, choose the required user and choose Add. The selected user appears in the box below.
5. Confirm your entry and then repeat the steps for each remaining policy that the user requires for the installation.
6. Log off and log on again to apply the changes.

**More Information**
*Required User Authorization for the Installation [page 47]*

### 7.7.6 Troubleshooting with SAPinst

This section tells you how to proceed when errors occur during the installation with SAPinst.

If an error occurs, SAPinst:
- Stops the installation
- Displays a dialog informing you about the error

**Procedure**

1. To view the log file, choose View Logs.
2. If an error occurs during the dialog or processing phase, do one of the following:
   - Try to solve the problem.
   - Abort the installation with Exit.
     - For more information, see *Interrupted Installation with SAPinst [page 95]*.
   - Continue the installation by choosing Retry.
3. Check the log and trace files of the GUI server and SAPinst GUI in the directory `%userprofile%\sapinst\logs` for errors.
4. If GUI server or SAPinst GUI do not start, check the file `sdtstart.err` in the current `%userprofile%` directory.
5. If SAPinst GUI aborts during the installation without an error message, restart SAPinst GUI as described in *Starting SAPinst GUI Separately*.

### 7.8 Starting and Stopping the SAP System

You use this procedure to check that you can start and stop the SAP system after the installation with the SAP Microsoft Management Console (SAP MMC).

With a newly installed MMC you can start or stop installed SAP instances locally on the host that you are logged on to. If the MMC is configured for central system administration, you can start or stop the entire system from a single host.
**Note**

For more information, see:

- [http://help.sap.com](http://help.sap.com) &gt; [your product] &gt; SAP NetWeaver Library &gt; Function-Oriented View &gt; Application Server ABAP &gt; Administration Tools for AS ABAP &gt; Monitoring in the CCMS &gt; Microsoft Management Console: Windows

**Prerequisites**

- You have logged on to the SAP system host as user `<sapsid>adm`.
- You have checked the settings for VM parameters as described in SAP Note 723909.

**Procedure**

1. Start the SAP MMC on the SAP system host by choosing [Start] &gt; All Programs &gt; SAP Management Console 4.
2. Right-click the SAP system node and choose Start or Stop.
   
   All instances listed under the system node, will start or stop in the correct order.
3. If the SAP system is installed on multiple hosts (distributed system), you have the following options to start or stop your system:
   
   You have the following options to start or stop your system:
   - You start or stop the SAP instances using the MMC on each host.
   - You add the remote instances to the MMC configuration to start or stop all instances from a single MMC.
   
   To do so, you configure the MMC manually. For more information, see *Changing the Configuration of the MMC* in the SAP MMC documentation.

**Note**

You can also start and stop a UNIX system with the MMC.

**Note**

You can also start and stop an SAP instance on UNIX with the MMC.

**7.9 SAP System Security on Windows**

In a standard SAP system installation, SAPinst automatically performs all steps relevant for security. Although SAPinst makes sure that the system is protected against unauthorized access, you must still check that no security breaches can occur.

For central and straightforward administration of the SAP system, you have to install distributed SAP systems with multiple application servers in a Windows **domain**. This section describes the user
accounts and groups that SAPinst creates during a domain installation and shows how these are related to the SAP directories.

**User Accounts**

SAPinst creates the following accounts for SAP system administration:

- `<sapsid>adm`
  - This is the SAP system administrator account that enables interactive administration of the system.

- `SAPService<SAPSID>`
  - This is the user account that is required to start the SAP system. It has the local user right to log on as a service.
  - The advantage of the additional `SAPService<SAPSID>` account is that it does not allow an interactive logon, which prevents abuse of the account. Therefore, you do not need to set an expiration date for the password and you do not have to set the option `user must change password at next logon`.

- `sapadm`
  - This is the user for the SAP host agent. It is a member of the local Administrators group.
  - The host agent contains all of the required elements for centrally monitoring any host with the Alert Monitor or the SAP NetWeaver Administrator.

**Groups**

SAPinst creates the following groups during a domain installation:

- `SAP_<SAPSID>_GlobalAdmin`
  - This global group is a domain-level SAP administration group for organizing SAP system administrators. The only function of a global group is to group users at the domain level so that they can be placed in the appropriate local groups.

- `SAP_<SAPSID>_LocalAdmin`
  - Only local groups are created and maintained on an application server. A local group can only be given permissions and rights to the system where it is located. The system is part of a particular domain, and the local group can contain users and global groups from this domain.

- `SAP_LocalAdmin`
  - This group is created on all hosts, but is particularly important for the transport host. Members of the group have full control over the transport directory (`\usr\sap\trans`) that allows transports to take place between systems.
  - The `SAP_<SAPSID>_GlobalAdmin` groups of all the SAP systems that are part of the transport infrastructure are added to the `SAP_LocalAdmin` group. As a consequence, the users `<sapid>adm` and `SAPService<SAPSID>` of all systems in the transport infrastructure are members of the `SAP_LocalAdmin` group and have the required authorizations necessary to initiate and execute transports.
SAP Directories

SAPinst protects the SAP directories under `\usr\sap\<SAPSID>` by only granting the group `SAP_<SAPSID>_LocalAdmin` full control over these directories. The following graphic illustrates the user accounts and groups created by SAPinst in a system infrastructure consisting of two SAP systems.

**Figure 10:** User Groups and Accounts

![User Groups and Accounts Diagram]

- **Note**
  An access control list (ACL) controls access to SAP system objects. For maximum security in the SAP system, only the following are members of all SAP system object ACLs:
  - Local group `SAP_<SAPSID>_LocalAdmin`
  - Group `Administrators`
  - Account `SYSTEM`

### 7.10 Automatic Creation of Accounts and Groups

SAPinst automatically creates the accounts and groups required for the secure operation of the SAP system with Windows [page 102] during the installation.
# Features

The following figures show the steps that SAPinst performs to create the users and groups and assign the required rights to SAP directories.

**Figure 11:** Creating Users and Groups

<table>
<thead>
<tr>
<th>Creation of Accounts</th>
<th>Creation of SAP user accounts</th>
<th>SAP Host Agent Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Administrator</td>
<td>SAP Service Account</td>
<td>sapadm</td>
</tr>
<tr>
<td>&lt;sapid&gt;adm</td>
<td>SAPService&lt;sapid&gt;</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Creation and Modification of Global Group in the Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation of global group SAP_&lt;SAPSID&gt;GlobalAdmin</td>
</tr>
<tr>
<td>Addition of &lt;sapid&gt;adm and SAPService&lt;sapid&gt; to group SAP_&lt;SAPSID&gt;_GlobalAdmin</td>
</tr>
<tr>
<td>Addition of &lt;sapid&gt;adm to the local Administrators group</td>
</tr>
<tr>
<td>Addition of &lt;sapid&gt;adm to the Windows domain user groups</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Creation and Modification of Local Group on Each Application Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation of the local group SAP_&lt;SAPSID&gt;_LocalAdmin on the application server</td>
</tr>
<tr>
<td>Addition of the global SAP_&lt;SAPSID&gt;<em>GlobalAdmin to the local group SAP</em>&lt;SAPSID&gt;_LocalAdmin</td>
</tr>
<tr>
<td>Creation of the local group SAP_LocalAdmin on the application server</td>
</tr>
<tr>
<td>Addition of the global group SAP_&lt;SAPSID&gt;_GlobalAdmin to the local group SAP_LocalAdmin on the application server</td>
</tr>
<tr>
<td>Addition of the SAP_&lt;SAPSID&gt;_GlobalAdmin group to the local group SAP_LocalAdmin on the transport host</td>
</tr>
</tbody>
</table>
You have to uninstall all components of the SAP NetWeaver Composition Environment separately. You can uninstall your SAP NetWeaver CE system in different ways.

**Uninstalling SAP NetWeaver CE**
Choose Start Control Panel Add / Remove programs SAP System <SAPSID>.

**Uninstalling SAP NetWeaver CE Using SAPinst**
1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Start SAPinst from the SAP Installation Master DVD as described in the section Installing SAP NetWeaver Composition Environment.
3. In the Welcome screen, choose Uninstall SAP System or Single Instances from the tree structure.
4. Follow the on-screen instructions.

**Uninstalling the SAP Management Console**
Since all SAP systems use the SAP Management Console, there is no uninstallation option for the SAP Management Console with SAPinst. If you are sure that you do not need the SAP Management Console any more, you can remove it using Start Control Panel Add / Remove programs.
7.12 Deleting an SAP System

This section describes how to delete a single instance, a standalone engine or a complete SAP system with the Uninstall option of SAPinst.

Caution

- You cannot delete an SAP system remotely.
- If you delete network-wide users, groups or service entries in an environment with Network Information System (NIS), other SAP installations might also be affected. Make sure that the users, groups, and service entries to be deleted are no longer required.

Prerequisites

- This description assumes that you have installed your SAP system with standard SAP tools according to the installation documentation.
- You are logged on with a user account that has the required authorization to run the SAPinst tool and the SAP system. For more information, see Required User Authorization for the Installation [page 47].

Procedure

1. Start SAPinst and on the Welcome screen, choose:
   - |<SAP System>| | Software Life-Cycle Options | | Uninstall | | Uninstall — SAP systems or single instances |
2. Follow the instructions in the SAPinst input dialogs.

   Note
   For more information about the input parameters, place the cursor on the relevant field and press \[F1\] in SAPinst.

   SAPinst first asks you which SAP instances you want to delete. Make sure that you delete the SAP instances in the order as described hereinafter.
   - If you want to delete a standard system (all instances reside on the same host), you can do this in one SAPinst run.

   Note
   SAPinst deletes the database instance but you have to delete the Oracle database software [page 108] separately.

   - If you want to delete a distributed system, you have to run SAPinst to delete the required instances locally on each of the hosts belonging to the SAP system in the following sequence:
     a) Additional application server instance(s), if there are any
b) Database instance

⚠️ **Caution**
SAPinst only stops local instances automatically. Before you delete the database instance of a distributed system make sure that you stop all remaining instances. You must stop the instance with the message server only after having entered all SAPinst parameters for the deletion of the database instance.

⚠️ **Note**
With this SAPinst option you do **not** delete the database software.

Use the following options to delete the database instance and schema:

<table>
<thead>
<tr>
<th>Options</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop database</td>
<td>Select this option if you want to delete the database instance, including all database schemas, all tablespaces and their corresponding data files. The database software will not be deleted.</td>
</tr>
<tr>
<td>Select schemas and tablespaces to drop only</td>
<td>Do not select this option.</td>
</tr>
<tr>
<td>Keep database and its content</td>
<td>Select this option if you only want to delete the previously selected SAP instance(s). With this option, you do <strong>not</strong> delete the database instance, database content or the database software.</td>
</tr>
</tbody>
</table>

c) Primary application server instance

⚠️ **Note**
If SAPinst stops responding while trying to delete the primary application server instance, close SAPinst with **Cancel** and **Exit**. Log off and log on again. To complete the uninstall process of the primary application server instance, restart SAPinst.

d) Central services instance

3. *Delete the Oracle database software* [page 108].
4. If required, you can delete the directory `/usr/sap/trans` and its contents manually.
   SAPinst does not delete `/usr/sap/trans` because it might be shared.

### 7.13 Deleting the Oracle Database Software

You use the Oracle Universal Installer to delete the Oracle database software.
Prerequisites
Before you delete the database software, make sure that you delete the groups `ORA_<DBSID>_DBA` and `ORA_<DBSID>_OPER` as follows:

1. Choose `Start` ➤ `All Programs` ➤ `Administrative Tools` ➤ `Computer Management`. 
2. Choose `Local Users and Groups` ➤ `Groups`. 
3. Select and delete the local groups `ORA_<DBSID>_DBA` and `ORA_<DBSID>_OPER` with `Action` ➤ `Delete`.

Procedure

> Note
The Oracle software is installed on all hosts where an SAP instance is running, for example, on a central instance host, database host, or dialog instance host. Do not delete the Oracle database software, if another SAP instance is running on the same host.

Only valid for: HA (MSCS)

> Caution
- Deinstall the Oracle Fail Safe (OFS) software with Oracle Universal Installer before deleting the Oracle database software on both nodes.
- Delete the Oracle database software on both nodes.

End of: HA (MSCS)

1. Stop all Oracle Services and the Microsoft Distributed Transaction Coordinator.
   To access the services choose `Start` ➤ `All Programs` ➤ `Administrative Tools` ➤ `Services`. 
   Select a service and then choose `Action` ➤ `All Tasks` ➤ `Stop`.
2. Delete the Oracle database software with the Oracle Universal Installer as follows:
   a) Start the Oracle Universal Installer with `Start` ➤ `All Programs` ➤ `Oracle-<Oracle_Home_name>` ➤ `Oracle Installation Products` ➤ `Universal Installer`.
   b) Choose `Installed Products` or `Deinstall Products`.
   c) Select the database product (`<Oracle_Home_name>`) you want to uninstall.
   d) Choose `Remove`.
   e) Confirm with `Yes` and choose `EXIT`.
3. Delete the corresponding Oracle home directory and all its subdirectories under `<DRIVE>:\ORACLE_HOME`.
4. Edit the Oracle Registry entries as follows:
   a) Choose `Start` ➤ `Run` and enter `REGEDIT`.
   b) Delete the key for the corresponding Oracle_Home at `HKEY_LOCAL_MACHINE` ➤ `SOFTWARE` ➤ `ORACLE` ➤ `KEY_<Oracle_Home>`.
   c) Delete all Oracle references for the respective Oracle Home at `HKEY_LOCAL_MACHINE` ➤ `SYSTEM` ➤ `CURRENTCONTROLSET` ➤ `SERVICES`. 

11/05/2007  PUBLIC  109/168
5. Delete all Oracle references from the Windows user and system environment:
   a) Choose Start Programs System.
   b) Choose the Advanced tab and then click Environment Variables.
   c) For example, delete the variables:
      
      -\texttt{TNS\_ADMIN, NLS\_LANG, ORACLE\_HOME, ORACLE\_<DBSID>}. 
   d) Also delete \texttt{Oracle} from the \texttt{PATH} variable.

6. Delete the corresponding Oracle entries from the Start menu:
   a) Choose Start Settings Taskbar & Start Menu.
   b) On the Advanced tab, click Advanced.
   c) On the Start Menu screen, look at
      \texttt{All Users\Start Menu\Programs}.
      Select and delete the folders for Oracle with File Delete.
   d) Delete the Oracle shortcut from the desktop.
8 High Availability with Microsoft Cluster Service

You can install a high-availability SAP system with Microsoft Cluster Service (MSCS). For this type of installation, you have to set up the system on at least two clustered hosts (called “MSCS nodes”) and configure it so that it can take advantage of the MSCS software. The MSCS software improves the availability of the system and safeguards it against failure and unplanned downtime, enabling 24-hour operation, 365 days a year.

With high availability you enable critical system components, called Single Points of Failure (SPOFs), to be automatically switched from one machine to the other in the event of hardware or software problems affecting one machine. With the help of this switchover – or failover – the system can continue functioning normally so that unplanned system downtime is avoided.

Apart from enabling failover when hardware problems occur, you can also use MSCS to avoid downtime when you perform essential system maintenance. If you need to maintain one node, you can deliberately switch the cluster resources to another node and temporarily operate it there while maintenance is in progress. When maintenance work is finished you can easily move the resources back to their original node and continue operating them there.

Until now, SAP has only supported the installation of one clustered SAP system in one MSCS cluster with two MSCS nodes. Now you have the following options to install a high-availability system with MSCS to safeguard it against failure and unplanned downtime:

- You install one SAP system in one MSCS cluster.
- You install one SAP system in two MSCS clusters.
- You install several SAP systems in one or more MSCS cluster(s) with two and more MSCS nodes.

For all MSCS configurations the following restrictions apply:

- The (A)SCS instance must be installed and configured to run on two MSCS nodes in one MSCS cluster.
- If your database supports the installation on several MSCS nodes, you can install the database instance on more than two MSCS nodes in one MSCS cluster.
Caution

The following conditions for SAP support apply to:

- One clustered SAP system in one MSCS cluster with two MSCS nodes or one clustered SAP system in two MSCS clusters

  If you have one of these MSCS configurations and you use SAPinst to install such an MSCS system, you get SAP support with the installation, configuration, and operation.

- Multiple SAP systems with one or more MSCS cluster(s) and two or more MSCS nodes

  For such complex MSCS systems you need in-depth knowledge of and experience with the Windows operating system, the Microsoft Cluster Service, the sizing and clustering of an SAP system. Therefore, the sizing, installation and configuration of such an MSCS system must be performed by an SAP Global Technology Partner, who supports any installation and configuration problems that arise from this MSCS configuration. Only then does SAP support the operation of this MSCS system.

Note

- Make sure that you read SAP Note 965569, which contains the most recent information as well as corrections for MSCS. For more information, see the SAP installation notes [page 9] before you begin the installation.

- In this documentation the hosts in an MSCS cluster are referred to as first MSCS node and additional MSCS node(s).

  The first MSCS node is the MSCS node where you perform the general installation of an SAP system, for example where the database or (A)SCS instance is to be installed.

  The additional MSCS node is the node where you configure the already installed SAP instances to run in MSCS.

To install a new SAP system with MSCS, you combine general installation steps, described earlier in this documentation, with cluster-specific steps described here:

- Since the cluster hardware has at least two nodes that have access to all local and shared storage devices, you have to install some components on all MSCS nodes and observe special rules for distributing components to local or shared disks.

- Since the correct configuration of network addresses is absolutely essential to enable the cluster to function properly, you have to perform a number of additional steps that are necessary to set up and check addressing.
Note
If you have an existing SAP system and plan to migrate to a cluster with new hardware, you install the SAP system using a **system copy**.
For more information about the system copy, see the *System Copy Guide* for your SAP system on SAP Service Marketplace at [http://service.sap.com/instguides](http://service.sap.com/instguides) » Release » Installation ». The documentation for system copy does **not** include the cluster-specific information, which is described here.

### 8.1 Planning

You have to complete the following planning activities for your SAP system using Microsoft Cluster Service (MSCS):

1. You check the *general planning activities* [page 13] listed in Chapter 2 of this guide.
2. You decide how to **set up your SAP system components in an MSCS configuration** [page 113].
3. You decide how to **distribute components to disks for MSCS** [page 121].
4. You read *Directories in an MSCS Configuration* [page 125].
5. You read *IP Addresses in an MSCS Configuration* [page 126].
6. You obtain *IP addresses for MSCS* [page 130].

### 8.1.1 System Configuration in MSCS

The following chapters provide information about the configuration of your SAP system configuration in MSCS. It describes the components you have to install for one or more SAP system running in one cluster, and how to distribute them on the specific host. For more information, see:

- SAP System Components in an MSCS Configuration [page 113]
- Multiple SAP Systems in one MSCS Cluster [page 116]
- Multiple SAP Systems Inside Multiple MSCS Cluster [page 119]
- Enqueue Replication Server in MSCS [page 120]

### 8.1.1.1 SAP System Components in an MSCS Configuration

In an MSCS configuration you have the following mandatory components for your SAP system:
SAP System Components in an MSCS Configuration

<table>
<thead>
<tr>
<th>Component</th>
<th>Number of Components per SAP System</th>
<th>Single Point of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCS instance (message services and enqueue services)</td>
<td>1</td>
<td>yes</td>
</tr>
<tr>
<td>Database instance</td>
<td>1</td>
<td>yes</td>
</tr>
<tr>
<td>Application server instance (primary application server, additional application server)</td>
<td>1-n</td>
<td>no</td>
</tr>
</tbody>
</table>

To protect the SPOFs ((A)SCS instance and database instance) you have to use MSCS.
If a hardware or software problem occurs on the first MSCS node, the clustered (A)SCS instance and the clustered database automatically fail over to another node.
If you need to maintain the MSCS node where the (A)SCS instance and database are running you can switch these instances to another node. When maintenance work is finished you move the (A)SCS and database instance back to the original node.

To protect system components that are non-SPOFs, for example application servers, you have to install them as multiple components. In this case you must install at least two application servers (the primary application server instance and one additional application server instance) on two different hosts. You have the following options:

- You install the primary application server and the additional application server instance on the MSCS nodes of an MSCS cluster. You install them on a local disk. Any additional application server instances are installed on hosts outside of the MSCS cluster.
  If you have to maintain an MSCS node, you have to stop the primary application server or the additional application server instance on that node. When you have finished maintenance, you restart the instance(s).
- You install the primary application server and all additional application server instances on hosts, which are not part of an MS cluster.

The following figures show examples for the installation of SPOFs and non-SPOFs of an SAP system in an MSCS cluster with two nodes.
The first figure shows an MSCS configuration where the non-SPOFs components (primary application server instance, additional application server instance) are installed locally on the MSCS nodes. Any additional application server instance(s) are installed outside the MSCS cluster on separate hosts.
The following figure shows an MSCS configuration, where the non-SPOFs components (primary application server instance, additional application server instance) are installed on separate hosts that are not part of the MS cluster.
SAP System Components in Two MSCS Clusters

Besides installing your SAP system in one MSCS cluster, you can also set up two MSCS clusters and distribute the SPOF system components on these clusters to protect them against system failure. The following figure shows an example where the database instance for the SAP system is installed in one MSCS cluster, and the (A)SCS instance is installed on the second MSCS cluster. The application servers (primary application server instance, additional application server instance) can either be installed on a local disk on the MSCS nodes or on separate hosts that are not part of the MS cluster.

Figure 15: Java System

8.1.1.2 Multiple SAP Systems In One MSCS Cluster

Caution
For such a complex MSCS system you need in-depth knowledge of and experience with the Windows operating system, the Microsoft Cluster Service, the sizing and clustering of an SAP system. Therefore, the installation and configuration of such an MSCS system must be performed by an SAP Global Technology Partner, who supports any installation and configuration problems that arise from this MSCS configuration. Only then does SAP support the operation of multiple SAP systems in one MSCS cluster.

Until now, SAP has only supported the installation of one clustered SAP system in one MSCS cluster with two MSCS nodes. This was due to the fact that the cluster share sapmnt resource could only be assigned to one cluster group and could only point to one shared drive. However, additional
clustered SAP systems require additional cluster groups, shared disks, and a unique IP and network name, as well as an sapmnt share. Adding an additional sapmnt share is not possible as it already exists and points to the shared disk of the first clustered SAP system. The solution is to rename the cluster share sapmnt resource into sapmnt<SAPSID>.

On the local disk, which must have the same disk letter on all MSCS nodes, you create the usr\sap<SID> folders on all nodes and set the saploc and sapmnt shares on usr\sap. Then you create junctions on the local disk pointing to the relevant SYS and <Instance><Number> folders on the shared disk(s) on all nodes.

**Caution**

All additional local instances like an enqueue replication server, first or additional application server instance are installed on the local disk where the saploc share is pointing to. Make sure that you have enough space on this local disk.

With this configuration, every SAP system is placed in a separate MSCS cluster group with the unique name SAP <SAPSID> having its own shared disk, IP address, network name, sapmnt<SID> share as well as the Windows generic service and the SAP resource. SAP cluster groups belonging to different SAP systems are running separately and independent from each other. If you have such an MSCS configuration with three and more MSCS nodes, the following restrictions:

- The (A)SCS instance must be installed and configured to run on two MSCS nodes in one MSCS cluster.
- If the database supports the installation on several MSCS nodes, the database instance can be installed on more than two MSCS nodes in one MSCS cluster.

The following figure shows the installation of multiple SAP systems in one MSCS cluster. For each SAP system you have to install one primary and at least one additional application server.
The following table shows what additional SAP systems you can install in one MSCS cluster if you already have a clustered SAP system.

Multiple SAP Systems in One MSCS Cluster

<table>
<thead>
<tr>
<th>First Clustered System</th>
<th>Additional SAP System(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.1 based ABAP system (kernel 7.10)</td>
<td>SAP NetWeaver 7.1 based ABAP system(s) (kernel 7.10)</td>
</tr>
<tr>
<td>SAP NetWeaver 7.0 SR &lt;x&gt; and higher based ABAP system (kernel 7.00)</td>
<td>SAP NetWeaver 7.0 SR &lt;x&gt; and higher based ABAP system (kernel 7.00)</td>
</tr>
<tr>
<td>SAP NetWeaver 7.0 SR &lt;x&gt; and higher based Java system (kernel 7.00)</td>
<td>SAP NetWeaver 7.0 SR &lt;x&gt; and higher based Java system (kernel 7.00)</td>
</tr>
<tr>
<td>SAP NetWeaver 7.0 SR &lt;x&gt; and higher based ABAP+Java system (kernel 7.00)</td>
<td>SAP NetWeaver 7.0 SR &lt;x&gt; and higher based ABAP+Java system (kernel 7.00)</td>
</tr>
<tr>
<td>SAP NetWeaver '04 SR1 based ABAP system (kernel 6.40, ABAP Patch Level 90)</td>
<td>SAP NetWeaver 7.1 based ABAP system (kernel 7.10)</td>
</tr>
<tr>
<td>SAP NetWeaver '04 SR1 based Java system (kernel 6.40, SP 18)</td>
<td>SAP NetWeaver 7.0 SR &lt;x&gt; and higher based ABAP system (kernel 7.00)</td>
</tr>
<tr>
<td>SAP NetWeaver '04 SR1 based ABAP+Java system (kernel 6.40, SP 18)</td>
<td>SAP NetWeaver 7.0 SR &lt;x&gt; and higher based Java system (kernel 7.00)</td>
</tr>
<tr>
<td></td>
<td>SAP NetWeaver 7.0 SR &lt;x&gt; and higher based ABAP+Java system (kernel 7.00)</td>
</tr>
</tbody>
</table>
8.1.1.3 Multiple SAP Systems In Multiple MSCS Clusters

Besides installing multiple SAP systems in one MSCS cluster, it is also possible to install multiple SAP systems in several MSCS clusters with two or more MSCS nodes.

Note
The MSCS software supports up to eight MSCS nodes.

Caution
For such a complex MSCS system you need in-depth knowledge of and experience with the Windows operating system, the Microsoft Cluster Service, the sizing and clustering of an SAP system. Therefore, the installation and configuration of such an MSCS system must be performed by an SAP Global Technology Partner, who supports any installation and configuration problems that arise from this MSCS configuration. Only then does SAP support the operation of multiple SAP systems in multiple MSCS clusters.

For this MSCS configuration the following restrictions apply:
- The (A)SCS instance must be installed and configured to run on two MSCS nodes in one MSCS cluster.
- If the database supports the installation on several MSCS nodes, the database instance can be installed on more than two MSCS nodes in one MSCS cluster.

The following figure shows the installation of multiple SAP systems in two MSCS clusters with three nodes, called Node A, B and C. In this example, the SCS and ASCS instances are installed in the first MSCS cluster, and the database instances for the two SAP systems are installed on the second MSCS cluster. The primary and additional application servers can be either installed on a local disk on the MSCS nodes or outside the MSCS cluster on separate hosts.

Note
If you use an enqueue replication server, you must install the enqueue replication server, and the
(A)SCS instance on two nodes.

Figure 17: Multiple SAP Systems in Two MSCS Clusters

8.1.1.4 Enqueue Replication Server in an MSCS Configuration

The enqueue replication server contains a replica of the lock table (replication table) and is an essential component in a high-availability setup. It is required for a Java system, but also strongly recommended for an ABAP system.

You have to install the enqueue replication server on the two MSCS nodes where the (A)SCS instance is installed and configured to run, even if you have more than two MSCS nodes.

In normal operation the replication enqueue server is always active on the host where the (A)SCS instance is not running.

If an enqueue server in an MSCS cluster with two nodes fails on the first MSCS node, the enqueue server on the additional MSCS node is started. It retrieves the data from the replication table on that node and writes it in its lock table. The enqueue replication server on the second MSCS node then becomes inactive. If the first MSCS node is available again, the enqueue replication server on the second MSCS node becomes active again.

The following figure shows the enqueue replication server mechanism in an MSCS configuration with two nodes:
**8.1.2 Distribution of SAP System Components to Disks for MSCS**

One of the central points to keep in mind when planning the MSCS installation is that the cluster hardware has two different sets of disks:

- Local disks that are connected directly to the MSCS node(s)
- Shared disks that can be accessed by all MSCS nodes via a shared interconnect

**Note**

Shared disk is a synonym for the MSCS resource of Resource type Physical disk.

You need to install the SAP system components in both the following ways:

- Separately on all MSCS nodes to use the local storage on each node.
  - You install the Oracle database server software and the Oracle Fail Safe software on local disks.
- On the shared storage that is used in common by all MSCS nodes.
  - You install the following on different shared disks:
    - Database data files
    - SAP system executables
    - Single quorum device, if used
With Windows Server 2003, you can now choose between the following cluster models:

- **Single Quorum Device Cluster**
  In this cluster model the quorum resource maintains the cluster configuration data on a single cluster storage device.
  The quorum resource is unique to a cluster installation and is always owned by one of the nodes.
  It has the following main functions in the cluster:
  - It logs changes to the cluster configuration that are entered in the Registry.
  - It arbitrates between competing nodes when the communication between nodes breaks down.
  This means that cluster resources are forced to fail over to the node that owns the quorum resource.

- **Majority Node Set Cluster**
  In this new cluster model, each node maintains its own copy of the cluster configuration data.
  The Majority Node Set resource, acting as the Quorum Resource, ensures that the cluster configuration data is kept consistent across the different nodes.
  You can use majority node set for geographically dispersed cluster configuration.
  SAP supports Majority Node Set Cluster if it is part of a cluster solution offered by your Original Equipment Manufacturer (OEM), or Independent Hardware Vendor (IHV).

The following figures show a cluster configuration for one and for multiple SAP systems, where the (A)SCS and DB instance are installed in the same cluster. It illustrates how to distribute the database data files, the SAP system executables, and the quorum resource (if used) to different disks. Only with this distribution of files to distinct disks is it possible to move the SAP system and database as separate entities in a failover situation.
Figure 19: Distribution of SAP System Components For One SAP System in MSCS

Figure 20: Distribution of SAP System Components For Multiple SAP Systems in MSCS
The Oracle server software in the ORACLE HOME directory must have the same drive letter and path on all MSCS nodes.

**Distribution of Database Files in a RAID Configuration**

**Caution**

Microsoft does not support a Windows operating system-based RAID configuration (Dynamic Disks).

The following figures show a secure method to distribute the database files to different RAID volumes. You must always locate the database data and redo logs on separate RAID volumes.

**Figure 21:** Distribution of Database Files to Different RAID Volumes for Test or Development Systems
For high-performance production systems, we recommend that you locate the database files on at least four RAID volumes.

Note that the BR*Tools directories \sapreorg, \saptrace, \sapbackup, and \sapcheck are not shown in the figures. You can locate these directories on any of the database volumes as they do not require special security measures.

**More Information**
*Directories in an MSCS Configuration* [page 125]

### 8.1.3 Directories in an MSCS Configuration

The following tables show the directories where the main software components for the SAP cluster installation are stored:

**Directories on Local Disks on MSCS Nodes**

<table>
<thead>
<tr>
<th>Component</th>
<th>Default Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>A supported operating system [page 38]</td>
<td>%windir%</td>
</tr>
<tr>
<td>MSCS software</td>
<td>%windir%\Cluster</td>
</tr>
<tr>
<td>SAP cluster files</td>
<td>%windir%\SAPCluster</td>
</tr>
<tr>
<td>Junctions for multiple SAP systems in one MSCS</td>
<td>&lt;local_drive&gt;:\usr\sap&lt;SAPSID&gt;&lt;n&gt;[Junction]</td>
</tr>
<tr>
<td>Application server (if installed locally)</td>
<td>&lt;local_drive&gt;:\usr\sap&lt;SAPSID&gt;&lt;&lt;Instance&gt;</td>
</tr>
</tbody>
</table>
### Component Planning

<table>
<thead>
<tr>
<th>Component</th>
<th>Default Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle server software</td>
<td>&lt;local_drive&gt;:\oracle&lt;SAPSID&gt;\102</td>
</tr>
<tr>
<td>Oracle Fail Safe software</td>
<td>&lt;local_drive&gt;:\oracle\OFS</td>
</tr>
</tbody>
</table>

### Directories on Shared Disks

<table>
<thead>
<tr>
<th>Component</th>
<th>Default Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster quorum resource (if used)</td>
<td>&lt;drive&gt;:\MSCS</td>
</tr>
<tr>
<td>SAP global and instance directories</td>
<td>&lt;drive&gt;:\usr\sap ...</td>
</tr>
<tr>
<td>SAP data files</td>
<td>&lt;drive&gt;:\ORACLE&lt;SAPSID&gt;&lt;SAPSID&gt;DATA1 ... &lt;SAPSID&gt;DATA&lt;n&gt;</td>
</tr>
<tr>
<td>Online redo logs, set A</td>
<td>&lt;drive&gt;:\ORACLE&lt;SAPSID&gt;\origlogA</td>
</tr>
<tr>
<td>Online redo logs, set B</td>
<td>&lt;drive&gt;:\ORACLE&lt;SAPSID&gt;\origlogB</td>
</tr>
<tr>
<td>Mirrored online redo logs, set A</td>
<td>&lt;drive&gt;:\ORACLE&lt;SAPSID&gt;\mirrlogA</td>
</tr>
<tr>
<td>Mirrored online redo logs, set B</td>
<td>&lt;drive&gt;:\ORACLE&lt;SAPSID&gt;\mirrlogB</td>
</tr>
<tr>
<td>Archive of online redo logs</td>
<td>&lt;drive&gt;:\ORACLE&lt;SAPSID&gt;\oraarch</td>
</tr>
<tr>
<td>BR*Tools directories</td>
<td>...\saprereg, \saptrace, ...\sapbackup, \sapcheck, ...\saparch</td>
</tr>
</tbody>
</table>

**Note**

In a live system with intense I/O activity, you must reserve at least 3 times the minimum amount of space specified above for the redo logs and mirrored redo logs.

**SapCluster Directory**

In an SAP cluster installation, an additional directory – %WINDIR%\SapCluster – is created under the system directory.

This contains all the SAP files required by all MSCS cluster nodes, independently of the MSCS node the SAP instance is running on. The files are database tools and program files (executables) used by the operating system monitor (SAPOsCol).

The directory is added to the path variable of the user <sapsid>adm.

### 8.1.4 IP Addresses in an MSCS Configuration

A part of the installation process that is unique to MSCS is the configuration of host names and IP addresses in the network. This is a particularly important task because the addressing plays a key role...
role in the switchover procedure. Addressing must be set up correctly so that the system can take advantage of the cluster functionality and switch between nodes when hardware problems arise. This section explains the different types of IP addresses and their function in the switchover mechanism of one MSCS cluster with two MSCS nodes.

**Types of IP Addresses**
In a correctly configured cluster with at least two nodes, there are at least seven IP addresses and corresponding host names for your SAP system.
You have two IP addresses for each MSCS node, one IP address for the cluster, one address for the SAP cluster group and one for the database cluster group.
Some of the addresses are assigned to the *network adapters* (cards), others are virtual IP addresses that are assigned to the *cluster groups*.

**Physical IP Addresses Assigned to Network Adapters**
An MSCS configuration usually has two networks:
- A public network that is used for the communication between the primary application server, additional application servers and the LAN.
- A private network that is used internally for communication between the nodes of the cluster.

**Note**
For more information on network configuration, see also the Microsoft Knowledge Base Article 259267.

The following figure shows an MSCS cluster with two nodes and illustrates the adapters required for the public and private networks, and their corresponding physical IP addresses. A physical IP address, as opposed to a virtual one, is stationary and permanently mapped to the same adapter.
Figure 23: Adapters and IP Addresses Required for Public and Private Networks in an MSCS Cluster with Two Nodes

Host Names Assigned to Network Adapters
Each of the physical IP addresses of the network adapters must have a corresponding host name. For example, on the left-hand node in the figure above, you might assign the IP addresses of the public and private network adapters as follows:

<table>
<thead>
<tr>
<th>Network Adapter</th>
<th>IP Address</th>
<th>Host Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter 1 (private network)</td>
<td>10.1.1.1</td>
<td>clusA_priv</td>
</tr>
<tr>
<td>Adapter 3 (public network)</td>
<td>129.20.5.1</td>
<td>clusA</td>
</tr>
</tbody>
</table>

⚠️ Caution
- The IP address and host name of the public network adapter is also the IP address and name of the machine. In our example, this means that the machine that is the MSCS node on the left in the figure has the name clus1.
- Do not confuse the **host name** with the **computer name**. Each node also has a computer name, which is often the same as the host name.
- The computer name is displayed in the node column of the *Cluster Administrator*. However, it is not required for the TCP/IP communication in the cluster. When you configure IP addresses and corresponding names, keep in mind that it is the **host names** that are important for the
cluster, not the computer names.

**Virtual IP Addresses Assigned to Cluster Groups**

When you have installed the SAP system and fully configured the cluster, the critical system resources are bound together in three different groups. Each of these groups requires a virtual IP address and host name that is permanently mapped to the group and not to a particular node. This has the advantage that, whenever a group is moved between nodes, its IP address and host name move together with it.

⚠️ Caution

If you have more SAP systems in the same MSCS cluster, you need for each system an extra IP address and network name for the SAP and database cluster group.

An MSCS configuration has the following groups:

- SAP cluster group for each clustered SAP system
- Database cluster group for each clustered SAP system
- Cluster group

Each group consists of a set of related resources that work together to offer a service to the system. For example, the database cluster group comprises all the resources that enable the database server to fulfill the requests of a client. When the group is moved from one node to the other, due to node failure, the virtual IP address and host name move with it. Therefore, there is a failover not only of resources, but also of the virtual IP address and host name. As a result, all clients can still reach the database server with the same IP address as before.

The following figure illustrates how the virtual IP addresses of the database group and SAP group can move from one node to the other when failover occurs.
8.1.5 Obtaining IP Addresses for MSCS

You need to correctly configure IP addresses for a cluster system. During the installation procedure you have to assign at least seven IP addresses and host names. You normally obtain these names and addresses from the system administrator.

Prerequisites

- If you are installing Windows for the first time on your system, follow the procedure Obtaining IP Addresses below.
- If Windows has already been installed on your system, the host names and IP addresses of the network adapters (cards) have already been defined and exist in your system. This means that you can find out the IP addresses for the network adapters using the procedure Determining Existing IP Addresses below.
  However, you still need to use the table Virtual IP Addresses in the procedure Obtaining IP Addresses.

Obtaining IP Addresses

Ask the system administrator to give you the addresses and host names listed in the tables below, which shows an example for a configuration with one MSCS cluster with two nodes. You will need to enter the addresses and host names later during the installation process.

The column Defined During indicates at which stage of the installation the addresses are defined in the system.
Caution

Use the names exactly as specified by the system administrator, carefully observing uppercase and lowercase letters.

**Physical IP Addresses**

<table>
<thead>
<tr>
<th>Component</th>
<th>Example for Physical IP Address</th>
<th>Example for Physical Host Name</th>
<th>Purpose</th>
<th>Defined During</th>
</tr>
</thead>
<tbody>
<tr>
<td>First MSCS Node: adapter for private network</td>
<td>10.1.1.1</td>
<td>clusA_priv</td>
<td>Address for inter-node communication on the private network</td>
<td>Windows installation</td>
</tr>
<tr>
<td>First MSCS Node: adapter for public network</td>
<td>129.20.5.1</td>
<td>clusA</td>
<td>Address of the first MSCS node for communication with application servers and LAN (this is the same as the address of the first MSCS node)</td>
<td>Windows installation</td>
</tr>
<tr>
<td>Additional MSCS Node: adapter for private network</td>
<td>10.1.1.2</td>
<td>clusB_priv</td>
<td>Address for inter-node communication on the private network</td>
<td>Windows installation</td>
</tr>
<tr>
<td>Additional MSCS Node: adapter for public network</td>
<td>129.20.5.2</td>
<td>clusB</td>
<td>Address of the additional MSCS node for communication with application servers and LAN (this is the same as the address of the additional MSCS node)</td>
<td>Windows installation</td>
</tr>
</tbody>
</table>

**Virtual IP Addresses**

<table>
<thead>
<tr>
<th>Component</th>
<th>Example for Virtual IP Address</th>
<th>Example for Host Name</th>
<th>Purpose</th>
<th>Defined During</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster group</td>
<td>129.20.5.3</td>
<td>clusgrp</td>
<td>Virtual address and name of the cluster group. It identifies the cluster and is used</td>
<td>MSCS software installation</td>
</tr>
</tbody>
</table>
### Determining Existing IP Addresses

To find out the existing IP addresses and corresponding host names and addresses, proceed as follows:

1. Choose **Start** ➤ **Settings** ➤ **Network and dial-up Connections**. The **Network and dial-up Connections** window appears.
2. Select one of the network cards that are displayed and choose **File** ➤ **Properties**. A dialog box opens.
3. Choose **TCP/IP Protocol** ➤ **Properties**. The **TCP/IP Properties** dialog box appears and shows the IP address of the initially selected network card.
4. To find out the host name that is mapped to the IP address, use the `ping` command:
   ```bash
   ping -a <IP_Address>
   ```
   The system returns the host name assigned to the IP address.
   Do not forget to `ping` your local machine as well.
5. Repeat these steps for the other network cards.

For more information about IP addresses in the cluster environment, see *IP Addresses in an MSCS Configuration* [page 126].

### 8.2 Preparation

For the installation of a high-availability system with Microsoft Cluster Service (MSCS), you have to perform the same general preparations as for a distributed system [page 25]. In addition, you have to perform the following MSCS-specific preparation tasks:
1. On all MSCS nodes, you manually assign drive letters to the shared disks [page 133] using the Windows Disk Administrator. All MSCS nodes must access the shared disks with the same drive letters.

2. You map the IP addresses to host names [page 133] on the Domain Name System (DNS) Server or in the hosts file.

3. You check the mapping of host names for MSCS [page 134].

4. If you have already one clustered SAP system, and you want to you use multiple systems in this MSCS cluster, you must adapt the existing SAP system for the installation of multiple systems in one MSCS cluster [page 135].

5. You prepare your system for the installation of multiple SAP systems in one cluster [page 138].

6. Having finished all MSCS-specific preparations, continue with the installation tasks for MSCS [page 141].

**Note**

To make sure that all preparation steps have been correctly performed, check that you can move the disk resources from one MSCS node to another so that they are only accessible from a single node at any time.

### 8.2.1 Assigning Drive Letters for MSCS

We recommend that you assign drive letters for MSCS. In an MSCS cluster, the shared disks that can be accessed by all nodes via a common bus must be addressed by all nodes with the same drive letters.

**Procedure**

2. Select a disk and choose Action All tasks Change drive.
3. Enter a new drive letter.

### 8.2.2 Mapping Host Names to IP Addresses for MSCS

To enable correct operation of the failover mechanism, you have to map all IP addresses in the MSCS cluster to host names.

The mapping enables the system to translate host names into IP addresses. Host names are normally used for administrative tasks because they are easier to use than the long, numeric IP addresses. However, the system can only respond to host names if they are translated into IP addresses.

**Prerequisites**

- You have installed the Windows operating system.
You have the *list of IP addresses* [page 130].
You have correctly entered all seven IP addresses required for the MSCS configuration.

⚠️ **Caution**
Missing or incorrect entries for the IP addresses can cause problems later during the installation.

**Procedure**
To map the host names to the IP addresses, do one of the following:

- Map the host names to IP addresses on a Domain Name System (DNS) server.
- Map the IP addresses in the Windows `hosts` file.
  The file is located in the default Windows directory:
  `%SystemRoot%\Drive\system32\drivers\etc`

💡 **Recommendation**
We recommend that you perform the mapping on the DNS server because this only requires a single entry.
If you perform the mapping in the `hosts` file, you have to maintain the `hosts` file on all MSCS nodes of the cluster, and on all application servers and front ends, as each host in the system has its own `hosts` file.

### 8.2.3 Checking the Mapping of Host Names for MSCS

You need to check the mapping of host names to IP addresses as otherwise you might have serious problems later.

**Prerequisites**
You have *mapped the host names to the IP addresses* [page 133] on the DNS Server or in the `hosts` file.

**Procedure**
1. For each IP address enter the following commands:
   a) `ping -a <IP_Address>`
      The system returns the host name that is assigned to the IP address.
   b) `ping hostname`
      The system returns the IP address that is assigned to the host name.
Note
- When you enter the ping command, you do not get a reply if the host does not yet exist.
- If the address you are checking already exists in the system, you also receive a reply from the host. For example, after the installation of Windows and the configuration of the network, you get a reply when entering the IP addresses of the network adapters.

2. Compare the output with your own record of addresses and host names, and check for the following possible errors:
- Incorrect output of uppercase and lowercase
  Make sure that you correct the error before you proceed with the installation.
- Error in the network bindings
  If you enter the name of the public network adapter, which is usually also the name of the local host, and the system returns the IP address of the private network, there is an error in the network bindings.
  To correct the network bindings, do the following on all MSCS nodes:
  a) Choose \Start\ Settings \Network and Dial-up Connections\.
     The Network and Dial-up Connections window appears.
  b) Choose \Advanced \Advanced Settings \Adapters and Bindings\.
     The network cards of the private and public networks are displayed for the current MSCS node.

Note
The card of the public network must be displayed before that of the private network. If necessary, change the order in which the cards are listed by using the Move Up and Move Down arrows.

8.2.4 Preparing an Existing SAP System to Support Multiple Systems in one MS Cluster

If you have already installed an SAP system in a Microsoft cluster, and you want to install an additional SAP system in the same cluster, you have to prepare the existing clustered system to use junctions.
The following sections describe the procedure for the preparation of the:
- (A)SCS instance
- ABAP primary application server instance

Note
As of SAP NetWeaver 7.1, the central instance is called primary application server.
8.2 Preparation

Prerequisites
To create the junctions, you need the tool \linkd.exe from Microsoft. The executable is part of the Microsoft Windows Server 2003 Resource Kit Tools, which you can download from [http://www.microsoft.com](http://www.microsoft.com). Search for Microsoft Windows Server 2003 Resource Kit Tools.

Note
You can also use the 32-bit executable for 64-bit machines.

Preparing the (A)SCS Instance
The following procedure applies for the:

- SCS instance based on one of the following SAP NetWeaver Java systems:
  - SAP NetWeaver 7.1 Java
  - SAP NetWeaver 7.0 SR<\x> Java
  - SAP NetWeaver '04 SR1 Java
- ASCS instance based on one of the following SAP NetWeaver ABAP systems:
  - SAP NetWeaver 7.1 ABAP
  - SAP NetWeaver 7.0 SR<\x> ABAP
- ASCS and SCS instance based on one of the following SAP NetWeaver ABAP+Java systems:
  - SAP NetWeaver 7.1 ABAP+Java
  - SAP NetWeaver 7.0 SR<\x> ABAP+Java

1. Bring the SAP <SAPSID> SAPMNT cluster resource offline.
2. Double-click on this resource and choose Properties, and then the Parameters tab.
3. Change the Share name from SAPMNT to SAPMNT<SAPSID>.
4. Install the Windows Server 2003 Resource Kit Tools that include the \linkd.exe program.
5. If not available, create the folder(s) \drive:\usr\sap\<SAPSID> on the local disk

Caution
You must create the folder(s) on all MSCS nodes using the same local disk letter.

6. Set the file security as follows:
   a) On the sap folder add the SAP_LocalAdmin local group and grant full permissions.
   b) On the <SAPSID> folder add the SAP_<SAPSID>_LocalAdmin local group and add full permissions.
7. Create the saploc share on the <local_disk>\usr\sap\ folder and grant full access to the SAP_LocalAdmin group and local Administrators group.
8. Create the sapmnt share on the <local_disk>\usr\sap\ folder and grant full access to the SAP_LocalAdmin group and local Administrators group.
9. Create the junctions with \linkd.exe as shown in the table below using the following formula, in which source refers to the local disk and target refers to the shared disk:
   \linkd <source> <target>
Junctions for Existing 7.00 and 7.10 Systems

<table>
<thead>
<tr>
<th>SAP System</th>
<th>&lt;Source&gt;</th>
<th>&lt;Target&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>All SAP systems</td>
<td>&lt;local_disk&gt;:\usr\sap&lt;SAPSID&gt;\SYS</td>
<td>&lt;shared_disk&gt;:\usr\sap&lt;SAPSID&gt;\SYS</td>
</tr>
<tr>
<td>Java system</td>
<td>&lt;local_disk&gt;:\usr\sap&lt;SAPSID&gt;\SCS&lt;Instance_Number&gt;</td>
<td>&lt;shared_disk&gt;:\usr\sap&lt;SAPSID&gt;\SCS&lt;Instance_Number&gt;</td>
</tr>
<tr>
<td>ABAP system</td>
<td>&lt;local_disk&gt;:\usr\sap&lt;SAPSID&gt;\ASCS&lt;Instance_Number&gt;</td>
<td>&lt;shared_disk&gt;:\usr\sap&lt;SAPSID&gt;\ASCS&lt;Instance_Number&gt;</td>
</tr>
<tr>
<td>ABAP+Java system, (or 7.00 only: Java Add-In system)</td>
<td>&lt;local_disk&gt;:\usr\sap&lt;SAPSID&gt;\SCS&lt;Instance_Number&gt;</td>
<td>&lt;shared_disk&gt;:\usr\sap&lt;SAPSID&gt;\SCS&lt;Instance_Number&gt;</td>
</tr>
</tbody>
</table>

10. Move the cluster group SAP <SAPSID> to another node.
11. Repeat steps 4 to 9.
12. Bring the cluster group online.

Preparing the ABAP Primary Application Server Instance (Central Instance)
The following procedure applies for the:

- Primary application server instance of a former SAP NetWeaver '04 SR1 ABAP system that was upgraded to an SAP NetWeaver 7.1, or SAP NetWeaver 7.0 SR<x> system
- Primary application server instance and SCS instance of a former SAP NetWeaver '04 SR1 based ABAP+Java system that was upgraded to an SAP NetWeaver 7.1, or SAP NetWeaver 7.0 SR<x> system.

**Note**
As of SAP NetWeaver 7.1, the central instance is called primary application server.

1. Bring the SAPMNT cluster resource offline.
2. Double-click on this resource and choose Properties, and then the Parameters tab.
3. Change the Share name from SAPMNT to SAPMNT<SAPSID>.
4. Bring the SAPLOC cluster resource offline.
5. Double-click on this resource and choose Properties, and then the Parameters tab.
6. Change the Share name from SAPLOC to SAPLOC<SAPSID>.
8. If not available, create the folder(s) <drive>\usr\sap\<SAPSID> on the local disk

**Caution**
You must create the folder(s) on all MSCS nodes using the same local disk letter.
9. Set the file security as follows:
   a) On the sap folder add the SAP_LocalAdmin group and grant full permissions.
   b) On the <SAPSID> folder add the SAP_<SID>_LocalAdmin group and grant full permissions.
10. Create the sapoc share on <local_disk>:\usr\sap\ folder and set full access to the SAP_LocalAdmin group and local Administrators group.
11. Create the sapmnt share on the <local_disk>:\usr\sap\ folder and grant full access to the SAP_LocalAdmin group and local Administrators group.
12. Create the junctions with lnkd.exe as shown in the table below using the following formula, in which source refers to the local disk and target refers to the shared disk:
   
   \lnkd <source> <target>

<table>
<thead>
<tr>
<th>SAP System</th>
<th>&lt;Source&gt;</th>
<th>&lt;Target&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>All SAP systems</td>
<td>&lt;local_disk&gt;:\usr\sap&lt;SAPSID&gt;\SYS</td>
<td>&lt;shared_disk&gt;:\usr\sap&lt;SAPSID&gt;\SYS</td>
</tr>
<tr>
<td>ABAP system</td>
<td>&lt;local_disk&gt;:\usr\sap&lt;SAPSID&gt;\DVEBMGS&lt;Instance_Number&gt;</td>
<td>&lt;shared_disk&gt;:\usr\sap&lt;SAPSID&gt;\DVEBMGS&lt;Instance_Number&gt;</td>
</tr>
<tr>
<td>ABAP+Java</td>
<td>&lt;local_disk&gt;:\usr\sap&lt;SAPSID&gt;\SCS&lt;Instance_Number&gt;</td>
<td>&lt;shared_disk&gt;:\usr\sap&lt;SAPSID&gt;\SCS&lt;Instance_Number&gt;</td>
</tr>
<tr>
<td>(or 7.00 only: Java Add-In system)</td>
<td>&lt;local_disk&gt;:\usr\sap&lt;SAPSID&gt;\Instance_Number&gt;</td>
<td>&lt;shared_disk&gt;:\usr\sap&lt;SAPSID&gt;\Instance_Number&gt;</td>
</tr>
</tbody>
</table>

13. Move the cluster group SAP-R/3 <SAPSID> to another node.
14. Repeat steps 7 to 12.
15. Bring the cluster group online.

### 8.2.5 Preparing the Installation of Multiple SAP Systems in MSCS

SAP supports the installation of multiple SAP systems in a Microsoft cluster configuration. For each system you install in a Microsoft cluster you require a separate shared disk. In addition you need the tool lnkd.exe from Microsoft to create junctions. The executable is part of the Microsoft Windows Server 2003 Resource Kit Tools, which you can download from [http://www.microsoft.com](http://www.microsoft.com). Search for Microsoft Windows Server 2003 Resource Kit Tools.

**Note**

You can also use the 32-bit executable for 64-bit machines.
The following figure shows the directories to create on the local and shared disks as well as the junctions on two MSCS nodes. In this example there are three SAP systems (ABAP, Java, ABAP+Java) installed in the same MSCS cluster.

**Figure 25:** Directories and Junctions for Multiple SAP Systems in MSCS

**Procedure**

The following steps are only required if you want to install at least two SAP systems in one MSCS cluster.

1. If it does not exist, create the domain group: <Domain>\SAP_<SAPSID>_GlobalAdmin.
2. If it does not exist, create the local groups:
   - SAP_LocalAdmin
   - SAP_<SAPSID>_LocalAdmin
3. Move the shared disk to the MSCS node where you are logged on.
4. Create the following directories on the shared disk, using the following naming conventions:
   - <shared_disk>:\usr\sap\<SAPSID>\SYS
   - <shared_disk>:\usr\sap\<SAPSID>\<instance_name><instance_number>
High Availability with Microsoft Cluster Service

8.2 Preparation

Example

**ABAP system:**
G:\usr\sap\C11
G:\usr\sap\C11\ASCS01

**Java system:**
H:\usr\sap\E12
H:\usr\sap\E12\SCS02

**ABAP+Java**
I:\usr\sap\F13
I:\usr\sap\F13\SCS03
I:\usr\sap\F13\ASCS04

5. Set the *File* security on the *shared* disk in the folder *sap* to *Full control* for *SAP_<SAPSID>_LocalAdmin* and `<Domain>\SAP_<SAPSID>_GlobalAdmin`.

6. Set the *File* security on the *shared* disk in the folder *usr* to *Full control* for *SAP_<SAPSID>_LocalAdmin*.

7. Create the following directories on the *local* disk of the MCS node you are logged on for each SAP system you want to install in a Microsoft cluster:

   `<local_disk>:\usr\sap\<SAPSID>`

   Move the groups containing the shared disk to the MCS node you are logged on.

8. Create junctions on the *local* hard disk of this MCS node with *linkd.exe* as shown in the table below using the following command:

   `linkd <source> <target>`.

<table>
<thead>
<tr>
<th>SAP System</th>
<th>&lt;Source&gt;</th>
<th>&lt;Target&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>All SAP systems</td>
<td><code>&lt;local_disk&gt;:\usr\sap\&lt;SAPSID&gt;\SYS</code></td>
<td><code>&lt;shared_disk&gt;:\usr\sap\&lt;SAPSID&gt;\SYS</code></td>
</tr>
<tr>
<td>Java system</td>
<td><code>&lt;local_disk&gt;:\usr\sap\&lt;SAPSID&gt;\SYS\SCS&lt;Instance_Number&gt;</code></td>
<td><code>&lt;shared_disk&gt;:\usr\sap\&lt;SAPSID&gt;\SYS\SCS&lt;Instance_Number&gt;</code></td>
</tr>
<tr>
<td>ABAP system</td>
<td><code>&lt;local_disk&gt;:\usr\sap\&lt;SAPSID&gt;\ASCS&lt;Instance_Number&gt;</code></td>
<td><code>&lt;shared_disk&gt;:\usr\sap\&lt;SAPSID&gt;\ASCS&lt;Instance_Number&gt;</code></td>
</tr>
<tr>
<td>ABAP+Java system</td>
<td><code>&lt;local_disk&gt;:\usr\sap\&lt;SAPSID&gt;\SCS&lt;Instance_Number&gt;</code></td>
<td><code>&lt;shared_disk&gt;:\usr\sap\&lt;SAPSID&gt;\SCS&lt;Instance_Number&gt;</code></td>
</tr>
<tr>
<td></td>
<td><code>&lt;local_disk&gt;:\usr\sap\&lt;SAPSID&gt;\ASCS&lt;Instance_Number&gt;</code></td>
<td><code>&lt;shared_disk&gt;:\usr\sap\&lt;SAPSID&gt;\ASCS&lt;Instance_Number&gt;</code></td>
</tr>
</tbody>
</table>
The following example shows the parameters you have to use for creating the junctions to install the three SAP systems, shown in the figure above.

**Example**

**ABAP system:**

```bash
linkd C:\usr\sap\C11\SYS G:\usr\sap\C11\SYS
linkd C:\usr\sap\C11\ASCS01 G:\usr\sap\C11\ASCS01
```

**Java system:**

```bash
linkd C:\usr\sap\E12\SYS H:\usr\sap\E12\SYS
linkd C:\usr\sap\E12\SCS02 H:\usr\sap\E12\SCS02
```

**ABAP+Java system:**

```bash
linkd C:\usr\sap\F13\SYS I:\usr\sap\F13\SYS
linkd C:\usr\sap\F13\SCS03 I:\usr\sap\F13\SCS03
linkd C:\usr\sap\F13\ASCS04 I:\usr\sap\F13\ASCS04
```

9. If they do not yet exist, create the `saploc` and `sapmnt` share on the `<local_disk>\usr\sap` folder and grant Full Control to the `SAP_LocalAdmin` group and local Administrators group.
10. Repeat steps 3 to 9 on the other MSCS nodes.

**Note**

`sapmnt` and `saploc` point to the local disk of each node.

### 8.3 Installation

The following sections provide information about how to install the SAP system for MSCS.

**Note**

- Make sure that you have **not** installed the Cluster Service and the Oracle Fail Safe service with the `<sapsid>adm` user but with an SAP system independent user.
- Make sure that you are logged on as domain administrator, unless otherwise specified.
  
  If for any reason, you are not granted domain administrators rights, you can perform the installation as a domain user who is a member of the local administrators group. However, the domain administrator has to prepare the system appropriately for you. Do not use the user `<sapsid>adm` unless specified.
- On the first MSCS node, in the **Cluster Administrator**, make sure that all existing cluster groups are online.
- If you are prompted during the installation process, log off and log on again.
- When you **reboot during the installation process** [page 144], resources fail over to the other MSCS node(s). Therefore, pause the other MSCS node(s) before the reboot.
You have to perform the following steps:

1. In the Cluster Administrator, you move all disk groups and the cluster group to the first MSCS node [page 143].
2. On all MSCS nodes of the host where the database instance is to run, you install the Oracle database server software and the current patch set and hot fix [page 59], (if available).

![Note]

The following information only applies if you install multiple SAP systems:
- You must have one ORACLE_HOME per database instance on every cluster node on local disks.
- All ORACLE_HOMES must use the same disks and directories and ORACLE_HOME names on all DB MSCS nodes.

3. If required, you set up multiple Oracle Homes [page 61].

![Note]

This step is not required if you install a system into an existing database (MCOD) [page 21].

4. On all MSCS nodes of the host where the database instance is to run, you install the Oracle Fail Safe Software [page 144].

After the installation you reboot [page 144].

![Caution]

Do not install the Fail Safe Software at the same time on all MSCS nodes. You must install it on one MSCS node at a time.

5. You perform additional steps for the Oracle Fail Safe configuration [page 146] of the host where the database instance is to run.
6. You install the central services instance (SCS) on the first MSCS node [page 148] of the host where the SCS instance is to run.
7. You configure the first MSCS node [page 149].
8. You install the database instance on the first MSCS node [page 150] of the host where the database instance is to run.
9. You install the host agent on the additional MSCS node [page 151] of the host where the host agent is to run.
10. You configure the additional MSCS node [page 152].
11. If required, you install an enqueue replication server [page 153] on the host where the enqueue replication server instance is to run.
12. You install the primary application server instance [page 154] on the host where the primary application server instance host is to run.
13. You create the Oracle Fail Safe group [page 155] on the host where the database instance runs.
14. You set up as shared database directory in your Oracle Home [page 157] on the host where the database instance runs.
15. You add the Oracle database resource to the Fail Safe group [page 158] on the host where the database instance runs.
16. You install at least one additional application server instance [page 159] on the host where the additional application server instance is to run.

8.3.1 Moving MSCS Groups

During the cluster installation you have to move the database, SAP, or disk cluster groups from one MSCS node to the other before you can continue.
You can use the Cluster Administrator or the Fail Safe Manager, both of which are described in this procedure.

Prerequisites

For more information if you need to reboot during the installation, see Rebooting During the Installation or Conversion for MSCS [page 144].

Moving Groups with the Cluster Administrator
You use the Cluster Administrator for groups that do not belong to the Oracle database groups.

1. Start the Cluster Administrator with Start Programs Administrative Tools Cluster Administrator.
2. In the Cluster Administrator, select the group you want to move and drag it to the required MSCS node on the left-hand pane.
3. Repeat the previous step for each group that you want to move.

Moving Groups with the Fail Safe Manager
You use the Fail Safe Manager to move the Oracle resources, for example, the Oracle database group

1. Start the Fail Safe Manager with Start Programs Oracle <Home_Name_fail safe> Oracle Fail Safe Manager.
2. On the left-hand pane, right-click the group you want to move, and choose Move to a Different Node on the context menu.
The group is now moved to another MSCS node.
8.3.2 Rebooting During the Installation or Conversion for MSCS

You only need to perform this procedure if you have to reboot during the installation or conversion for MSCS. A reboot means that resources fail over to another MSCS node. To avoid this, pause the additional MSCS node in the Cluster Administrator.

Procedure

1. Before the reboot, pause the additional MSCS node(s) in the Cluster Administrator.
2. After the reboot, activate the paused MSCS node(s) in the Cluster Administrator.
3. If you forgot to pause the MSCS node(s) before you reboot, perform the following steps:
   a) After the reboot, in the Cluster Administrator, move all resources back to the original node.
   b) Restart the Windows Server service.

8.3.3 Installing the Oracle Fail Safe Software in a 64-Bit System

To enable the database to take advantage of the cluster functionality, you have to install an additional component, the Oracle Fail Safe software. In a 64-bit system you first have to install the 64-bit Fail Safe server software, and then the 32-bit Fail Safe client software.

Note

- The Oracle Fail Safe Service from previous Oracle releases is now called OracleMSCSServices. You might still see the old name in certain SAP Notes.
- Be sure that you always use the new name OracleMSCSServices.
- You have to install the Oracle Fail Safe (OFS) Software on all MSCS nodes.

Caution

For a domain user make sure to use the syntax <domain_name>\<user_name>. The Oracle Fail Safe Software is not able to handle the syntax <user_name>@<domain>.

Prerequisites

- You have installed the Oracle database software locally on all MSCS nodes, using the same Oracle home.
- In the Cluster Administrator make sure that the:
  - Additional MSCS node is not set to Pause.
  - SAP group is offline on the node where you are installing.
Make sure that the *Cluster Server* service is started on all MSCS nodes.

**Procedure**

1. Start the *Oracle Universal Installer* from the Oracle RDBMS DVD to install the Fail Safe server software:
   a) Double-click the file `setup.exe` in the corresponding directory for your 64-bit platform: `<DVD_DRIVE>:\0FS334IA64\install` or `<DVD_DRIVE>:\0FS334AMD64\install`.
   b) Enter the required information as shown in the following table:

<table>
<thead>
<tr>
<th>Screen</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome</td>
<td>Choose Next.</td>
</tr>
<tr>
<td>File Locations</td>
<td><em>Source...</em>&lt;br&gt;For <em>Path</em>&lt;br&gt;The path to the Oracle software on the DVD is displayed. Do not change the path.&lt;br&gt;<em>Destination...</em>&lt;br&gt;For <em>Name</em>&lt;br&gt;Enter the name of the <em>Oracle Home</em> for the <em>Fail Safe</em> software. The Fail Safe software must be installed in a separate <em>Oracle Home</em> directory, for example OFSSRV.&lt;br&gt;Use the same <em>Oracle Home</em> for both nodes.&lt;br&gt;For <em>Path</em>&lt;br&gt;Enter the path of the <em>Oracle Home</em> directory for the <em>Fail Safe</em> software. It must be on a local disk, for example: <code>F:\Oracle\OFFSRV</code>&lt;br&gt;Choose Next.</td>
</tr>
<tr>
<td>Installation Types</td>
<td>Choose Typical.</td>
</tr>
<tr>
<td>Reboot Needed After Installation</td>
<td>Choose Next.</td>
</tr>
<tr>
<td>Summary</td>
<td>View the information and choose <em>Install</em>.</td>
</tr>
<tr>
<td>Install</td>
<td>Wait while the software is installed.</td>
</tr>
<tr>
<td>Configuration Tools</td>
<td>On the dialog box <em>Oracle Fail Safe Account/Password</em> enter the account and password under which the <em>Fail Safe</em> software is to run. This must be the same account as the one under which the <em>Cluster Server</em> service is running.&lt;br&gt;To find out which account must be entered, choose <code>Start</code> &gt; <code>Settings</code> &gt; <code>Control Panel</code> &gt; <code>Administrative Tools</code> &gt; <code>Services</code>. &lt;br&gt;Select the Cluster Service and choose <code>Startup</code>...&lt;br&gt;The log on account for the service is displayed. Enter this account for <em>Oracle Fail Safe Account/Password</em>...</td>
</tr>
<tr>
<td>End of Installation</td>
<td>Choose <em>Exit</em> to close the Oracle Universal Installer.</td>
</tr>
</tbody>
</table>

2. Start the *Oracle Universal Installer* from the Oracle RDBMS DVD to install the 32-bit Fail Safe client software:
   a) Double-click the file `setup.exe` in the directory `<DVD_DRIVE>:\0FS334I386\install`
b) Enter the required information as shown in the following table:

<table>
<thead>
<tr>
<th>Screen</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome</td>
<td>Choose Next.</td>
</tr>
</tbody>
</table>
| File Locations      | **Source...**  
                     | For **Path**  
                     | The path to the Oracle software on the DVD is displayed. Do **not** change the path.  
                     | **Destination...**  
                     | For **Name**  
                     | Enter the name of the **Oracle_Home** for the Fail Safe software. The Fail Safe software must be installed in a separate **Oracle_Home** directory, for example **OFSCLI**.  
                     | Use the same **Oracle_Home** for all MSCS nodes.  
                     | For **Path**  
                     | Enter the path of the **Oracle_Home** directory for the Fail Safe software. It must be on a local disk, for example:  
                     | **F:\Oracle\OFS\CLI**. |
| Available Products  | Select **Oracle Fail Safe 3.3.4.0.0** and choose **Next**.          |
| Installation Types  | Choose **Client Only**.                                             |
| Summary             | View the information and choose **Install**.                        |
| Install             | Wait while the software is installed.                               |
| End of Installation | Choose **Exit** to close the Oracle Universal Installer.            |

3. **Multiple Oracle Homes only:**  
On all DB MSCS nodes, manually add **one** **ORACLE_HOME\bin** directory to the **<ClusterServiceUsers>** user environment variable path.

**Note**  
You have to switch this **ORACLE_HOME\bin** directory for the **<ClusterServiceUsers>** user environment variable path to another existing ORACLE_HOME, if the first one has to be deleted.

4. Reboot and log on again.

**Caution**  
Do not reboot an MSCS node, if the installation of OFS 3.3.4 is in progress on another MSCS node.

**8.3.4 Additional Steps for the Oracle Fail Safe Configuration**

To complete the Oracle Fail Safe configuration, you must perform the following steps:
Adjusting security settings
Oracle only allows the use of computer local groups to identify database operators and administrators. Therefore, the local groups that were created on the first MSCS node are not known on the MSCS nodes. This means that you have to create these groups manually and grant them access to the database directories.

■ Copying BR*Tools to the sapcluster directory
■ Additional steps for a standalone clustered database (see the section at the end of this chapter.

1. Create the local groups ORA_<dbsid>_DBA and ORA_<dbsid>_OPER.
2. Add <sapsid>adm, SAPService<sapsid> and <ClusterServiceUser> to these local groups.

Example

```
net localgroup ORA_<DDBSID>_DBA /add
net localgroup ORA_<DDBSID>_OPER /add
net localgroup ORA_<DDBSID>_DBA <sapsid>adm /add
net localgroup ORA_<DDBSID>_OPER <sapsid>adm /add
net localgroup ORA_<DDBSID>_DBA SAPService<sapsid> /add
net localgroup ORA_<DDBSID>_OPER SAPService<sapsid>/add
```

3. Create additional Domain groups (only once per database SID)

```
net group ORA_<DDBSID>_DBA /add /domain
net group ORA_<DDBSID>_OPER /add /domain
net group ORA_<DDBSID>_DBA <SAPSID>adm /add /domain
net group ORA_<DDBSID>_DBA SAPService<SAPSID> /add /domain
net group ORA_<DDBSID>_OPER <ClusterServiceUser> /add /domain
net group ORA_<DDBSID>_OPER SAPService<SAPSID> /add /domain
net group ORA_<DDBSID>_OPER <ClusterServiceUser> /add /domain
```

4. On all MSCS nodes, add the cluster groups to the local Oracle groups as follows:

```
net localgroup ora_<DDBSID>_DBA <Domain>\ORA_<DDBSID>_DBA /add
net localgroup ora_<DDBSID>_OPER <Domain>\ORA_<DDBSID>_OPER /add
```

5. On all oracle\<DDBSID> directories on the shared disk drives, adjust the security settings as follows:
   a) Right-click \oracle\<dbsid> and select Sharing and Security....

   Note
   You can select multiple directories before you right-click to adjust the security settings.

   b) Select the Security tab, add both domain groups to the Group or Users list and grant them Full Control.

   c) Choose Advanced and check Replace Permission entries on all child objects with entries shown here that apply to child objects.
6. On all MSCS nodes, copy the BR*TTools to the local `windows\sapcluster` directory with the following command:

```
sapcpe.exe source:<path_to_platform_directory>
target:<path_to_%windir%\sapcluster_directory> list:dbatoolsora.lst
```

**Additional Steps for Clustered Database Instance Running Separately in One Cluster**

If you have not installed the (A)SCS instance and the database instance together in one cluster, but run the database instance in a separate MSCS cluster, you have to perform the following steps on the database cluster:

1. On each additional MSCS node, grant the user rights by adding the `<DBSID>adm` user to the local Administrators group.
2. Copy the user environment of the database user `<DBSID>adm` as follows:
   a) Log on to the first MSCS node as `<DBSID>adm` user.
   b) Run `regedit.exe` and right-click on `HKEY_CURRENT_USER\Environment`.
   c) Choose `Export` to export the environment key to a file.
   d) On each additional MSCS node, log on as user `<DBSID>adm`.
   e) Import the exported registry key to the registry by executing the `.reg` file.
3. Enable the DB13 support on standalone database servers by setting up a standalone gateway as described in SAP Note 657999.

   You have to perform this step on all MSCS nodes and for each database instance.

### 8.3.5 Installing the Central Services Instance (SCS)

1. Run SAPinst [page 61] and choose `► <Your SAP System> ► Installation Options ► High-Availability System ► Based on <technical stack> ► Central Services Instance (SCS) ◄`.
2. If you are installing the SCS instance with SAPinst for the first time and SAPinst prompts you to log off, choose `OK` and log on again.
3. Follow the instructions in the SAPinst dialogs and enter the required parameter values.

**Note**

For more information about the input parameters, position the cursor on a parameter and press `F1` in SAPinst.
Caution

The SCS installation drive must be a **shared** disk, which belongs to the SAP cluster group.

Note

If you have an MSCS configuration with more than two MSCS nodes in one cluster, you have to install and configure the SCS instance on **two** nodes only. These are also the nodes where you install the enqueue replication server.

Caution

**Multi-SID only:**
- In the SAPinst installation screen only the local drive letter and not the shared drive letter is displayed. However, since the link points to the shared drive, all files will be located on the shared drive.
- If you install multiple SAP systems in one MSCS cluster, make sure that you enter the SAP system ID and instance numbers as prepared when setting up the links. The instance number must be unique and not already used by another SAP system.

4. Check that the SCS instance is running.

### 8.3.6 Configuring the First MSCS Node

To configure the first MSCS node so that it functions properly in MSCS, you have to run the cluster configuration option offered by the SAPinst tool. When you run this option it:

- Creates the SAP cluster group
- Copies tools to the SAPCluster directory
- Sets the SAPService to `manual`

Caution

When you **reboot during the conversion to MSCS** [page 144], resources fail over to another MSCS node. Therefore, after each reboot you have to return the system to the state it had before the reboot.

**Prerequisites**

- You are logged on to the **first** MSCS node as domain administrator or as a local user with domain administration rights. For more information, see *Performing a Domain Installation without being a Domain Administrator* [page 49].
The SCS installation drive must be online on the first MSCS node.

**Procedure**

1. Run SAPinst and choose <Your SAP System> > Installation Options > High-Availability System > Based on <technical stack> > First MSCS Node.

   ![Note]
   
   If SAPinst prompts you to log off from your system, log off and log on again.

2. Enter the required parameter values.

   ![Note]
   
   **Multi-SID only:**
   
   If you install multiple SAP systems in one MSCS cluster, select Support of multiple SAP systems in one MSCS cluster.

   ![Note]
   
   For more information about the input parameters, position the cursor on the parameter and press F1 in SAPinst.

**Result**

SAPinst converts the SAP instances on the first MSCS node for operation in MSCS.

### 8.3.7 Installing the Database Instance

**Prerequisites**

- The SAP cluster group is Online on the first MSCS node.
- The Oracle shared disk is Online on the first MSCS node.
- You have added the Oracle virtual IP network name to the Oracle cluster group and brought it online on the first MSCS node.

**Procedure**

Perform the following steps on the first MSCS node.

1. On the first MSCS node, run SAPinst [page 61] and choose <Your SAP System> > SAP Systems with <Database> > Installation Options > High-Availability System > Based on <technical stack> > Database Instance.
Caution

The following only applies if you use multiple Oracle Homes:
- You must have one ORACLE_HOME per database instance on every cluster node on local disks.
- All ORACLE_HOMES must use the same disks and directories and ORACLE_HOME names on all DB MSCS nodes.
- Since each ORACLE_HOME uses its own Oracle Listener, you must specify unique Oracle TCP/IP port numbers for every database in the DB MSCS cluster.

Use 1527 for the first database, 1526 for the second database, 1525 for the third, and so on.

2. Follow the instructions in the SAPinst dialogs and enter the required parameter values.
   a) For the profile directory you have to use the UNC path of the virtual (A)SCS host name, for example:
      \\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
   b) Make sure that in the database host field, the local database host is displayed.

Caution

By default, SAPinst locates the saparch, sapreorg, sapcheck, and saptrace directories on the last available drive. If this is a local drive, you must specify that these directories reside on a shared disk by using Advanced Database Options, which you can find on the screen Oracle Database Instance. Continue with Next until you can select Windows Drive Mapping. Check the box and choose Next. Then relocate all folders to a shared disk.

Note

For more information about the input parameters, position the cursor on a parameter and press the F1 key in SAPinst.

8.3.8 Installing the Host Agent on the Additional MSCS Node

You must install the host agent on the additional MSCS node(s). SAPinst installs the host agent with the instance number 99 and the SAP system ID SAP.

Procedure

1. Run SAPinst [page 61] on the additional MSCS node and choose  » <Your SAP System> » Installation Options » SAP Systems with <Database> » High-Availability System » Based on <technical stack> » Host Agent ».
2. If SAPinst prompts you to log off, choose OK and log on again.
3. Follow the instructions in the SAPinst dialogs and enter the required parameter values.
4. For Destination Drive, select the local drive on the MSCS node.

Note

The screen General SAP System Parameters is not displayed if one of the following cases apply:
- There is only one disk available
  - SAPInst then installs the host agent on the local disk.
- The saploc share already exists
  - saploc must then point to the correct local disk. If it points to the wrong disk, delete the saploc share with the command: `net share saploc /DELETE`

5. Start the installation.

### 8.3.9 Configuring the Additional MSCS Node

To configure the additional MSCS node(s) in the cluster, you have to run the MSCS configuration option for each additional MSCS node offered by the SAPInst tool. When you run this option it:

- Creates users and groups
- Sets the system and user environment
- Enters required port numbers in the Windows services file
- Creates the SAPService

Caution

When you reboot during the conversion to MSCS [page 144], resources fail over to another MSCS node. Therefore, after each reboot you have to return the system to the state it had before the reboot.

**Prerequisites**

- You are logged on to the additional MSCS node as domain administrator or as a local user with domain administration rights. For more information, see Performing ad Domain Installation without being a Domain Administrator [page 49].
- You have already configured the first MSCS node [page 149], which is the primary cluster node.

**Procedure**

1. Run SAPInst and choose &lt;Your SAP System&gt; &gt; Installation Options &gt; SAP Systems with &lt;Database&gt; &gt; High-Availability System &gt; Based on &lt;technical stack&gt; &gt; Additional MSCS Node &gt;.
2. Enter the required parameter values.

3. When SAPinst has finished, start the SAP cluster group SAP <SAPSID> in the Cluster Administrator with Start All Programs Administration Tools Cluster Administrator.

8.3.10 Installing an Enqueue Replication Server

We **strongly** recommend to install an enqueue replication server with SAPinst on all MSCS nodes where an SCS instance is running.

You have to perform the installation at least two times.

**Prerequisites**

* Your SCS instance is already clustered with MSCS.
* You have to install the enqueue replication server on a **local** disk.

**Procedure**

1. On the **first** MSCS node, log on as domain user who is a member of the local administrators group.
2. Run SAPinst [page 61] and choose Start Your SAP System Installation Options High-Availability System Based on technical stack Enqueue Replication Server.
3. Follow the instructions in the SAPinst dialogs and enter the required parameters.

Note the following, when entering the parameters

* On the SAPinst screen SAP Instance, enter the:
  * SAP system ID <SAPSID> of your SAP system
Instance number of the (A)SCS instance

Virtual instance host name of the (A)SCS instance

- On the SAPinst screen Enqueue Replication Server Instance, enter a unique instance number that is not in use by another instance on this host.
- Decide if you want to restart the (A)SCS instance and service cluster resources with SAPinst now, or later with the Cluster Administrator.

**Note**

You only need to do this once for all enqueue replication servers that you install on the MSCS nodes.

After you have entered all required input information, SAPinst starts the installation and displays the progress of the installation. During the process phase, the enqueue server instance is started. SAPinst installs the enqueue replication server instance on a local disk in the following directory:

```
./usr/sap/<SAPSID>/ERS<instance_number>/
```

**Note**

The profile is replicated from the global host to the local instance profile folder. The enqueue replication server instance uses the profile from the local instance profile folder:

```
./usr/sap/<SAPSID>/ERS<instance_number>/profile/
```

4. On the additional MSCS node, start SAPinst to install the enqueue replication server for the (A)SCS instance as described in step 2 above.

**Note**

There is no need to move the (A)SCS cluster group to another MSCS node.

5. Enter the required parameter values in the SAPinst dialogs as described above.

### 8.3.11 Installing the Primary Application Server Instance

The following describes how to install the primary application server instance for MSCS.

You have the following options to install the primary application server instance:

- You install the primary application server instance on an MSCS node.
  
  In this case, bring the SAP cluster group online on this node, and make sure that the primary application server instance number is different from the (A)SCS instance number.
- You install the primary application server instance on a host outside of MSCS.
**Procedure**

1. Run SAPinst [page 61] and choose ❯❯ <Your SAP System> ➤ Installation Options ➤ High-Availability System ➤ Based on <technical stack> ➤ Primary Application Server Instance ❯.
2. If SAPinst prompts you to log off, choose OK and log on again.
3. Follow the instructions in the SAPinst dialogs and enter the required parameter values.

**Note**
- For more information about the input parameters, position the cursor on a parameter and press F1 in SAPinst.
- If you install the primary application server instance on an MSCS node, make sure that on the screen General SAP System Parameters for the:
  - Profile Directory, you use the UNC path (not the local path) of the virtual (A)SCS host name, for example:
    ```\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile```
  - Destination Drive, you select the local disk where you want to install the primary application server instance. Do not enter the shared disk for the (A)SCS instance.

**Note**
If the destination drive is not shown and you cannot select it, the saploc share already exists. Since you already installed the ERS instance on the local drive, and the saploc share points to that local drive, SAPinst automatically takes that drive as destination drive.

4. Check that the primary application server instance is running.

**8.3.12 Creating the Oracle Fail Safe Group**

You perform the following steps in the Fail Safe Manager on the first MSCS node.

**Procedure**

1. Stop the primary application server instance.
2. Change the physical host name into the virtual database host name as follows:
   a) Change to the local directory of the primary application server instance:
   ```<drive>:\usr\sap\<SAPSID>\JC<Instance_number>\j2ee\configtool\```
   b) Run configtool.bat to start the Config Tool.
   c) Choose secure store and then select jdbc\pool/\<SAPSID>\Url.
   d) In the Value field, change the physical host name into the virtual database host name.
   e) Choose Add and save your changes.
3. Choose ❯❯ Start ➤ Programs ➤ Oracle - <OFSClient_Home> ➤ Oracle Fail Safe Manager ❯.
   The window Add Cluster To Tree appears.
4. Insert your virtual cluster name.
5. Right-click the cluster and choose Connect to cluster.
6. Enter the following and then confirm your entries with OK:

<table>
<thead>
<tr>
<th>User name</th>
<th>&lt;user&gt; (user with the account under which the service ClusterServer is running)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>&lt;password&gt;</td>
</tr>
<tr>
<td>Cluster Alias</td>
<td>&lt;virtual_cluster_name&gt; (name of the cluster you are installing)</td>
</tr>
<tr>
<td>Domain</td>
<td>&lt;domain_name&gt;</td>
</tr>
</tbody>
</table>

7. In the Welcome dialog box, choose Verify Cluster.

Note
All MSCS cluster nodes must be up and running for this step.

The window Clusterwide Operation: Verifying Fail Safe Cluster shows the steps that are executed to verify the cluster. When you are informed that the operation has completed successfully, close the window.

8. In the Oracle Fail Safe Manager, create the Fail Safe group ORACLE<DBSID>.
   Choose Groups Create.
   The window Create Group... appears.

9. Enter the Group Name ORACLE<DBSID>.
   In answer to the question Do you want to allow the group to failback to preferred node?, select Prevent failback.
   The window Finish Creating the Group appears and displays information about the group. Choose OK.

10. In the window Add Virtual Address, select Yes to indicate that you want to add a virtual address to the group.
    The Add Resource to Group: - Virtual Address appears.

11. Select Show networks accessible by clients and enter the following information:
    Under Network leave the entry public
    Under Virtual Address for Host Name enter the <virtual_hostname>.
    The IP Address is automatically recognized.
    Choose Finish.
    The window Add the Virtual Address to the Fail Group appears. Choose OK.

Note
If the Fail Safe Manager cannot create the Fail Safe group, look at the Windows Event Logs on all MSCS nodes to find out the reason for the failure.
8.3.13 Setting Up a Shared Database Directory in Oracle Home

As of Oracle 10g your database is configured for using an spfile. With an spfile you can set up a central (shared) `<Oracle_Home>`\`database\`-directory for MSCS with a link or junction. A central `<Oracle_Home>`\`database\`-directory has the following advantages:

- You can also use `sqlplus` remotely to make changes to your profile parameters
- You only have to make the changes in the parameter files once in the shared `<Oracle_Home>`\`database\`-directory.

**Note**
In the past, you had to apply all changes in the parameter file `init<DBSID>.ora` in the `<Oracle_Home>`\`database\`-directories on all MSCS nodes.

**Prerequisites**
You have one of the following executables available:

- `\1inkd.exe`
  This executable is part of the Microsoft Windows 2003 Server Resource Kit. You can download the kit from [www.microsoft.com](http://www.microsoft.com). Search for *Microsoft Windows 2003 Server Resource Kit*.

  **Note**
  After you have installed the resource kit you can copy `\1inkd.exe` to a local directory.

- `junction.exe`
  You can download this executable from [www.sysinternals.com](http://www.sysinternals.com) (Search for `junction`).

**Procedure**

1. Stop the Oracle database and the Oracle Service.
2. In the `\sapdata1` directory create the directory `\database`.
   The `\sapdata1` directory is located on a shared disk in the cluster.
3. On the first MSCS node, change to the `<Oracle_Home>`\`database\` directory, and enter the following command:
   ```
   move * `<path_to_sapdata1>`\`database
   ```
4. Delete the `<Oracle_Home>`\`database\`-directory with the command:
   ```
   rd /q /s database
   ```

  **Note**
  You can also use the Windows Explorer to delete the directory.

5. Create the junction or link with the following command:
   - If you use `junction`, enter:
8.3 Installation

8.3.14 Adding the Oracle Database Resource to the Cluster Group

1. Copy the sqlnet.ora file from the directory <ORACLE_HOME>\network\admin on the first MSCS node to the same directory on the additional MSCS node(s).
2. Start the Oracle Fail Safe Manager with Start Programs Oracle - <Fail_Safe_Home_Name> Oracle Fail Safe Manager.
3. If the Welcome dialog box appears, choose Verify Cluster. Otherwise, right-click the cluster and choose Verify Cluster.

Note
All MSCS nodes must be up and running for this step.

The window Verifying Cluster shows the steps that are executed to verify the cluster. When you are informed that the operation has completed successfully, close the window.
4. Add the SAP database to the cluster group Oracle<DBSID>.
   a) In the tree on the left, choose Nodes <First MSCS Node> Standalone Resources.
   b) Select the database <DBSID>.world
   c) Choose Resources Add to Group.
5. In the dialog box Add Resource to Group – Resource:
   For Resource Type, select Oracle Database.
   For Group name, select Oracle<DBSID>.
6. Choose Next.
7. In the dialog box Add Resource to Group – Database Identity: enter the following information:
8. Choose Next.
9. In the dialog box Add Resource to Group — Database Password:
   Select Yes, create the password file (recommended).
   Enter and confirm the password.
11. In the dialog box Finish Adding the Database to the Group, choose OK to add the database resource to
    the group.
12. In the dialog box Confirm Add database to Group, choose Yes.
    The Adding resource <DBSID>.world to group window, shows the steps that are executed to add the
    database to the cluster group.
13. For each MSCS node a pop-up appears: The Oracle Net Listener uses a host name in the host address parameter.
    It must be converted to use an IP address.
    Choose Yes to convert to an IP address.
14. In the DEFAULT profile, replace the physical host name with the virtual database host name in the
    following variables:
        SAPDBHOST
        j2ee\dbhost.
        The default profile is located at:
        \\<virtual_SAP_hostname>\sapmnt\<SID>\sys\profile\DEFAULT.PFL
15. Copy tnsnames.ora from %ORACLE_HOME%\network\admin to
    \\<sapglobalhost>\sapmnt\<SAPSID>\SYS\profile\oracle.

### 8.3.15 Installing the Additional Application Server Instance

You have to install at least one additional application server instance for MSCS.
You have the following options to install the additional application server instance:

- You install the additional application server instance on an MSCS node.
  - In this case, bring the SAP cluster group online on this node, and make sure that the additional
    application server instance number is different from the (A)SCS instance number.
- You install the additional application server instance on a host outside of MSCS.
8.4 Post-Installation

This section describes how to complete and check the installation of the SAP system for an MSCS configuration:

1. You perform the post-installation checks for the enqueue replication server [page 161].
2. You perform the general post-installation steps [page 73] listed in this guide.
8.4.1 Post-Installation Checks for Enqueue Replication Server

Note
Make sure that you have restarted the (A)SCS instance and service cluster resources SAP <SAPSID> <(A)SCS_instance_number> Instance and SAP <SAPSID> <(A)SCS_instance_number> Service during the installation with SAPInst or with the Cluster Administrator.

The following sections describe the tests you must perform to check whether the installed enqueue replication server works properly. For these tests you use the ENQT and ENSMON command line tools, which allow remote access to the enqueue server statistics. Before you can use these tools you must copy them to the remote host where the Enqueue Replication Server is running and from where you want to start the tests.

You perform the following steps:

1. You copy ENQT.exe and ENSMON.exe from your cluster's binary directory on the sapmnt share \<host>\sapmnt\<SAPSID>\SYS\exe\<codepage>\<platform> to a directory on the remote host from where you run the tests.
2. You check the status of the enqueue replication server with the ENSMON tool [page 161].
3. You check the fill status and ID of the lock table during failover with the ENQT tool [page 162].

8.4.1.1 Checking the Status of the Enqueue Replication Server with ENSMON

You use the ENSMON tool to check if the enqueue replication server and the enqueue server are properly connected.

Prerequisites
- You have started the (A)SCS instance of your SAP system.
- You run the ENSMON tool from the host where you installed the Enqueue Replication Server.

Procedure

To check the status of the enqueue replication server enter the following command:

ensmon pf=<ERS_instance_profile> 2

where <ERS_instance_profile> is the profile created during the installation of the Enqueue Replication Server.
If the enqueue replication server and the enqueue server are properly connected, the output is similar to this:

Try to connect to host <Virtual (A)SCS host> service sapdp01 get replinfo request executed successfully
Replication is enabled in server, repl. server is connected
Replication is active
...

If the enqueue replication server and the enqueue server are not properly connected, the output is similar to this:

Try to connect to host <Virtual (A)SCS host> service sapdp01 get replinfo request executed successfully
Replication is enabled in server, but no repl. server is connected
...

8.4.1.2 Monitoring the Lock Table During Failover with ENQT

With the following tests you monitor and check the lock table’s fill status and the lock table ID using the ENQT tool.

Prerequisites

- You have started the (A)SCS instance of your SAP system.
- You run the ENQT tool from the host where you installed the Enqueue Replication Server.

**Caution**

*Only* use the ENQT commands stated in this procedure otherwise you might damage the enqueue server’s lock table.

Monitoring the Lock Table Fill Status During Failover with ENQT

1. Use the following command to fill the lock table of the enqueue server with 20 locks:

   ```
   enqt pf=<ERS_instance_profile> 11 20
   ```

   where `<ERS_instance_profile>` is the profile created during the installation of the Enqueue Replication Server.

2. Monitor the fill status of the lock table with the following command:

   ```
   enqt pf=<ERS_instance_profile> 20 1 1 9999
   ```

   This command continuously reads the content of the enqueue server’s lock table and returns the number of the table entries to the console.

3. Move the (A)SCS cluster group to another MSCS node to simulate an enqueue server failover while running the ENQT command.
The output is similar to this:

```
Number of selected entries: 20
Number of selected entries: 20
Number of selected entries: 20
Number of selected entries: 20
Number of selected entries: 20
Number of selected entries: 0 (enqueue server fails over )
Number of selected entries: 20 (enqueue server is running again )
Number of selected entries: 20
Number of selected entries: 20
Number of selected entries: 20
...```

4. Make sure that the lock count is the same before and after the failover.

**Monitoring the Lock Table ID During Failover with ENQT**

1. Monitor the lock table ID during the failover with the following command:
   ```
   for /l %i in (1,1,100000) do enqt pf=<ERS_instance_profile> 97
   ```
   where `<ERS_instance_profile>` is the profile created during the installation of the Enqueue Replication Server.

2. Move the (A)SCS cluster group to another MSCS node to simulate an enqueue server failover while running the ENQT command.

The output is similar to this:

```
... (Output before failover)
C:\WORK\HA\ENQU-Tests>enqt pf=BUG_ERS01_PCJ2EEV6 97
---REQ-----------------------------------------------
EnqId: EnqTabCreaTime/RandomNumber = 25.10.2005 11:15:59 1130231759 / 9288
...```

```
... (Output after failover)
C:\WORK\HA\ENQU-Tests>enqt pf=BUG_ERS01_PCJ2EEV6 97
---REQ-----------------------------------------------
EnqId: EnqTabCreaTime/RandomNumber = 25.10.2005 11:15:59 1130231759 / 9288
...```

3. Make sure that the lock table ID (ENQID) is the same before and after the failover.
### 8.4.2 Starting and Stopping the SAP System in an MSCS Configuration

The following describes how to start or stop the SAP system in an MSCS configuration with the:

- SAP MMC
- Cluster Administrator

#### Note

- With the Cluster Administrator you can only start and stop the (A)SCS instance and the database instance.
- You also use the Cluster Administrator for all other administrative tasks like moving instances from one MSCS node to another MSCS node.

#### Procedure

- To start or stop your SAP system with the SAP MMC, see Starting and Stopping the SAP System [page 101].
- To start or stop the (A)SCS instance and the database instance with the Cluster Administrator do the following:
  1. Start the Cluster Administrator by choosing Start > All Programs > Administrative Tools > Cluster Administrator.
  2. To start or stop the (A)SCS instance, right-click the instance SAP <SAPSID> <instance_no> Instance and choose Bring online or Take offline.
  3. To start or stop the database instance, right-click the <database_resource> and choose Bring online or Take offline.

---

End of: HA (MSCS)
© Copyright 2007 SAP AG. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

Microsoft, Windows, Outlook, and PowerPoint are registered trademarks of Microsoft Corporation.
IBM, DB2, DB2 Universal Database, OS/2, Parallel Sysplex, MVS/ESA, AIX, S/390, AS/400, OS/390, OS/400, iSeries, pSeries, xSeries, zSeries, System i, System i5, System p, System p5, System x, System z, System z9, z/OS, AFP, Intelligent Miner, WebSphere, Netfinity, Tivoli, Informix, i5/OS, POWER, POWER5, POWER5+, OpenPower and PowerPC are trademarks or registered trademarks of IBM Corporation.
Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either trademarks or registered trademarks of Adobe Systems Incorporated in the United States and/or other countries.
Oracle is a registered trademark of Oracle Corporation.
UNIX, X/Open, OSF/I, and Motif are registered trademarks of the Open Group.
Citrix, ICA, Program Neighborhood, MetaFrame, WinFrame, VideoFrame, and MultiWin are trademarks or registered trademarks of Citrix Systems, Inc.
HTML, XML, XHTML and W3C are trademarks or registered trademarks of W3C®, World Wide Web Consortium, Massachusetts Institute of Technology.
Java is a registered trademark of Sun Microsystems, Inc.
JavaScript is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by Netscape.
MaxDB is a trademark of MySQL AB, Sweden.
SAP, R/3, mySAP, mySAP.com, xApps, xApp, SAP NetWeaver, and other SAP products and services mentioned herein as well as their respective logos are trademarks or registered trademarks of SAP AG in Germany and in several other countries all over the world. All other product and service names mentioned are the trademarks of their respective companies. Data contained in this document serves informational purposes only. National product specifications may vary.
These materials are subject to change without notice. These materials are provided by SAP AG and its affiliated companies (“SAP Group”) for informational purposes only, without representation or warranty of any kind, and SAP Group shall not be liable for errors or omissions with respect to the materials. The only warranties for SAP Group products and services are those that are set forth in the express warranty statements accompanying such products and services, if any. Nothing herein should be construed as constituting an additional warranty.

This document was created using stylesheet 2006-12-31 (V5.1beta [= 6.0 for E1]) and XSLT processor SAXON 6.5.2 from Michael Kay (http://saxon.sf.net/), XSLT version 1.

Disclaimer
Some components of this product are based on Java™. Any code change in these components may cause unpredictable and severe malfunctions and is therefore expressly prohibited, as is any decompilation of these components.
Any Java™ Source Code delivered with this product is only to be used by SAP’s Support Services and may not be modified or altered in any way.


**Legal Software Terms**

**Terms for Included Open Source Software**

This SAP software contains also the third party open source software products listed below. Note that for these third party products the following special terms and conditions shall apply.

1. **This software was developed using ANTLR.**
2. **SAP License Agreement for STLport**
   
   SAP License Agreement for STLP between
   
   SAP Aktiengesellschaft
   
   Systems, Applications, Products in Data Processing
   
   Dietmar-Hopp-Allee 16
   
   69190 Walldorf, Germany
   
   (hereinafter: SAP)
   
   and
   
   you
   
   (hereinafter: Customer)
   
   a) **Subject Matter of the Agreement**
   
   A) SAP grants Customer a non-exclusive, non-transferable, royalty-free license to use the STLP.org C++ library
   (STLP) and its documentation without fee.
   
   B) By downloading, using, or copying STLP or any portion thereof Customer agrees to abide by the intellectual
   property laws, and to all of the terms and conditions of this Agreement.
   
   C) The Customer may distribute binaries compiled with STLP (whether original or modified) without any
   royalties or restrictions.
   
   D) Customer shall maintain the following copyright and permissions notices on STLP sources and its
   documentation unchanged: Copyright 2001 SAP AG
   
   E) The Customer may distribute original or modified STLP sources, provided that:
   
   - The conditions indicated in the above permissions notice are met;
   - The following copyright notices are retained when present, and conditions provided in accompanying
   permission notices are met:
   
   Copyright 1994 Hewlett-Packard Company
   
   Copyright 1996.97 Silicon Graphics Computer Systems Inc.
   
   Copyright 1997 Moscow Center for SPARC Technology.
   
   Copyright 1999,2000 Boris Fomitchev
   
   Copyright 2001 SAP AG
   
   Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is
   hereby granted without fee, provided that the above copyright notice appear in all copies and that both that
   copyright notice and this permission notice appear in supporting documentation. Hewlett-Packard Company
   makes no representations about the suitability of this software for any purpose. It is provided “as is” without
   express or implied warranty.

   Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is
   hereby granted without fee, provided that the above copyright notice appear in all copies and that both that
   copyright notice and this permission notice appear in supporting documentation. Silicon Graphics makes no
   representations about the suitability of this software for any purpose. It is provided “as is” without express or
   implied warranty.

   Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is
   hereby granted without fee, provided that the above copyright notice appear in all copies and that both the
   copyright notice and this permission notice appear in supporting documentation. Moscow Center for SPARC
makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

Boris Fomitchev makes no representations about the suitability of this software for any purpose. This material is provided “as is”, with absolutely no warranty expressed or implied. Any use is at your own risk. Permission to use or copy this software for any purpose is hereby granted without fee, provided the above notices are retained on all copies. Permission to modify the code and to distribute modified code is granted, provided the above notices are retained, and a notice that the code was modified is included with the above copyright notice. Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. SAP makes no representations about the suitability of this software for any purpose. It is provided with a limited warranty and liability as set forth in the License Agreement distributed with this copy. SAP offers this liability and warranty obligations only towards its customers and only referring to its modifications.

b) Support and Maintenance
SAP does not provide software maintenance for the STLport. Software maintenance of the STLport therefore shall be not included.
All other services shall be charged according to the rates for services quoted in the SAP List of Prices and Conditions and shall be subject to a separate contract.

c) Exclusion of warranty
As the STLport is transferred to the Customer on a loan basis and free of charge, SAP cannot guarantee that the STLport is error-free, without material defects or suitable for a specific application under third-party rights.
Technical data, sales brochures, advertising text and quality descriptions produced by SAP do not indicate any assurance of particular attributes.

d) Limited Liability
A) Irrespective of the legal reasons, SAP shall only be liable for damage, including unauthorized operation, if this (i) can be compensated under the Product Liability Act or (ii) if caused due to gross negligence or intent by SAP or (iii) if based on the failure of a guaranteed attribute.
B) If SAP is liable for gross negligence or intent caused by employees who are neither agents or managerial employees of SAP, the total liability for such damage and a maximum limit on the scope of any such damage shall depend on the extent to which its occurrence ought to have anticipated by SAP when concluding the contract, due to the circumstances known to it at that point in time representing a typical transfer of the software.
C) In the case of Art. 4.2 above, SAP shall not be liable for indirect damage, consequential damage caused by a defect or lost profit.
D) SAP and the Customer agree that the typical foreseeable extent of damage shall under no circumstances exceed EUR 5,000.
E) The Customer shall take adequate measures for the protection of data and programs, in particular by making backup copies at the minimum intervals recommended by SAP. SAP shall not be liable for the loss of data and its recovery, notwithstanding the other limitations of the present Art. 4 if this loss could have been avoided by observing this obligation.
F) The exclusion or the limitation of claims in accordance with the present Art. 4 includes claims against employees or agents of SAP.

3. Adobe Document Services
Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and / or other countries. For information on Third Party software delivered with Adobe document services and Adobe LiveCycle Designer, see SAP Note 854621.

Documentation in the SAP Service Marketplace
You can find this document at the following address: https://service.sap.com/instguides